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О программе SMART Notebook
В ПОSMART Notebook вы можете создавать файлы *.notebook, содержащие графику, текст,
таблицы, линии, фигуры, анимацию имногое другое. Демонстрируйтефайл и удерживайте
внимание класса, перемещая объекты и управляя ими. Если ваш класс выдвигает замечания
и предложения, записывайте их на странице с помощью цифровых чернил. Вы можете
открывать файлы *.notebook в ПОSMART Notebook на компьютерах с операционными
системамиWindows®, Mac или Linux®. Вы такжеможете экспортировать свойфайл в
различныеформаты, включая HTML и PDF.

Для добавления дополнительных функций ПОSMART Notebook можно установить
инструменты SMART Notebook Tools, а также надстройки сторонних разработчиков.
Инструменты SMART Notebook Tools включают в себя следующее.

l 3D-инструменты  для ПОSMART Notebook™

l Инструменты объединения реальностей для документ-камеры SMART
Document Camera™

l SMART Notebook Math Tools

О другом ПО SMART, установленном на
компьютере
На вашем компьютере может быть установлено другое ПОSMART.

l Драйверы продуктов SMART

Ваш интерактивный продукт распознает касания экрана и посылает координаты каждого
касания вместе с информацией о пере компьютеру, к которому подключен
интерактивный продукт. SMART Product Drivers преобразуют информацию в нажатия
кнопок мыши и цифровые чернила. SMART Product Drivers позволяют выполнять
стандартные компьютерные операции с помощью пальцев или пера.

l SMART Ink™

С помощью SMART Ink можно писать или рисовать на экране цифровыми чернилами с
помощью пера, затем сохранять или стирать записи.

l Инструменты SMART Board®

Можно привлечь внимание к определенным частям страницы с помощью инструментов
SMART Tools, как «Затенение экрана», «Подсветка», «Лупа» и «Указатель».
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Новые возможности
В августовской версии ПОSMART Notebook 2015 появились следующие новыефункции.

ПО SMART Notebook 15.1
Функция Тема

В конструктор учебных занятий (LAB) добавлены четыре
новых занятия: «Найди соответствие!», «Заполните пропуски»,
«Порядок сортировки» и «Кричи!». Также были добавлены
новые красочные темы.

Создание занятий с
помощью конструктора
учебных занятий (LAB) на
странице 142

«Кричи!» — это инструмент создания материалов, с
которым учащиеся и учителя могут работать в конструкторе
учебных занятий (LAB).С помощью своих мобильных
устройств учащиеся могут быстро создавать и отправлять
изображения и тексты в занятия создания материалов LAB, а
учителя могут легко проверять материалы. Учащиеся быстро
вовлекаются в выполнение задания, потому что видят
собственную работу и то, как развиваются их идеи.

Добавление задания
«Кричи!» на странице 153

В новых занятиях LAB теперь есть поддержка добавления
изображений (за исключением «Заполните
пропуски»).Добавляйте изображения и списки в категории
LAB.Теперь этафункция доступна в задании на
переворачивание карточек.

Управление материалами
в конструкторе учебных
занятий на странице 165

Улучшения SMARTInk 3.1включают:

l Обновление динамической панели инструментов
l Оконные инструменты SMART Ink
l Избранные перья SMART Ink
l Средство ввода рукописных данных SMART Touch Inking

ПО SMART Notebook 15
Функция Тема

Конструктор учебных занятий помогает быстро создать
интерактивное игровое занятие для учащихся, что сделает
процесс обучения более увлекательным.

Создание занятий с
помощью конструктора
учебных занятий (LAB) на
странице 142

Концептуальные карты помогают учащимся
систематизировать информацию.

Chapter 9: Работа с
концептуальными
картами на странице 167
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Функция Тема

Теперь для всех пользователей в панели инструментов
доступны функции для работы с формами и углами:

l Инструмент создания неправильных многоугольников

l Инструмент «Многоугольник»

l Показать длины сторон

l Показать внутренние углы

l Показать вершины

l Разделениефигур

Оптимизация характеристик просмотра повышает качество
работы YouTube™ иGeoGebra.

Запуск программного обеспечения
SMART Notebook
Запустите ПОSMART Notebook, дважды щелкнув по значку SMART Notebook на рабочем
столе.

При первом запуске SMART Notebook автоматически открывается файл руководства.
Прочитав материалы, представленные в этом файле, можно получить дополнительную
информацию об этом программном обеспечении и новых функциях последних версий. По
завершении выберите File > New («Файл» > «Новый») , чтобы создать новый пустойфайл.

NOTE

В последующем при запуске ПО новый пустойфайл открывается автоматически. Чтобы
открыть обучающийфайл, выберите Help > Tutorial («Справка» > «Руководства»).

Управление пользовательским интерфейсом
Интерфейс пользователя ПОSMART Notebook состоит из следующих элементов:

l Меню

l Панель инструментов

l Вкладки: Page Sorter («Сортировщик страниц»), Gallery («Галерея»), Attachments
(«Вложения»), Properties («Свойства»), Add-ons («Надстройки») и SMART Response®)

l Область страницы
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Меню
В меню содержатся все команды, которыеможно использовать для управления файлами и
объектами в ПОSMART Notebook.

Сортировщик страниц
Сортировщик страниц отображает все страницы в открытом файле в виде эскизов и
автоматически обновляет эти эскизы при изменении содержимого страниц.

При использовании сортировщика страниц вы можете выполнять следующее:

l Вырезание, копирование и вставка страниц

l Отображение страниц

l Вырезание, копирование, вставка страниц

l Создание страниц

l Клонирование страниц

l Очистка страниц

l Удаление страниц

l Переименование страниц

l Изменение порядка страниц

l Перенос объектов с одной страницы на другую

l Группировка страниц

Открытие сортировщика страниц

Чтобы открыть сортировщик страниц, нажмите «Сортировщик страниц» .

Настройка сортировщика страниц
Сортировщик страниц можно переместить с одной стороны окна SMART Notebook на другую,

нажав на значок «Переместить боковую панель» .

Размер сортировщика страниц можно изменить, перетягивая его край влево или вправо. Если
сортировщик страниц не используется, его можно скрыть, установив флажок «Скрывать
автоматически» . (Чтобы отобразить скрытый сортировщик страниц, нажмите

«Сортировщик страниц» .)
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NOTE

Если уменьшить размер сортировщика страниц до минимального, функция скрытия
включится автоматически.

Вкладка «Галерея»
На вкладкеGallery («Галерея») содержится графика, фоновые рисунки, мультимедийные
материалы, файлы и страницы, которые вы можете использовать в своих уроках, а также
предлагается предварительный просмотр этих материалов. Вкладка «Галерея» также
предоставляет доступ к другим интерактивным ресурсам. Дополнительную информацию см.
на странице Вставка материалов из Галереи на странице 88.

Кроме того, вы можете включить в галерею свои собственныематериалы иматериалы своих
коллег (см. Организация и предоставление общего доступа к содержимому с помощью
Галереи на странице 110).

Открытие вкладки «Галерея»

Чтобы открыть вкладку Gallery («Галерея»), нажмитеGallery .

Настройка вкладки «Галерея»
Вкладку Gallery («Галерея») можно переместить с одной стороны окна SMART Notebook на

другую, нажав значок Move Sidebar («Переместить боковую панель») .

Размер вкладкиGallery («Галерея») можно изменить, перетягивая ее край влево или вправо.
Если вкладкаGallery («Галерея») не используется, ее можно скрыть, установив флажок
Auto-hide («Скрывать автоматически»). (Чтобы отобразить скрытую вкладку Gallery

(«Галерея»), нажмитеGallery ).

NOTE

Если уменьшить размер вкладки «Галерея» до минимального, функция скрытия
включится автоматически.

Вкладка «Вложения»
На вкладке Attachments («Вложения») отображаются файлы и ссылки на веб-страницы,
вложенные в текущийфайл. Дополнительную информацию см. в разделе Вложениефайлов
и веб-страниц на странице 108.

Открытие вкладки «Вложения»

Чтобы снова открыть вкладку Attachments («Вложения»), нажмите Attachments .
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Настройка вкладки «Вложения»
Вкладку Attachments («Вложения») можно переместить с одной стороны окна
SMART Notebook на другую, нажав значок Move Sidebar («Переместить боковую панель»)

.

Размер вкладки Attachments («Вложения») можно изменить, перетягивая ее край влево или
вправо. Если вкладка Attachments («Вложения») не используется, ее можно скрыть,
установив флажок Auto-hide («Скрывать автоматически»). (Чтобы отобразить скрытую

вкладку Attachments («Вложения»), нажмите Attachments ).

NOTE

Если уменьшить размер вкладки «Вложения» до минимального, функция скрытия
включится автоматически.

Вкладка «Свойства»
Вкладка «Свойства» позволяет изменять формат объектов, таких как цифровые чернила,
фигуры, линии, текст и таблицы. В зависимости от выбранного объекта, вы можете
изменять:

l цвет, толщину и тип линий;

l прозрачность и эффекты заливки объектов;

l типшрифта для текстовых объектов, его кегль и стиль;

l анимацию объектов.

На вкладке Properties («Свойства») отображаются только опции, доступные для выбранного
объекта. Дополнительная информация об отображении и настройке свойств объектов на
вкладке Properties («Свойства») представлена в разделе Изменение свойств объектов на
странице 66.

На вкладке Properties («Свойства») также имеется кнопка Page Recording («Запись
страницы») . Вы можете использовать эту функцию для записи ваших действий на текущей
странице (см. раздел Запись страниц с помощью средства записи уроков на странице 180).

Открытие вкладки «Свойства»

Чтобы открыть вкладку «Свойства», нажмите «Свойства» .

Настройка вкладки «Свойства»
Вкладку «Свойства» можно переместить с одной стороны окна SMART Notebook на другую,

нажав на значок «Переместить боковую панель» .
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Размер вкладки «Свойства» можно изменить, перетягивая ее край влево или вправо. Если
вкладка «Свойства» не используется, ее можно скрыть, установив флажок «Скрывать

автоматически» . (Чтобы отобразить скрытую вкладку «Свойства», нажмите «Свойства»

.)

NOTE

Если уменьшить размер вкладки «Свойства» до минимального, функция скрытия
включится автоматически.

Вкладка «Надстройки»
Вкладка Add-ons («Надстройки») позволяет работать с надстройкамиПОSMART Notebook
(см. Chapter 11: Расширениефункционала ПОSMART Notebook с помощью надстроек на
странице 221).

Вызов вкладки «Надстройки»

Чтобы открыть вкладку Add-ons («Надстройки»), нажмите Add-ons («Надстройки») .

Настройка вкладки «Надстройки»
Вкладку Add-ons («Надстройки») можно переместить с одной стороны окна SMART Notebook

на другую, нажав значок Move Sidebar («Переместить боковую панель») .

Размер вкладки Add-ons («Надстройки») можно изменить, перетягивая ее край влево или
вправо. Если вкладка Add-ons («Надстройки») не используется, ее можно скрыть, установив
флажокAuto-hide («Скрывать автоматически»). (Чтобы отобразить скрытую вкладку Add-

ons («Надстройки»), нажмитеAdd-ons ).

NOTE

Если уменьшить размер вкладки «Надстройки» до минимального, функция скрытия
включится автоматически.

Вкладка SMARTResponse
Вкладка SMART Response является частью ПОSMART Response и доступна, только если на
компьютере установлено ПОSMART Response.

Область страницы
В области страницы отображается содержимое выбранной страницы в файле. Это область
страницы, где вы можете создавать объекты и работать с ними (см. Chapter 4: Создание
основных объектов на странице 31).
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Просмотр уведомлений при смене
инструмента
Если в вашем продукте SMART включенафункция распознавания касаний, ПО
SMART Notebook будет отображать уведомления о смене инструмента при выборе нового
инструмента или изменении его параметров. Перья, ластик и мышь являются аппаратными
инструментами. Вы такжеможете просматривать уведомления при смене инструмента, когда
касаетесь пальцем поверхности экрана.

NOTE

Не все аппаратные продукты SMART поддерживают технологию распознавания касаний.
Дополнительная информация приведена в руководстве пользователя оборудования
SMART.

Просмотр уведомлений о смене инструмента

Нажмите на панель инструментов с помощью пера или пальца, а затем выберите
параметры инструмента.

Под панелью инструментов появится панель состояния, на которой будут отображаться
активный инструмент и его параметры. Панель состояния обновляется при каждом
выборе инструмента или изменении параметров.

NOTE

Панель состояния также появляется при задании параметров чернил аппаратного пера
на панели Properties («Свойства») (см. раздел Изменение свойств объектов на
странице 66).
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Использование жестов
С объектами в ПОSMART Notebook можно взаимодействовать с помощью следующих
жестов (если они поддерживаются интерактивным продуктом):

Смахивание (слева направо) Смахивание (справа налево)

Жест-щипок для увеличения изображения
/ масштабирования (увеличения)

Жест-щипок для уменьшения
изображения / масштабирования

(уменьшения)

Панорамировать Вращать
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Встряхивать Быстрое движение

Отмена и возврат действий
При внесении изменений в файл можно отменить эффект предыдущих действий и команд.

NOTE

Если интерактивный продукт используется двумя пользователями, нажатие Undo
(«Отменить») и Redo («Восстановить») влияет на действия обоих пользователей.

Отмена последнего действия:

Нажмите кнопку Undo («Отменить») .

NOTE

Вы можете отменять неограниченное количество действий.

Восстановление последнего действия, отмененного командой Undo («Отмена»):

Нажмите кнопку Redo («Восстановить») .
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Chapter 2: Создание файлов и работа с
ними
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В ПОSMART Notebook можно создавать или открывать файлы *.notebook. После создания
или открытия файла *.notebook его можно сохранить, напечатать и выполнить с ним другие
стандартные действия.

Создание файлов
При первом запуске SMART Notebook автоматически открывается файл руководства. В
дальнейшем при запуске ПО новый пустойфайл *.notebook открывается автоматически.
Однако новыйфайл можно создать в любоймомент.

Чтобы создать файл:

Выберите File > New («Файл» > «Создать»).

Если вы работаете с файлом, в котором имеются несохраненные изменения, появится
диалоговое окно с вопросом о сохранении текущегофайла. Нажмите Yes («Да») , чтобы
сохранить изменения, а затем следуйте инструкциям на экране.
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Открытие файлов
ПОSMART Notebook 15.х открывает и сохраняет файлы *.notebook (формат по умолчанию
для ПОSMART Notebook 9.5, 9.7, 10 и 11)

NOTE

SMART Notebook версий 8.x, 9.0 и 9.1 может открыть файлы формата *.xbk, а не *.notebook.

Метод открытия файла одинаковый для всех версий программного обеспечения
SMART Notebook.

Чтобы открыть файл, выполните следующие действия:

1. НажмитеOpen File («Открыть файл») .

Появится диалоговое окноOpen («Открыть»).

2. Найдите и выберитефайл.

3. Нажмите кнопку Open («Открыть»).

TIP

Вы можете открыть недавно открывавшийся файл, выбрав меню File («Файл») , а
затем выбрав имяфайла.

Сохранение файлов

ПОSMART Notebook 15.х открывает и сохраняет файлы в формате *.notebook (формат по
умолчанию для ПОSMART Notebook 9.5, 9.7, 10 и 11)

NOTE

По умолчанию для SMART Notebook версий 8, 9.0 и 9,1 используется формат файла *.xbk.
Однакоформат *.xbk не поддерживает некоторые объекты и свойства, имеющиеся в этой
версии SMART Notebook.

Сохранение нового файла:

1. Нажмите Save («Сохранить») .

Появится диалоговое окно Save As («Сохранить как»).
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2. Выберите папку для сохранения новогофайла.

3. Введите имяфайла в полеFile name («Имяфайла»).

4. Нажмите «Сохранить».

Сохранение существующего файла:

Нажмите Save («Сохранить») .

Сохранение под новым именем или в новом месте:

1. Выберите File > Save As («Файл» > «Сохранить как»).

Появится диалоговое окно Save As («Сохранить как»).

2. Выберите папку для сохранения новогофайла.

3. Введите имяфайла в поле File name («Имяфайла») .

4. Нажмите «Сохранить».

Экспорт файлов
Файлы *.notebook можно экспортировать в следующиеформаты:

l Веб-страницы

l Форматы изображений

o BMP

o GIF

o JPEG

o PNG

l PowerPoint®

l PDF

l Используемыйформат файлов интерактивных досок (CFF)
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NOTES

l ПОSMART Notebook не включает вложения при экспортированиифайлов в виде
изображений. Чтобы включить вложения, следует экспортировать файл как веб-
страницу или PDF (Adobe Acrobat Reader 6.0 и более поздней версии).

l ПОSMART Notebook не экспортирует файлы, прикрепляемые к файлу *.notebook в
виде ярлыка. Чтобы вложить файл, прикрепите его копию (см. Вложениефайлов и веб-
страниц на странице 108).

l ПОSMART Notebook не экспортирует некоторые эффекты градиентов, узоров и
изображений. Эти эффекты могут отображаться в экспортированном файле неверно
или в виде сплошной заливки.

Вы такжеможете настроить ПОSMART Notebook на сохранениефайла *.notebook при
переходе к другой странице или по истечении заданного времени (см. Автоматическое
сохранениефайлов на странице 19).

Экспорт файла в формате веб-страниц

1. Выберите File > Export As > Web Page («Файл» > «Экспортировать как» > «Веб-
страница»).

Появится диалоговое окно Save As («Сохранить как»).

2. Выберите папку для экспортафайла.

3. Введите имяфайла в поле File name («Имяфайла») .

4. Нажмите «Сохранить».

Экспорт файла в формате изображения

1. Выберите File > Export As > Image Files («Файл» > «Экспортировать как» > «Файлы
изображений»).

Появится диалоговое окно Save As («Сохранить как»).

2. Выберите папку, в которую нужно экспортировать файлы изображений.

3. Выберите требуемыйформат изображения из выпадающего спискаImage Type («Тип
изображения»).

4. Выберите размер изображения из выпадающего спискаSize («Размер»).

5. НажмитеOK.
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Экспорт файла в PowerPoint

1. Выберите пункт меню File > Export As > PowerPoint («Файл» > «Экспортировать как»
> PowerPoint).

Появится диалоговое окно Save As («Сохранить как»).

2. Выберите папку для экспортафайла.

3. Введите имяфайла в поле File name («Имяфайла») .

4. Выберите PowerPoint 2007 Files (*.pptx) («Файлы PowerPoint 2007 (*.pptx)») или
PowerPoint Files (*.ppt) («Файлы PowerPoint (*.ppt)») в выпадающем списке Save at
(«Сохранить в формате»).

5. Нажмите «Сохранить».

NOTE

Файлы PowerPoint можно также импортировать (см. Импорт файлов Microsoft
PowerPoint на странице 102).

Экспорт файла в формате PDF

1. Выберите File > Export As > PDF («Файл» > «Экспорт» > PDF).

Появится диалоговое окно Export PDF («Экспорт PDF»).

2. Нажмите Thumbnails («Эскизы»), Handouts («Проспекты») или Full Page («Вся
страница»).

3. Дополнительно введите текст заголовка в поле Header («Заголовок») текст нижнего
колонтитула в поле Footer («Нижний колонтитул») и текущую дату в поле Date («Дата») .

4. Дополнительно установитефлажок Show page numbers («Показывать номера
страниц») , чтобы показывать номер каждой страницы.

5. Если вы нажали Thumbnails («Эскизы») или Handouts («Проспекты») нашаге 2,
выберите размер эскиза в выпадающем списке Thumbnail size («Размер эскиза») и
опционально установитефлажок Page borders («Границы страниц») , чтобы показать
границу вокруг каждого эскиза, ифлажок Thumbnail titles («Названия эскизов») ,
чтобы показать название под каждым эскизом.
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6. Выберите All («Все») , чтобы включить все страницы.

ИЛИ

Выберите Pages («Страницы») , чтобы включить избранные страницы, затем введите
номера страниц в поле. Разделяйте номера страниц запятыми, а для указания
диапазона страниц используйте дефис (например, 1,2,4-7).

7. Нажмите «Сохранить».

На экране появится диалоговое окно Save as PDF File («Сохранить в файл формата
PDF»).

8. Выберите папку для экспортафайла.

9. Введите имяфайла в поле File name («Имяфайла») .

10. Нажмите «Сохранить».

Экспорт файла в формате CFF

1. Выберите File > Export As > CFF («Файл» > «Экспортировать как» > CFF).

Появится диалоговое окно Save As («Сохранить как»).

2. Выберите папку для экспортафайла.

3. Введите имяфайла в поле File name («Имяфайла») .

4. Нажмите «Сохранить».

NOTE

Можно также импортировать файлы CFF (см. Импорт файлов из других программ для
работы с интерактивными досками на странице 103).

Печать файлов
Можно напечатать все или выбранные страницы файла *.notebook. Страницы можно
распечатывать в виде эскизов, раздаточных материалов или целых страниц.

Печать файла:

1. Выберите File > Print («Файл» > «Печать»).

Появится диалоговое окноPrint («Печать»).
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2. Нажмите Thumbnails («Эскизы»), Handouts («Проспекты») или Full Page («Вся
страница»).

3. Дополнительно введите текст заголовка в поле Header («Заголовок») текст нижнего
колонтитула в поле Footer («Нижний колонтитул») и текущую дату в поле Date («Дата») .

4. Дополнительно установитефлажок Show page numbers («Показывать номера
страниц») , чтобы показывать номер каждой страницы.

5. Если вы нажали Thumbnails («Эскизы») или Handouts («Проспекты») нашаге 2,
выберите размер эскиза в выпадающем списке Thumbnail size («Размер эскиза») и
опционально установитефлажок Page borders («Границы страниц») , чтобы показать
границу вокруг каждого эскиза, ифлажок Thumbnail titles («Названия эскизов») ,
чтобы показать название под каждым эскизом.

6. Выберите All («Все») , чтобы включить все страницы.

ИЛИ

Выберите Pages («Страницы») , чтобы включить избранные страницы, затем введите
номера страниц в поле. Разделяйте номера страниц запятыми, а для указания
диапазона страниц используйте дефис (например, 1,2,4-7).

7. Выберите вкладку Printer Setup («Настройка принтера») .

8. Укажите другие параметры печати, такие как имя принтера и количество копий.

9. Нажмите Print («Печать»).

Автоматическое сохранение файлов
Вы можете в любоймомент сохранить свойфайл *.notebook (см. Сохранениефайлов на
странице 14), а также экспортировать его в различныеформаты (см. Экспорт файлов на
странице 15). Вы такжеможете настроить SMART Notebook на автоматическое сохранение
файла при переходе к другой странице или по истечении заданного времени.

NOTES

l ПОSMART Notebook не включает вложения при экспортированиифайлов в виде
изображений. Чтобы включить вложения, следует экспортировать файл как веб-
страницу или PDF (Adobe Reader 6.0 и более поздней версии).

l ПОSMART Notebook не экспортирует файлы, прикрепляемые к файлу *.notebook в
виде ярлыка. Чтобы вложить файл, прикрепите его копию (см. Вложениефайлов и веб-
страниц на странице 108).
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l ПОSMART Notebook не экспортирует некоторые эффекты градиентов, узоров и
изображений. Эти эффекты могут отображаться в экспортированном файле неверно
или в виде сплошной заливки.

Автоматическое сохранение файлов:

1. Выберите File > Timed Saves («Файл» > «Сохранения по времени»).

Появится окно мастера планирования сохранений.

2. Выберите Every time I move to a different page («При каждом переходе на другую
страницу») , чтобы файл автоматически сохранялся, когда вы выбираете другую
страницу.

ИЛИ

Выберите «1 минута», «5 минут», «15 минут» или «30 минут» , чтобы файл
сохранялся через указанные промежутки времени.

3. Нажмите «Далее».

4. Выберите Notebook Document («Документ Notebook»).

5. Нажмите «Далее».

Появится диалоговое окно Save As («Сохранить как»).

6. Выберите папку для сохранения новогофайла.

7. Введите имяфайла в поле File name («Имяфайла») . SMART Notebook автоматически
сохранит файл с расширением *.notebook.

8. Нажмите «Сохранить».

Автоматическое сохранение файла в формате веб-страниц:

1. Выберите File > Timed Saves («Файл» > «Сохранения по времени»).

Появится окно мастера планирования сохранений.

2. Выберите Every time I move to a different page («При каждом переходе на другую
страницу») , чтобы файл автоматически экспортировался, когда вы выводите на экран
другую страницу.

ИЛИ

Выберите «1 минута», «5 минут», «15 минут» или «30 минут» , чтобы файл
экспортировался через указанные промежутки времени.

3. Нажмите «Далее».
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4. ВыберитеWeb Page (HTML) («Веб-страница (HTML)»).

5. Нажмите «Далее».

Появится диалоговое окно Save As («Сохранить как»).

6. Выберите папку для экспортафайла.

7. Введите имяфайла в поле File name («Имяфайла») .

8. Нажмите «Сохранить».

Автоматическое сохранение файла в файлы PDF:

1. Выберите File > Timed Saves («Файл» > «Сохранения по времени»).

Появится окно мастера планирования сохранений.

2. Выберите Every time I move to a different page («При каждом переходе на другую
страницу») , чтобы файл автоматически экспортировался, когда вы выводите на экран
другую страницу.

ИЛИ

Выберите «1 минута», «5 минут», «15 минут» или «30 минут» , чтобы файл
экспортировался через указанные промежутки времени.

3. Нажмите «Далее».

4. Выберите PDF.

ИЛИ

Выберите Time Stamped PDFs («PDF с отметкой времени»), если вы хотите, чтобы
имяфайла содержало время экспорта.

5. Нажмите «Далее».

Появится диалоговое окно Save As («Сохранить как»).

6. Выберите папку для экспортафайла.

7. Введите имяфайла в поле File name («Имяфайла») .

8. Нажмите «Сохранить».

Автоматическое сохранение файла в формате изображения:

1. Выберите File > Timed Saves («Файл» > «Сохранения по времени»).

Появится окно мастера планирования сохранений.
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2. Выберите Every time I move to a different page («При каждом переходе на другую
страницу») , чтобы файл автоматически экспортировался, когда вы выводите на экран
другую страницу.

ИЛИ

Выберите «1 минута», «5 минут», «15 минут» или «30 минут» , чтобы файл
экспортировался через указанные промежутки времени.

3. Нажмите «Далее».

4. Выберите Image Files («Файлы изображений»).

5. Нажмите «Далее».

6. Нажмите Browse («Обзор»), найдите папку, в которую нужно экспортировать файлы и
нажмитеOpen («Открыть»).

7. Выберите требуемыйформат изображения из выпадающего спискаImage Type («Тип
изображения»).

8. Выберите размер изображения из выпадающего списка Size («Размер»).

9. НажмитеOK.

Автоматическое сохранение файла в файл PowerPoint:

1. Выберите File > Timed Saves («Файл» > «Сохранения по времени»).

Появится окно мастера планирования сохранений.

2. Выберите Every time I move to a different page («При каждом переходе на другую
страницу») , чтобы файл автоматически экспортировался, когда вы выводите на экран
другую страницу.

ИЛИ

Выберите «1 минута», «5 минут», «15 минут» или «30 минут» , чтобы файл
экспортировался через указанные промежутки времени.

3. Нажмите «Далее».

4. Выберите PowerPoint.

5. Нажмите «Далее».

Появится диалоговое окно Save As («Сохранить как»).

6. Выберите папку для экспортафайла.
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7. Введите имяфайла в поле File name («Имяфайла») .

8. Нажмите «Сохранить».

Отмена автоматического сохранения файла:

1. Выберите File > Timed Saves («Файл» > «Сохранения по времени»).

Появится окно мастера планирования сохранений.

2. Выберите Do not save the document automatically («Не сохранять документ
автоматически»).

3. Нажмите «Далее».

Вложение файлов в сообщения электронной
почты
Вы можете отправить файл другому человеку, вложив файл или PDF-версию файла в
сообщение электронной почты.

Вложение файла к сообщению электронной почты:

Выберите File > Send To > Mail Recipient («Файл» > «Отправить» > «Отправить
адресату»).

Запустится заданная по умолчанию программа электронной почты, будет создано новое
сообщение, и текущийфайл будет вложен в это сообщение.

Если вы не сохранилифайл, SMART Notebook сохранит его как временныйфайл с
именем untitled.notebook , и ваша почтовая программа вложит этот временныйфайл в
сообщение электронной почты.

Вложение файла в сообщение электронной почты в виде PDF:

Выберите пункт меню File > Send To > Mail Recipient (as PDF) («Файл» > «Отправить»
> «Отправить адресату (как PDF)»).

Запустится заданная по умолчанию программа электронной почты, будет создано новое
сообщение, и PDF-версия текущегофайла будет вложена в это сообщение.

Если вы не сохранилифайл, SMART Notebook сохранит его как временный PDF-файл с
именем untitled.pdf , и ваша почтовая программа вложит этот временныйфайл в
сообщение электронной почты.
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Файл *.notebook состоит из набора страниц, каждая из которых содержит свои объекты и
обладает своими свойствами.

Эскиз каждой страницы отображается в сортировщике страниц. С помощью сортировщика
страниц или команд меню можно вывести существующую страницу на экран, создать пустую
страницу, добавить дубликат существующей страницы или удалить страницу.

Отображение страниц в файле
Любую страницу в файле можно отобразить с помощью сортировщика страниц. Следующую
или предыдущую страницу файла можно отобразить с помощью кнопок или жестов.

Вывод страницы на экран

1. Если «Сортировщик страниц» не отображается, нажмите «Сортировщик страниц» .

2. Выделите эскиз страницы, которую вы хотите отобразить.

Вывод следующей страницы файла

Нажмите Next Page («Следующая страница») .

ИЛИ
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Совершите быстрое движение пальцем по странице справа налево.

Появится сообщение с номером текущей страницы.

Вывод предыдущей страницы файла

Нажмите Previous Page («Предыдущая страница») .

ИЛИ

Совершите быстрое движение пальцем по странице слева направо.

Появится сообщение с номером текущей страницы.

Создание страниц
В открытыйфайл можно добавить пустую новую страницу с помощью кнопки Add Page
(«Добавить страницу») или сортировщика страниц.
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Добавление страницы с помощью кнопки Add Page («Добавить страницу»)

Нажмите кнопку Add Page («Добавить страницу») .

После текущей страницы появится новая страница.

Вставка страницы с помощью сортировщика страниц

1. Если «Сортировщик страниц» не отображается, нажмите «Сортировщик страниц» .

2. Выделите эскиз той страницы, посл�� которой требуется вставить новую страницу.

3. Нажмите на стрелку меню этого эскиза и выберите пункт Insert Blank Page («Вставить
пустую страницу»).

После выбранной страницы появится новая страница.

Клонирование страниц
В качестве альтернативы созданию пустой страницы, вы можете создать копию (клон)
существующей страницы.

NOTE

Вы можете клонировать страницу, только если на ней что-нибудь содержится.

Клонирование страницы:

1. Если «Сортировщик страниц» не отображается, нажмите «Сортировщик страниц» .

2. Выделите эскиз страницы, которую требуется клонировать.

3. Нажмите на стрелку меню этого эскиза и выберите Clone Page («Клонировать
страницу»).

Клонированная страница появится непосредственно после текущей страницы.

NOTE

Данную операцию можно повторять нужное количество раз.

Увеличение пространства страниц
Если вам требуется большеместа в нижней части страницы, вы можете увеличить страницу
по вертикали, не затрагивая ееширину. Эту функцию можно отключить, чтобы исключить
увеличение высоты страниц.
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Увеличение пространства страницы

1. Если страница отображается в режиме «Вся страница», выберите другой уровень
увеличения для страницы.

2. Нажмите Extend Page («Растянуть страницу») в нижней части страницы.

Включение и выключение функции «Растянуть страницу»

1. Выберите View > Extend Page («Вид» > «Растянуть страницу»).

2. ВыберитеOff («Отключить») , чтобы отключить функцию Extend Page
(«Растянуть страницу»).

ИЛИ

ВыберитеOn («Включить») , чтобы включить функцию Extend Page
(«Растянуть страницу».

Переименование страниц
При создании страницы ПОSMART Notebook автоматически присваивает ей имя с указанием
даты и времени создания. Это имя можно изменить.

Переименование страницы:

1. Если «Сортировщик страниц» не отображается, нажмите «Сортировщик страниц» .

2. Дважды нажмите имя страницы.

3. Введите новое имя страницы.

4. Нажмите в любом месте экрана.

Вырезание, копирование и вставка страниц
Теперь вы можете вырезать, копировать и вставлять страницы из текущегофайла с
помощью сортировщика страниц.

Вырезание, копирование или вставка страницы с помощью сортировщика страниц

1. Если «Сортировщик страниц» не отображается, нажмите «Сортировщик страниц» .

2. Выделите эскиз страницы, которую требуется вырезать.
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3. Нажмите на стрелку меню этого эскиза и выберите вариант «Вырезать страницу» или
«Копировать страницу» .

4. Выделите эскиз страницы, которая должна следовать за вставляемой страницей.

5. Нажмите на стрелку меню этого эскиза и выберите «Вставить страницу».

Новый эскиз появится перед эскизом, выбранном на предыдущем этапе.

TIP

Такжеможно копировать и вставлять страницы из других файлов ПОSMART Notebook.

Изменение порядка страниц
Прижелании вы можете изменить порядок страниц в файле.

Изменение порядка страниц:

1. Если «Сортировщик страниц» не отображается, нажмите «Сортировщик страниц» .

2. Выделите эскиз страницы, которую вы хотите переместить в пределах файла.

Вокруг эскиза появится синяя рамка.

3. Перетащите эскиз в новое место в сортировщике страниц.

Синяя линия показывает новое положение страницы.

4. Отпустите эскиз.

Удаление страниц
Вы можете удалить страницу из текущегофайла с помощью кнопки Delete Page («Удалить
страницу») или сортировщика страниц.

TIP

Вместо удаления страницы можно просто удалить с нее все объекты (см. Очистка страниц
на странице 216).

Удаления страницы с помощью кнопки Delete Page («Удалить страницу»)

1. Если этого не было сделано ранее, выведите на экран страницу, которую вы хотите
удалить.
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2. Выберите Delete Page («Удалить страницу») .

Удаление страницы с помощью сортировщика страниц

1. Если «Сортировщик страниц» не отображается, нажмите «Сортировщик страниц» .

2. Выделите эскиз страницы, которую требуется удалить.

3. Нажмите на стрелку меню этого эскиза и выберите Delete Page («Удалить страницу»).
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Объекты — это строительные блоки содержимогофайлов *.notebook. Объект — это просто
элемент на странице, который вы создаете или импортируете, чтобы работать с ним.
Основные типы объектов включают:

l Цифровые чернила (написанное и нарисованное от руки)

l Фигуры

l Прямые линии

l Дуги

l Текст

l Таблицы

Написание, рисование и стирание цифровых
чернил
Цифровые чернила — текст или объекты, нарисованные от руки с помощью пера или перьев
интерактивного экрана, или с помощью пера ПОSMART Notebook. Написание или рисование
с помощью цифровых чернил позволяет быстро добавлять материал в файлы
SMART Notebook при созданиифайлов или во время представления файлов учащимся.

Вы можете стирать надписи или рисунки, сделанные цифровыми чернилами.

Написание или рисование цифровыми чернилами
Перья интерактивного экрана — самый простой способ писать или рисовать цифровыми
чернилами.
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Вы такжеможете создавать рукописные объекты с помощью инструмента «Перо».
Инструмент «Перо» позволяет писать или рисовать цифровыми чернилами с помощью
следующих типов пера.

Тип пера Цель и пример Примечания

Стандартное
перо

Пишите или рисуйте цифровыми
чернилами разных цветов и типов линий.

С помощью пера типа
«Стандартное» можно
писать или рисовать
цифровыми чернилами,
исчезающими через
несколько секунд (см.
раздел Использование
инструмента «Стандартное
перо» для создания
исчезающих объектов на
странице 190).

Каллиграфическое
перо

Пишите или рисуйте цифровыми
чернилами тем же способом, что и
пером «Стандартное», но толщина линии
может изменяться.

Перо типа
«Каллиграфическое»
удобно для обучения
учащихся письму.

Мелок Пишите или рисуйте цифровыми
чернилами с эффектом мелка.

Тип пера «Мелок»
предназначен не столько
для письма, сколько для
творческой работы,
например живописи и
раскрашивания
изображений.

Выделение
Выделяйте текст и другие объекты.

Текстовое

перо

Сделанные вами записи будут
автоматически преобразовываться в
текст с возможностью редактирования.

Вы сможете редактировать
текст во время работы без
помощи клавиатуры (см.
раздел Использование
инструмента «Текстовое
перо» на странице 184).



CHAPTER 4
СОЗДАНИЕ ОСНОВНЫХ ОБЪЕКТОВ

34

Тип пера Цель и пример Примечания

Художественное
перо

Добавляйте цветные элементы в ваши
презентации.

Можно создавать
пользовательские стили
художественного пера (см.
раздел Создание
пользовательских стилей
художественного пера на
странице 118).

Кисть Пишите или рисуйте цифровыми
чернилами с эффектом кисти.

Тип пера «Кисть»
предназначен не столько
для письма, сколько для
творческой работы,
например живописи и
раскрашивания
изображений.

Волшебное
перо

Пишите или рисуйте цифровыми
чернилами, исчезающими через
несколько секунд.

Волшебное перо также
можно использовать для
открытия окна увеличения
или окна подсветки (см.
раздел Работа с
инструментом «Волшебное
перо» на странице 183).

Распознавание
фигур

Рисуйте различныефигуры с помощью
цифровых чернил.

Вы можете рисовать круги,
овалы, квадраты,
прямоугольники,
треугольники и дуги (см.
раздел Созданиефигур с
помощью инструмента
«Перо распознавания
фигур» на странице 39).
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Написание или рисование цифровыми чернилами:

1. Нажмите Pens («Перья») .

Появляется кнопка инструмента «Перья».

2. Нажмите Pen Types («Типы перьев»), затем выберите тип пера.

3. Выберите тип линии.

4. По желанию можно настроить тип линии с помощью переключателей свойств.

NOTE

Настроить тип линии или дуги можно с помощью вкладки Properties («Свойства») (см.
Изменение свойств объектов на странице 66).
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5. Пишите или рисуйте на странице цифровыми чернилами.

TIPS

o Во время письма или рисования не облокачивайтесь на поверхность
интерактивного продукта и не кладите на него ладонь.

o Если вы пишете или рисуете несколько линий, ПОSMART Notebook
автоматически объединяет линии в один объект. Например, если вы пишете
буквы слова, SMART Notebook объединяет отдельные буквы, позволяя вам
работать с целым словом. Если вы хотите писать слова на одной строке, но не
хотите,чтобы они объединялись, оставляйте между ними большой интервал,
используйте разные перья или ненадолго положите перо в лоток перед
написанием другого слова (только для интерактивных досок).

o Если вы хотите писать по диагонали, нарисуйте прямую линию, а потом поверните
ее (см. раздел Поворот объектов на странице 82).

o Если вы хотите писать маленькими буквами, напишите большими, а затем
уменьшите их размер (см. раздел Изменение размеров объектов на странице 80).

o Можно использовать заливку для всех областей, ограниченных цифровыми
чернилами (см. раздел Заливка рисунков, выполненных цифровыми чернилами
на странице 69).

Стирание цифровых чернил
Цифровые чернила можно стирать с интерактивного дисплея с помощью ластика или жеста
стирания. Если вы стираете цифровые чернила со страницы файла *.notebook, вы также
можете стирать объекты с помощью инструмента Eraser («Ластик»).

NOTE

Можно стирать цифровые чернила, но не объекты других типов, включая фигуры, линии,
текст и изображения. Чтобы убрать такие объекты, их следует удалить (см. Удаление
объектов на странице 86).

Стирание цифровых чернил

1. Нажмите инструмент Eraser («Ластик») , а затем выберите тип ластика.

2. Сотрите цифровые чернила.
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Создание фигур и линий
Фигуры и линии можно создавать не только рукописным способом цифровыми чернилами,
но и с помощью специальных инструментов в SMART Notebook.

NOTE

Чтобы убрать фигуру или линию со страницы, ее необходимо удалить (см. Удаление
объектов на странице 86). Инструмент «Ластик» не удаляет фигуры.

Созданиефигур с помощью инструмента «Фигуры»
С помощью инструмента «Фигуры»можно создавать разнообразныефигуры, в том числе
круги, квадраты и треугольники, другие геометрическиефигуры, сердцеобразныефигуры,
галочки, крестики, и т.п.

Вы можете добавить фигуру на страницу, а затем отредактировать ее свойства. И, наоборот,
вы можете настроить цвет контурафигуры, цвет заливки, толщину линий, а затем добавить
фигуру на страницу.

Чтобы создать фигуру, выполните следующие действия:

1. Нажмите Shapes («Фигуры») .

Появляется кнопка инструмента «Фигуры».

2. Выберитефигуру на панели инструментов.

ИЛИ

Нажмите , затем выберитефигуру.

3. По желанию можно настроить фигуру с помощью переключателей свойств.

NOTE

Настроить типфигуры можно с помощью вкладки Properties («Свойства») (см.
Изменение свойств объектов на странице 66).
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4. Создайтефигуру, нажав на то место, куда вы хотите ее поместить, и тащите ее границу,
покафигура не приобретет нужный размер.

TIPS

o Вы можете создавать правильные круги, квадраты, треугольники и другие
фигуры, удерживая нажатой клавишу SHIFT во время рисования.

o Вы можете выбирать фигуры, когда активен инструмент Shapes («Фигуры») ,

не переключаясь на инструмент Select («Выбор») . Нажмите один раз на

фигуру, после чего вокруг нее появится рамка выделения.

Созданиефигур с помощью инструмента «Правильные
многоугольники»
Помимо создания фигур с помощью инструмента «Фигуры», можно также создавать
правильныемногоугольники с количеством сторон от 3 до 15 с помощью инструмента
«Правильныемногоугольники».

Создание фигур с помощью инструмента «Правильные многоугольники»:

1. Нажмите Regular Polygons («Правильные многоугольники») .

Появляется кнопка инструмента «Правильныемногоугольники».

2. Выберитефигуру на панели инструментов.

ИЛИ

Нажмите , затем выберитефигуру.

NOTE

Число нафигуре указывает на количество ее сторон.
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3. По желанию можно настроить фигуру с помощью переключателей свойств.

NOTE

Настроить типфигуры можно с помощью вкладки Properties («Свойства») (см.
Изменение свойств объектов на странице 66).

4. Создайтефигуру, нажав на то место, куда вы хотите ее поместить, и тащите ее границу,
покафигура не приобретет нужный размер.

Созданиефигур с помощью инструмента «Перо распознавания
фигур»
Вы можете использовать инструмент «Перо распознавания фигур» для рисования таких
фигур, как круги, овалы, квадраты, прямоугольники, треугольники и дуги.

NOTE

Фигуры можно также рисовать с помощью инструмента «Фигуры» (см. Созданиефигур с
помощью инструмента «Фигуры» на странице 37) или инструмента «Правильные
многоугольники» (см. Созданиефигур с помощью инструмента «Правильные
многоугольники» на предыдущей странице).

Рисование фигуры:

1. Нажмите Pens («Перья») .

Появляется кнопка инструмента «Перья».

2. Нажмите Pen Types («Типы перьев»), затем выберите Shape Recognition Pen («Перо
распознавания фигур»).
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3. Нарисуйтефигуру на странице.

Если ПОSMART Notebook распознает ваш рисунок как круг, овал, квадрат,
прямоугольник, треугольник или дугу, этафигура будет добавлена на страницу.

Создание прямых линий и дуг
Для рисования прямых линий и дуг можно использовать инструмент «Линии».

Вы можете добавить линию на страницу, а затем отредактировать ее свойства. Или можно
настроить линию и добавить ее на страницу.

Чтобы нарисовать прямую линию или дугу, выполните следующие действия:

1. Нажмите кнопку Lines («Линии») .

Появляется кнопка инструмента «Линии».

2. Выберите тип линии или дуги.

3. По желанию можно настроить тип линии или дуги с помощью переключателей свойств.

NOTE

Настроить тип линии или дуги можно с помощью вкладки Properties («Свойства») (см.
Изменение свойств объектов на странице 66).

4. Для создания линии нажмите в месте, где должна начинаться линия, и тащите ее в
место, где она должна заканчиваться.
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Создание текста
Вводить текст в SMART Notebook можно любым из следующих способов:

l С клавиатуры компьютера

l Ввод текста с клавиатуры SMART

l Написание текста от руки (см. раздел Написание, рисование и стирание цифровых
чернил на странице 32) и преобразование его в печатный текст с помощью функции
распознавания рукописного текста

После ввода текста его можно редактировать, проверять орфографию и изменять его
свойства, включая стиль, размер и цвет шрифта.

Ввод текста
Можно вводить новый текст или редактировать существующий.

Ввод нового текста:

1. Если клавиатура недоступна, нажмите на значок SMART Board в области

уведомлений, а затем выберите Keyboard («Клавиатура»).

2. Нажмите инструмент Text («Текст») , а затем выберите доступный типшрифта.

3. При желании можно настраивать типшрифта (см. раздел Форматирование текста на
странице 43).

4. Нажмите в месте, где должен начинаться текст.

5. Введите текст.

6. По завершении нажмите за пределами текстового объекта.

Изменение существующего текста:

1. Дважды нажмите текстовый объект.

2. Отредактируйте текст.

3. По завершении нажмите за пределами текстового объекта.
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Преобразование рукописного текста в печатный
Вы можете писать на экране интерактивного продукта с помощью инструмента «Стандартное
перо» или «Каллиграфическое перо» и преобразовывать написанное в печатный текст.
SMART Notebook может преобразовывать рукописный текст на нескольких языках.

Преобразование рукописного текста в печатный:

1. Нажмите Pens («Перья») .

Появляется кнопка инструмента «Перья».

2. Нажмите Pen Types («Типы перьев»), затем выберите Pen («Перо») или Calligraphic
Pen («Каллиграфическое перо»).

3. Напишите текст.

TIP

Пишите аккуратно, печатными буквами, по горизонтальной линии. Хотя SMART
Notebook может преобразовывать написанный наклонно или письменными буквами
текст, это не всегда получается должным образом.

4. Выделите текстовый объект.

Функция распознавания рукописного текста SMART Notebook сравнивает написанное
вами слово со своим словарем и идентифицирует слова, наиболее похожие на
написанное.
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5. Нажмите на стрелку меню текстового объекта.

Появится меню и список совпадающих слов, перед каждым из которых будет пункт
Recognize («Распознать»).

NOTES

o Если вы хотите, чтобы SMART Notebook распознавал слова на другом языке,
выберите Recognize Languages («Распознавать языки») и выберите другой
язык из списка. SMART Notebook обновит список совпадающих слов, включив в
него слова на выбранном языке.

o Если вы меняете язык распознавания рукописного текста, вы не меняете
заданный по умолчанию язык пользовательского интерфейса SMART Notebook
или вашей операционной системы.

6. Выберите слово из списка совпадающих слов.

Выбранное слово появится на странице.

Форматирование текста
Если хотите отформатировать весь текст в текстовом объекте, выделите этот текстовый
объект.

ИЛИ

Если вы хотите отформатировать только часть текста в текстовом объекте, дважды нажмите
текстовый объект, затем выделите нужную часть текста.

Для форматирования текста можно использовать кнопки на панели инструментов, параметры
на вкладке «Свойства» и меню «Формат».

NOTE

Если вкладка Properties («Свойства») не отображается, нажмите Properties («Свойства»)

, затем выберите Text Style («Стиль текста»).

В следующей таблице описаны изменения в форматировании, которыеможно внести с
помощью упомянутых выше инструментов.

Заменить Панель
инструментов

Вкладка
«Свойства»

Меню
«Формат»

Символ, абзац или объект

Изменениешрифта
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Заменить Панель
инструментов

Вкладка
«Свойства»

Меню
«Формат»

Изменить размершрифта

TIP

Для выбора размерашрифта, который не
представлен в раскрывающемся списке,
(включая дробные значения, такие как 20,5)
введите этот размер в поле Font Size
(«Размершрифта») на панели инструментов.

Изменение цвета

Полужирное начертание, курсив или
подчеркивание

Зачеркивать текст 1

Подстрочные и надстрочные индексы 2

Абзац или объект

Изменение выравнивания (по левому краю, по
правому краю или по центру)

Изменение отступа 3

Создание маркированных или нумерованных
списков

4

Вставка буквицы

TIP

Для вставки буквицы в начале абзаца
нажмите кнопку Drop Cap («Буквица»)

на вкладке Properties («Свойства») окна Text
Style («Стиль текста»).

ИЛИ

Выберите Format > Paragraph > Drop Cap
(«Формат» > «Абзац» > «Буквица».

1ВпунктеMore Text Options («Другие параметры текста»)

2ВпунктеMore Text Options («Другие параметры текста»)

3ВпунктеMore Text Options («Другие параметры текста»)

4ВпунктеMore Text Options («Другие параметры текста»)
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Заменить Панель
инструментов

Вкладка
«Свойства»

Меню
«Формат»

Изменение межстрочного интервала

TIP

Для увеличения интервала между абзацами
установитефлажок Add space after
paragraphs («Добавить пробел после
абзацев») на вкладке Properties
(«Свойства») или выберите Format >
Paragraph > Line Spacing > Add space after
paragraphs («Формат» > «Абзац» >
«Межстрочный интервал» > «Добавить
пробел после абзацев»).

Изменение направления письма (слева направо
или справа налево)

NOTE

Выберите Format > Paragraph > Direction >
Left to Right («Формат» > «Абзац» >
«Направление» > «Слева направо») для
языков с письмом слева направо (например,
английского илифранцузского).

ИЛИ

Выберите Format > Paragraph > Direction >
Right to Left («Формат» > «Абзац» >
«Направление» > «Справа налево») для
языков с письмом справа налево (например,
арабского или иврита).

Объект

Изменение направления текста
(горизонтальное или вертикальное)

5

Изменение прозрачности

Изменение размеров текстовых объектов
Изменение текстового объекта в соответствии с процедурой, описанной в разделе Изменение
размеров объектов на странице 80, приводит к изменению размера текста этого объекта.

5ВпунктеMore Text Options («Другие параметры текста»)
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Если хотите изменить размер текстового объекта, не изменяя размер текста этого объекта,
выполните следующую процедуру.

Для изменения размера текстового объекта

1. Дважды нажмите текстовый объект.

2. Нажмите один из белых кружков, расположенных по бокам текстового объекта, затем
перетащите его, чтобы увеличить или уменьшить размер объекта.

Вставка математических символов
Можно вставлять на страницу различныематематические и научные символы.

NOTE

Математические обозначения представляют собой только символы. Они не выполняют
математических операций.

Вставка математического символа

1. Введите текст на странице.

2. НажмитеMore Text Options («Другие параметры текста») , затем выберите Insert

Symbol («Вставка символа») .

Появится диалоговое окно Insert Symbols («Вставить символы»).

3. Нажмите на категорию.

Появится список символов.

4. Нажмите на символ, который вам нужно добавить в текст.

5. Нажмите Insert («Вставить»).

Символ появится в текстовом объекте.

Проверка правописания в текстовых объектах
Во время ввода текста SMART Notebook проверяет правописание. Если слово введено
неправильно, ПОSMART Notebook подчеркивает его красной линией. Можнощелкнуть по
слову правой кнопкой мыши и выбрать правильный вариант из предлагаемого списка.

При желании можно отключить эту функцию и проверять правописание с помощью
диалогового окна Spelling Check («Проверка правописания»).
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Отключение автоматической проверки правописания:

1. Нажмите Text («Текст») .

2. НажмитеMore Text Options («Другие параметры текста») , затем выберите Check

Spelling («Проверка правописания») .

Ручная проверка правописания текстового объекта:

1. Выделите текстовый объект.

2. Нажмите на стрелку меню объекта и выберите пункт Check Spelling («Проверка
правописания»).

Если ПОSMART Notebook обнаруживает неверно написанное слово, появляется
диалоговое окно Spelling Check («Правописание»).В этом диалоговом окне отображается
неверно написанное слово и предлагаются альтернативы.

3. Для каждого неправильно написанного слова выполните одно из следующих действий:

o Нажмите Ignore Once («Пропустить») , чтобы сохранить написание слова для
текущего случая.

o Нажмите Ignore All («Пропустить все»), чтобы сохранить написание слова для
всех случаев.

o Нажмите Add to Dictionary («Добавить в словарь»), чтобы сохранить текущее
написание слова для всех случаев в данном файле и добавить это написание в
словарь.

o Чтобы изменить написание слова для данного случая, выберите верный вариант из
списка Suggestions («Рекомендации») и нажмите Change («Изменить»).

o Чтобы изменить написание слова для всех случаев, выберите верный вариант из
списка Suggestions («Рекомендации») и нажмите Change All («Изменить все»).

NOTE

Если вы по ошибке нажали неправильную кнопку, нажмите Undo («Отменить») ,
чтобы отменить выполненное изменение.

После выполнения этогошага для каждого неправильно написанного слова появится
диалоговое окно с вопросом, нужно ли проверять правописание в оставшейся части
файла.



CHAPTER 4
СОЗДАНИЕ ОСНОВНЫХ ОБЪЕКТОВ

48

4. Нажмите Yes («Да») , чтобы проверить правописание в оставшейся частифайла.

ИЛИ

Нажмите No («Нет») , чтобы закрыть диалоговое окно Spelling Check («Правописание»)
без проверки оставшейся частифайла.

Вырезание и вставка текста
Можно вырезать, копировать и вставлять текст точно так же, как и любые другие объекты
(см. Вырезание, копирование и вставка объектов на странице 76). Кроме того, можно
вырезать и вставлять текст в текстовых объектах.

Вырезание и вставка текста в другое место на той же странице

1. Дважды нажмите текстовый объект.

2. Выделите текст, который требуется вырезать.

3. Перетащите выделенный текст в другое место на той же странице.

Вырезание и вставка текста на другую страницу

1. Если вкладка сортировщика страниц не отображается, нажмите Page Sorter

(«Сортировщик страниц») .

2. Дважды нажмите текстовый объект.

3. Выделите текст, который требуется скопировать.

4. Перетащите выделенный текст на значок другой страницы на вкладке сортировщика
страниц.
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Создание таблиц
Вы можете создавать таблицы в ПОSMART Notebook или вставлять их из других программ.
После создания таблицы можно добавлять в ее ячейки объекты.

Чтобы настроить таблицу, можно выделить таблицу, столбец, строку, ячейку или набор
ячеек, а затем:

l Переместить таблицу

l Изменить тип линий, заливку или свойства текста

l Изменить размер таблицы, столбца или строки

l Вставить и удалить столбцы, строки и ячейки

l Разбить или объединить ячейки

l Удалить таблицу

Создание таблиц

Добавление таблицы с помощью кнопки Table («Таблица»):

1. Нажмите Table («Таблица») .

Появится сетка.

2. Перемещая указатель по сетке, выберите нужное количество столбцов и строк таблицы.

NOTE

Ячейки сетки соответствуют ячейкам создаваемой таблицы.

TIP

По умолчанию в сетке отображается восемь столбцов и восемь строк. Можно
добавить строки, перемещая указатель ниже последней строки. Таким же образом
можно добавлять столбцы, перемещая указатель далее правого столбца.

Если вы используете мышь, нажмите и удерживайте нажатой левую кнопку мыши,
перемещая при этом указатель.

3. Нажмите на экране илищелкните мышкой.

На странице появится таблица.
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Добавление таблицы с помощью диалога Insert Table («Вставить таблицу»):

1. Выберите Insert > Table («Вставка» > «Таблица»).

Появится диалоговое окно Insert Table («Вставить таблицу»).

2. Введите число столбцов и строк в соответствующие поля.

3. Или выберитеMake cells square («Сделать ячейки квадратными») , чтобы сделать
ячейки квадратными.

4. Или выберите Remember dimensions for new tables («Запомнить размеры для новых
таблиц») , чтобы использовать размеры текущей таблицы для следующих таблиц,
создаваемых в ПОSMART Notebook.

5. НажмитеOK.

На странице появится таблица.

Рисование таблицы:

1. Нажмите Pens («Перья») .

Появляется кнопка инструмента «Перья».

2. Нажмите Pen Types («Типы перьев»), затем выберите Pen («Перо») или Calligraphic
Pen («Каллиграфическое перо»).

3. Выберите тип линии.

4. Нарисуйте таблицу на экране.

TIP

Делайте линии таблицы максимально прямыми и соединяйте углы.

5. Нажмите Select («Выбор») .

6. Выделите ваш рисунок.
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7. Нажмите на стрелку меню таблицы и выберите Recognize Table («Распознать
таблицу»).

Если SMART Notebook распознает ваш рисунок как таблицу, ваш рисунок будет убран, а
на страницу будет добавлена таблица.

Вставка таблиц из других программ
Вы можете вырезать или скопировать таблицу из Word или PowerPoint и вставить ее в файл
*.notebook как таблицу. Формат и структура таблицы, могут быть иными, чем в файле
*.notebook.

Если вы хотите вырезать или скопировать несколько таблиц, вы должны копировать или
вырезать их по одной.

NOTE

Вы такжеможете вырезать или скопировать таблицу из файла *.notebook и вставить ее в
Word или PowerPoint. Однакоформат и структура таблицы, могут быть иными, чем вWord
или PowerPoint.

При добавлении таблицы в файл PowerPoint, в котором есть ячейки и нетекстовые
объекты, нетекстовые объекты будут находиться за пределами таблицы в PowerPoint.

Добавление объектов в таблицы
После добавления таблицы на страницу вы можете вставлять объекты в ячейки таблицы.

NOTE

В каждую ячейку вы можете добавить только один объект. Если необходимо добавить
несколько объектов в ячейку, выполните следующее:

l Сгруппируйте объекты перед добавлением в таблицу (см. Группировка объектов на
странице 84).

l Выделите все объекты, затем добавьте их в таблицу как описано ниже. SMART
Notebook автоматически группирует объекты в ячейке таблицы.
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Добавление объекта в таблицу

1. Выберите объект.

2. Перетащите объект в ячейку таблицы.

NOTE

Нельзя перетаскивать объект, если он заблокирован на месте (см.
LockingObjects.htm).

Объект появится в ячейке таблицы.

NOTE

Если вы добавляете текстовый объект в таблицу, размер ячейки изменяется в
соответствии с размерами текстового объекта. Если вы добавляете в таблицу
объекты других типов, размеры объекта изменяются в соответствии с размерами
ячейки.

Удаление объекта из таблицы

1. Выберите объект.

2. Перетащите объект за пределы таблицы.

Выделение таблиц, столбцов, строк и ячеек
Вы можете выделить таблицу, столбец, строку, ячейку или группу ячеек. После того, как вы
выделите таблицу или часть таблицы, вы сможете:

l Переместить таблицу

l Изменить свойства таблицы или ее ячеек

l Изменить размеры таблиц, столбцов и строк

l Добавить или удалить столбцы, строки или ячейки

l Разбить или объединить ячейки

l Удалить таблицу
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Выделение таблицы:

1. Нажмите Select («Выбор») .

2. Нажмите за пределами ячейки, но вблизи ее угла, и тащите рамку в сторону
противоположного угла.

NOTE

Не начинайте перетаскивать границу из области таблицы. В этом случае будет
выделена ячейка таблицы, а не сама таблица.

Выделение столбца:

1. Нажмите Select («Выбор») .

2. Нажмите внутри верхней ячейки столбца и тащите рамку к нижней ячейке.

Выделение строки:

1. Нажмите Select («Выбор») .

2. Нажмите внутри самой левой ячейки строки и тащите рамку к правой ячейке.

Выделение ячейки:

1. Нажмите Select («Выбор») .

2. Нажмите внутри ячейки.

Выделение нескольких ячеек:

1. Нажмите Select («Выбор») .

2. Нажмите внутри верхней левой ячейки столбца и тащите рамку к нижней правой ячейке.

NOTE

Если выделить несколько ячеек и перетащить их в другое место страницы, будет
создана новая таблица, состоящая из выбранных ячеек и их содержимого.
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Перемещение таблиц
После создания таблицы ее можно перемещать по странице.

Перемещение таблицы:

Выделите таблицу и перетащите ее в другое место на странице.

ИЛИ

Выделите все ячейки таблицы и перетащите ячейки в другое место на странице.

Изменение свойств таблицы
Вы можете использовать вкладку «Свойства» для изменения свойств таблицы, включая
прозрачность, цвет ячеек и цвет линий.

Изменение заливки таблицы:

1. Выделите таблицу, столбец, строку, ячейку или диапазон ячеек.

2. Нажмите стрелку меню таблицы, столбца, строки или ячейки и выберите Properties
(«Свойства»).
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3. Нажмите кнопку «Эффекты заливки».
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4. Выберите тип заливки

Тип заливки Порядок действий

Без заливки
(прозрачный)

Выберите No fill («Без заливки»).

Сплошная заливка a. Выберите Solid fill («Сплошная заливка»).

b. Выберите один из следующих вариантов:
o Выберите один из 40 цветов палитры.

o НажмитеMore («Еще»)и выберите требуемый цвет в
диалоговом окне.

o Нажмите пипетку и выберите цвет на экране.

Градиент из двух
цветов

a. ВыберитеGradient fill («Градиентная заливка»).

b. Для каждого цвета выполните одно из следующих действий:
o Выберите один из 40 цветов палитры.

o НажмитеMore («Еще»)и выберите требуемый цвет в
диалоговом окне.

o Нажмите пипетку и выберите цвет на экране.

c. Выберите нужный вариант из выпадающего списка Style
(«Тип»).

Заливка узором a. Выберите Pattern fill («Заливка по шаблону»).

b. Выберите узор.
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Тип заливки Порядок действий

Рисунок a. Выберите Image fill («Заливка изображением»).

b. Нажмите «Обзор».

c. Найдите и выделите изображение, которое вы хотите
использовать в качествефона, и нажмитеOpen
(«Открыть»).

NOTE

При вставке большого изображения может открыться
диалоговое окно с предложением уменьшить размер
файла изображения либо оставить его без изменений.
Дополнительную информацию см. в разделе Настройка
параметров оптимизации изображения на странице 229.

d. Выберите Keep image size («Сохранить размер
изображения») , чтобы сохранить размер изображения,
независимо от того, больше изображение, чем объект, или
меньше.
ИЛИ
Выберите Scale image to fit («Масштабировать
изображение по размеру») , чтобы изменить размер
изображения до размера объекта.

5. Можно также перетащить ползунок Object transparency («Прозрачность объекта»)
вправо, чтобы сделать таблицу прозрачной.

Изменение типа линий таблицы:

1. Выделите таблицу.

NOTE

Можно изменить тип линии только всей таблицы, но не отдельных ячеек, столбцов или
строк.

2. Нажмите стрелку меню таблицы, столбца, строки или ячейки и выберите Properties
(«Свойства»).

3. Выберите «Тип линии».

4. Измените тип линий таблицы.
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Изменение стиля текста таблицы:

1. Выделите таблицу, столбец, строку, ячейку или набор ячеек.

2. Нажмите стрелку меню таблицы, столбца, строки или ячейки и выберите Properties
(«Свойства»).

3. Нажмите Text Style («Стиль текста»).

4. Измените стиль текста таблицы (см. Форматирование текста на странице 43).

Изменение размеров таблиц, столбцов или строк
Если вам нужно настроить таблицу, вы можете изменить размер таблицы, столбцов или
строк.

Изменение размера таблицы:

1. Выберите таблицу.

2. Нажмите ручку изменения размера (серый кружок) таблицы, и тащите ее, чтобы
увеличить или уменьшить размер таблицы.

Изменение размера столбца:

1. Нажмите Select («Выбор») .

2. Нажмите на вертикальную границу справа от столбца.

Появится указатель размеров.

3. Перетащите вертикальную границу для изменения размера столбца.

Изменение размера строки:

1. Нажмите Select («Выбор») .

2. Нажмите на горизонтальную границу под строкой.

Появится указатель размеров.

3. Перетащите горизонтальную границу для изменения размера строки.

Изменение размера всех ячеек таблицы:

1. Выберите таблицу.

2. Нажмите стрелку меню таблицы и выберите Adjust size («Настроить размер»).
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3. Выберите один из следующих вариантов:

o Make same height («Использовать одну высоту») , чтобы сделать все ячейки
таблицы одной высоты.

o Make same width («Использовать одну ширину») , чтобы сделать все ячейки
таблицы однойширины.

o Make same size («Использовать один размер») , чтобы сделать все ячейки
таблицы одного размера.

o Make cells square («Сделать ячейки квадратными») , чтобы сделать ячейки
квадратными.

Добавление и удаление столбцов, строк и ячеек
Для настройки таблицы в нее можно добавить столбцы или строки.

Добавление столбца:

1. Выделите столбец.

2. Нажмите стрелку меню столбца и выберите Insert Column («Вставить столбец»).

Новый столбец появится справа от текущего.

Удаление столбца:

1. Выделите столбец.

2. Нажмите стрелку меню столбца и выберите Delete Column («Удалить столбец»).

Добавление строки:

1. Выделите строку.

2. Нажмите стрелку меню строки и выберите Insert Row («Вставить строку»).

Под текущей строкой появится новая строка.

Удаление строки:

1. Выделите строку.

2. Нажмите стрелку меню строки и выберите Delete Row («Удалить строку»).
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Удаление ячейки:

1. Выделите ячейку.

2. Нажмите на стрелку меню ячейки и выберите Delete Cells («Удалить ячейки»).

NOTE

o При удалении ячейки удаляется также ее содержимое.

o Нельзя удалить ячейку, если она является единственной ячейкой, соединяющей
две половины таблицы.

Разделение и объединение ячеек таблиц
Вы можете добавлять таблицы на страницу и вставлять объекты в ячейки таблицы. Чтобы
настроить таблицу, можно разделить или объединить определенные ячейки.

Разделение ячейки:

1. Выделите ячейку.

2. Нажмите на стрелку меню таблицы и выберите Split («Разделить»).

3. Выберите вариант разделения на несколько столбцов и (или) строк.

NOTE

Если вы разделяете ячейку, содержащую данные, это содержимое будет находиться
после разделения в верхней левой ячейке.

Объединение ячеек:

1. Выделите ячейки.

2. Нажмите на стрелку меню таблицы и выберитеMerge Cells («Объединить ячейки»).

NOTE

Если вы объединяете ячейки, содержащие данные, ячейка после объединения будет
содержать данные, содержащиеся в верхней левой ячейке. Если верхняя левая ячейка
пуста, содержимое объединенных ячеек, в ячейке после объединения будет
находиться содержимое следующей ячейки по направлению слева направо, сверху
вниз.
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Удаление таблиц и их содержимого
Можно удалить таблицу или ее содержимое.

NOTE

Вы можете удалить все объекты со страницы, включая таблицы, очистив страницу (см.
Очистка страниц на странице 216).

Удаление содержимого таблицы

1. Выделите ячейки с содержимым, которое требуется удалить.

2. Нажмите кнопку Delete («Удалить») .

Удаление таблицы

1. Выберите таблицу.

2. Нажмите на стрелку меню таблицы и выберите Delete («Удалить»).

Управление заданием «Кричи!»
Можно управлять сессией задания «Кричи!» следующим образом: перемещать загруженные
учащимися тексты и изображения по рабочему столу Notebook, приостанавливать загрузку
материалов и отключать отображение имени учащегося, загрузившего материалы. Кроме
того, задание можно сохранить и использовать позднее.

Перемещение текстов или изображений, добавленных учащимися:

1. Наведите стрелку курсора на объект на рабочем столе занятия в конструкторе учебных
занятий.

2. Нажмите левой кнопкой мыши на объект и перетащите его в другое место на странице.

Чтобы приостановить добавление материалов учащимися на рабочий стол Notebook
необходимо выполнить следующие действия:

1. Нажмите на синюю кнопку Pause Contributions («Приостановить добавление
материалов») в диалоговом окне LAB Student Contribution Activity («Загрузка
материалов учащимися в LAB»).

Кнопка станет зеленой и на ней появится надпись Resume («Продолжить»).
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Учащиеся увидят на своих компьютерах или устройствах сообщение Activity Paused
(«Занятие приостановлено»).

2. Снова нажмите на нее, чтобы продолжить выполнение задания.

Кнопка станет синей и на ней появится надпись Pause Contributions («Приостановить
добавление материалов»).

Сообщение Activity Paused («Занятие приостановлено») исчезнет, и можно продолжить
загрузку материалов.

Отображения/сокрытие имени учащегося, добавившего материал:

1. Нажмите на ползунок Off On («Выкл./Вкл.») около надписи Display Contributor Names
(«Отображать имена пользователей, выполнивших загрузку»).

2. [Введите второйшаг процедуры здесь.]

Завершение, сохранение и перезапуск задания «Кричи!»:

1. Нажмите End and Save («Завершить и сохранить») в диалоговом окне LAB Student
Contribution Activity («Загрузка материалов учащимися в LAB»).

Появится диалоговое окно Contribution for this activity has ended («Загрузка материалов
для этого занятия завершена») .

2. Нажмите Restart Activity («Возобновить занятие») , чтобы продолжить работу с тем же
занятием.

NOTE

Одновременно можно запускать только одно задание.
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После создания объекта можно его выделить и работать с ним, как описано в данном
разделе.

NOTE

Задачи, описанные в данном разделе, применимы ко всем объектам, а не только к
основным объектам.

Выделение объектов
Для того чтобы работать с объектами, их необходимо сначала выделить. Можно выделить
отдельный объект, несколько объектов или все объекты на странице. При выделении вокруг
объекта появляется прямоугольная рамка.

Серый кружок в нижнем правом углу объекта — это ручка изменения размера (см. Изменение
размеров объектов на странице 80).

Зеленый кружок над объектом — это ручка поворота (см. Поворот объектов на странице 82).

Направленная вниз стрелка в верхнем правом углу объекта — это стрелка меню. Нажмите
стрелку меню, и меню команд появится на экране.

NOTE

При нажатии на стрелку меню объекта выводится тот же список команд, что и прищелчке
по объекту правой кнопкой мыши.
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Выделение объекта

1. Нажмите Select («Выбор») .

2. Нажмите объект, который необходимо выделить.

Вокруг объекта появится рамка выделения.

NOTE

Если при нажатии на объект вместо стрелки меню появится значок блокировки, объект
заблокирован. В зависимости от типа блокировки может потребоваться
разблокировать объект, прежде чем управлять объектом (см. раздел
LockingObjects.htm).

Выделение нескольких объектов

1. Нажмите Select («Выбор») .

2. Коснитесь интерактивного экрана и тащите рамку, пока она не охватит объекты, которые
вам нужно выделить.

ИЛИ

Удерживая клавишу CTRL, нажимайте на объекты, которые вы хотите выделить.

Вокруг выделенных объектов появится рамка выделения.

NOTE

Если нарисовать рамку вокруг нескольких объектов, некоторые из которых
заблокированы (см. LockingObjects.htm), будут выделены только незаблокированные
объекты.

Выделение всех объектов на странице:

Выберите Edit > Select All («Правка» > «Выделить все»).

Вокруг всех объектов страницы появится рамка выделения.

NOTE

Если некоторые из объектов заблокированы (см. раздел LockingObjects.htm),
выделятся только незаблокированные объекты.

Выделение всех объектов на странице:

Выберите Edit > Select All Locked Notes («Правка» > «Выделить все
заблокированные заметки»).
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Вокруг всех заблокированных объектов страницы появится рамка выделения.

Изменение свойств объектов
Вы можете изменять свойства объектов. Свойства, которыеможно изменять, зависят от
выбранного объекта. Вы можете также выделить несколько объектов и изменять их свойства
одновременно.

Изменение заливки
Заливку объекта можно изменить, выбрав нужный объект, а затем выбрав заливку на

вкладке Properties («Свойства»), либо нажав Fill («Заливка») , выбрав заливку, а затем

выделив необходимый объект.

Для изменения заливки объекта после его выделения:

1. Выберите объект.

2. Если вкладка Properties («Свойства») не отображается, нажмите Properties

(«Свойства») .
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3. Нажмите кнопку «Эффекты заливки».
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4. Выберите тип заливки

Тип заливки Порядок действий

Без заливки
(прозрачный)

Выберите No fill («Без заливки»).

Сплошная заливка a. Выберите Solid fill («Сплошная заливка»).

b. Выберите один из следующих вариантов:
o Выберите один из 40 цветов палитры.

o НажмитеMore («Еще»)и выберите требуемый цвет в
диалоговом окне.

o Нажмите пипетку и выберите цвет на экране.

Градиент из двух
цветов

a. ВыберитеGradient fill («Градиентная заливка»).

b. Для каждого цвета выполните одно из следующих действий:
o Выберите один из 40 цветов палитры.

o НажмитеMore («Еще»)и выберите требуемый цвет в
диалоговом окне.

o Нажмите пипетку и выберите цвет на экране.

c. Выберите нужный вариант из выпадающего списка Style
(«Тип»).

Заливка узором a. Выберите Pattern fill («Заливка по шаблону»).

b. Выберите узор.
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Тип заливки Порядок действий

Рисунок a. Выберите Image fill («Заливка изображением»).

b. Нажмите «Обзор».

c. Найдите и выделите изображение, которое вы хотите
использовать в качествефона, и нажмитеOpen
(«Открыть»).

NOTE

При вставке большого изображения может открыться
диалоговое окно с предложением уменьшить размер
файла изображения либо оставить его без изменений.
Дополнительную информацию см. в разделе Настройка
параметров оптимизации изображения на странице 229.

d. Выберите Keep image size («Сохранить размер
изображения») , чтобы сохранить размер изображения,
независимо от того, больше изображение, чем объект, или
меньше.
ИЛИ
Выберите Scale image to fit («Масштабировать
изображение по размеру») , чтобы изменить размер
изображения до размера объекта.

5. Можно также перетащить ползунок Object transparency («Прозрачность объекта»)
вправо, чтобы сделать объект прозрачным.

TIP

Для изменения свойств объекта можно также использовать переключатели свойств на
панели инструментов.

Для изменения заливки объекта после нажатия кнопки Fill («Заливка»):

1. Нажмите Fill («Заливка») , затем выберите цвет.

2. Выберите объект.

3. Повторитешаг 2 для каждого объекта, к которому нужно применить данную заливку.

Заливка рисунков, выполненных цифровыми чернилами
Помимо заливкифигур, правильных и неправильных многоугольников, с помощью кнопки Fill
(«Заливка») можно заливать области, ограниченные цифровыми чернилами.
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NOTES

l Для заливки произвольной области необходимо очертить эту область замкнутым
контуром, нарисованным цифровыми чернилами.

l Замкнутая область, являющаяся частью группы, не подлежит заливке (см.
Группировка объектов на странице 84).

l Заливка замкнутой области приводит к созданию отдельного объекта, которыйможно
перемещать отдельно от исходной замкнутой области. Можно залить замкнутую
область, а затем многократно перемещать получившийся в результате заливки
объект.

Изменение других свойств
Кроме изменения заливки можно также изменять тип линий и стиль текста объектов.

Изменение типа линий объекта:

1. Выберите объект.

2. Если вкладка Properties («Свойства») не отображается, нажмите Properties

(«Свойства») .
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3. Выберите «Тип линии».

4. Измените тип линий объекта.

Изменение стиля текста объекта:

1. Выберите объект.

2. Если вкладка Properties («Свойства») не отображается, нажмите Properties

(«Свойства») .

3. Нажмите Text Style («Стиль текста»).

4. Измените стиль текста объекта (см. Форматирование текста на странице 43).

Сохранение свойств инструмента
После выбора инструмента на панели инструментов вы можете изменить настройки по
умолчанию для этого инструмента с помощью вкладки Properties («Свойства»), а затем
сохранить их, нажав Save Tool Properties («Сохранить свойства инструмента»).

После изменения настроек инструмента по умолчанию кнопка этого инструмента изменяется
следующим образом:

Процедуру восстановления настроек по умолчанию см. в разделе Настройка панели
инструментов на странице 225.

Расположение объектов
Положение объектов можно менять, перемещая их в другую область текущей страницы или
на другую страницу. Вы такжеможете выравнивать объекты или изменять порядок объектов
в стеке.

Перемещение объектов
Вы можете перемещать объекты в другое место страницы. Можно также быстро перемещать
объекты.

NOTE

Нельзя перетаскивать объект, если он заблокирован на месте (см. LockingObjects.htm).



CHAPTER 5
РАБОТА С ОБЪЕКТАМИ

72

TIP

Вы можете управлять несколькими объектами, выделив их и создав группу (см.
Группировка объектов на странице 84).

Перемещение объекта или объектов:

1. Выделите объект или объекты.

2. Перетащите один или несколько объектов в другое место на странице.

TIP

Вы можете перемещать объект небольшимишагами, нажимая клавиши со стрелками
на клавиатуре.

Перемещение файла, совместимого с плеером Adobe Flash®:

1. Нажмите на цветную полосу в верхней частифайла, совместимого с плеером Adobe
Flash.

2. Перетащитефайл в другое место.

Перемещение объекта

1. Выберите объект.

2. Совершите быстрое движение пальцем в любом направлении.
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Перемещение объектов на другую страницу
Вы можете перемещать объекты на другую страницу файла.

Перемещение объекта или объектов на другую страницу:

1. Если «Сортировщик страниц» не отображается, нажмите «Сортировщик страниц» .

2. Если вы не видите страницу, на которую требуется переместить объект, прокрутите окно
сортировщика страниц до нужного эскиза страницы.

3. Выделите объект или объекты, который(-е) вы хотите переместить.

4. Перетащите один или несколько объектов в сортировщик страниц на эскиз страницы, на
которую требуется переместить объекты.

Перемещение файлов, совместимых с плеером Adobe Flash, на другую страницу:

1. Если «Сортировщик страниц» не отображается, нажмите «Сортировщик страниц» .

2. Если вы не видите страницу, на которую требуется переместить объект, прокрутите окно
сортировщика страниц до нужного эскиза страницы.

3. Нажмите на цветную полосу в верхней частифайла, совместимого с плеером Adobe
Flash.

4. Перетащитефайл в сортировщик страниц на эскиз страницы, на которую требуется
переместить объект.

Выравнивание объектов
Надстройка инструмента выравнивания позволяет выровнять и распределить объекты на
странице. Выбранные объекты можно выровнять по нижней части, слева, справа, по верхней
части, по горизонтали или по вертикали. Также можно выровнять объекты в стеке по
горизонтали или по вертикали.

При желании вы можете вывести на странице направляющие, помогающие выравнивать
вручную объекты по другим объектам, а также по вертикальной и горизонтальной оси
страницы. Также вы можете задать автоматическое выравнивание объектов по
направляющим при перемещении объектов по странице (см. page 71).

Выравнивание объектов на странице:

1. Выберите объект, который хоте выровнять (см. Выделение объектов на странице 64).

2. Нажмите кнопку Add-ons («Надстройки») , расположенную на панели инструментов,
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чтобы отобразить кнопки инструмента выравнивания.

3. Нажмите на кнопку выравнивания:

Кнопка Имя Нажмите на эту кнопку, чтобы:

Выравнивание
по нижней
границе

Выровнять выбранные объекты по их нижней границе.

Выравнивание
по левой
границе

Выровнять выбранные объекты по их нижней границе.

Выравнивание
по центру на
оси X

Выровнять выбранные объекты вертикально по их
центральным линиям.

Выравнивание
по центру на
оси Y

Выровнять выбранные объекты горизонтально по их
центральным линиям.

Выравнивание
по правой
границе

Выровнять выбранные объекты по их правой границе.

Выравнивание
по верхней
границе

Выровнять выбранные объекты по их верхней границе.

Стек по
горизонтали

Выровнять выбранные объекты в стеке по горизонтали.

Стек по
вертикали

Выровнять выбранные объекты в стеке по вертикали.

Отображение направляющих:

1. Выберите View > Alignment («Вид» > «Выравнивание»).

Появится диалоговое окноAlignment («Выравнивание»).
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2. Установитефлажки направляющих, которые вы хотите вывести на страницу:

Флажок Установите этот флажок, чтобы

Show guides for
active objects
(«Показать
направляющие для
активных
объектов»)

Выводить направляющую при выравнивании объекта
относительно другого объекта.

Show vertical page
center guide
(«Показать
центральную
направляющую по
вертикали»)

Выводить направляющую при выравнивании объекта по
вертикальной оси страницы.

Show horizontal
page center guide
(«Показать
центральную
направляющую по
горизонтали»)

Выводить направляющую при выравнивании объекта по
горизонтальной оси страницы.

Snap objects to
guides («Привязать
объекты к
направляющим»)

При перемещении объектов по странице автоматически
выравнивать объекты по направляющим.

3. Если вы хотите изменить цвет направляющих, нажмите на цветную полоску слева от
надписиGuide color («Цвет направляющей») и выберите цвет.

4. НажмитеOK.

Изменение порядка объектов в стеке
Если объекты на странице перекрываются, вы можете изменить их порядок в стеке (то есть,
вы можете управлять тем, какой объект будет отображаться перед другими).

NOTE

Нельзя перетаскивать объект в стеке, если он заблокирован на месте (см.
LockingObjects.htm).
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Перемещение выделенного объекта на передний план стека:

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберитеOrder > Bring to Front («Порядок» > «На
передний план»).

Перемещение выделенного объекта на задний план стека:

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберитеOrder > Send to Back («Порядок» > «На
задний план»).

Перемещение в стеке выделенного объекта на одну позицию вперед:

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберитеOrder > Bring Forward («Порядок» >
«Переместить вперед»).

Перемещение в стеке выделенного объекта на одну позицию назад:

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберитеOrder > Send Backward («Порядок» >
«Переместить назад»).

Вырезание, копирование и вставка объектов
Можно вырезать, копировать и вставлять объекты, включая текст, изображения, прямые
линии, дуги ифигуры в файле *.notebook.

TIPS

l Можно вставлять текст из других программ в ПОSMART Notebook и вырезать текст из
ПОSMART Notebook и вставлять его в другие программы (см. Вырезание, копирование
и вставка материалов из других программ на странице 99 и Вырезание и вставка
текста на странице 48).

l Можно создать точную копию объекта при помощифункции клонирования (см.
Клонирование объектов на странице 79).
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Вырезание и вставка объекта

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите Cut («Вырезать»).

TIP

Дополнительно вы можете нажать Cut («Вырезать») , если вы добавили эту кнопку

на панель инструментов (см. Настройка панели инструментов на странице 225).

3. Если объект необходимо вставить на другую страницу, выведите эту страницу на экран.

4. Нажмите кнопку Paste («Вставить») .

Копирование и вставка объекта

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите пункт Copy («Копировать»).

TIP

Дополнительно вы можете нажать Copy («Копировать») , если вы добавили эту

кнопку на панель инструментов (см. Настройка панели инструментов на странице 225).

3. Если вы хотите вставить элемент на другую страницу, выведите эту страницу на экран.

4. Нажмите кнопку Paste («Вставить») .

Обрезка изображений с маской
Для обрезки изображений можно использовать маску. Маска скрывает «вырезаемый»
участок изображения, а не удаляет его. Это позволяет вам редактировать маску при
необходимости обрезки другой части изображения. Вы такжеможете снять маску для
возврата исходного изображения.

NOTE

Вы можете обрезать только растровые изображения. Например, вы можете обрезать
растровые картинки, вставленные из Галереи или с вашего компьютера. Вы не можете
обрезать объекты других типов.
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Для обрезки изображения с маской:

1. Выберите изображение.

2. Нажмите стрелку меню изображения и выберитеMask («Маска»).

На изображении появится маска для обрезки. Обрезанные секции изображения
окрашиваются в серый цвет.

3. Перетаскивайте изображение до тех пор, пока секция изображения, которую вы хотите
сохранить, не появится в маске обрезки.

4. Также вы можете нажать на одно из средств изменения размера маски для обрезки
(белые кружки), затем перетащите его для увеличения или уменьшения размера маски
обрезки.

5. Для обрезки нажмите на любую область за пределами изображения.

Для редактирования маски:

1. Выберите изображение.

2. Нажмите на стрелку меню изображения и выберите Edit Mask («Изменить маску»).

На изображении появится маска для обрезки. Обрезанные секции изображения
окрашиваются в серый цвет.

3. Перетаскивайте изображение до тех пор, пока секция изображения, которую вы хотите
сохранить, не появится в маске обрезки.

4. Также вы можете нажать на одно из средств изменения размера маски для обрезки
(белые кружки), затем перетащите его для увеличения или уменьшения размера маски
обрезки.

5. Для обрезки нажмите на любую область за пределами изображения.
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Для восстановления изображения:

1. Выберите изображение.

2. Нажмите стрелку меню изображения и выберите Unmask («Удалить маску»).

Будет восстановлено исходное изображение.

Клонирование объектов
Вы можете создать дубликат объекта с помощью команды «Клонировать» или создать
несколько копий объекта с помощью команды «Бесконечное клонирование».

NOTE

Вы такжеможете копировать и вставлять объекты, включая текст, изображения, прямые
линии, изогнутые линии иформы (см. Вырезание, копирование и вставка объектов на
странице 76).

Клонирование объекта:

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите Clone («Клонировать»).

На странице появится дубликат объекта.

Клонирование объекта с помощью инструмента Infinite Cloner («Бесконечное
клонирование»):

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите пункт Infinite Cloner («Бесконечное
клонирование»).

3. Выделите объект снова.

Символ бесконечности появится на экране вместо стрелки меню объекта.

4. Перетащите объект в другое место на странице.

5. Повторитешаг 4 нужное количество раз.

6. После завершения клонирования объекта выделите исходный объект.

7. Нажмите на символ бесконечности и отключите Infinite Cloner («Бесконечное
клонирование»).
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Изменение размеров объектов
Размер объектов на странице можно менять с помощью ручки изменения размера или жеста
масштабирования (если ваш интерактивный продукт поддерживает режим нескольких
касаний).

NOTE

Нельзя изменить размеры объекта, если он заблокирован на месте (см.
LockingObjects.htm).

Использование ручки изменения размера

Изменение размеров объекта:

1. Выберите объект.

2. Нажмите ручку изменения размера (серый кружок) и потяните за нее, чтобы увеличить
или уменьшить размер объекта.

NOTE

Чтобы сохранять исходное соотношение высоты к ширине, перетащите кружок при
нажатой клавише SHIFT.

Изменение размеров нескольких объектов:

1. Сгруппируйте объекты (см. раздел Группировка объектов на странице 84), а затем
выделите группу.

Вокруг группы появится рамка выделения.

2. Нажмите ручку изменения размера в нижнем правом углу рамки выделения.

3. Тащите этот кружок для увеличения или уменьшения размера объектов.

Использование жеста масштабирования

Изменение размера объекта от центра:

1. Выберите объект.

2. С помощью указательных пальцев нажмите на противоположные стороны объекта.
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3. Двигайте пальцы в противоположных направлениях, чтобы увеличить размер объекта.

ИЛИ

Двигайте пальцы по направлению друг к другу для уменьшения размера объекта.

Изменение размера объекта от угла или стороны:

1. Выберите объект.

2. С помощью указательных пальцев нажмите на угол или сторону, откуда вы хотите
изменить размер объекта.

3. Двигайте пальцы в противоположных направлениях, чтобы увеличить размер объекта.

ИЛИ

Двигайте пальцы по направлению друг к другу для уменьшения размера объекта.

Изменение размеров нескольких объектов:

1. Выделите объекты.

2. С помощью указательных пальцев нажмите на противоположные стороны одного из
объектов.
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3. Двигайте пальцы в противоположных направлениях, чтобы увеличить размер объектов.

ИЛИ

Двигайте пальцы по направлению друг к другу для уменьшения размера объектов.

NOTE

Размер объектов изменяется от их центров вне зависимости от того, где вы нажимаете
на экран.

Поворот объектов
Объекты на странице можно поворачивать с помощью ручки поворота или жеста поворота
(если ваш интерактивный продукт поддерживает режим нескольких касаний).

NOTES

l Нельзя повернуть объект, если он заблокирован на месте (см. LockingObjects.htm).

l Нельзя поворачивать таблицы.

Использование ручки поворота

Поворот объекта:

1. Выберите объект.

2. Нажмите ручку поворота (зеленый кружок) объекта, и тащите ее в нужном направлении,
чтобы повернуть объект.

Поворот нескольких объектов:

1. Выделите объекты.

Вокруг каждого объекта появится рамка выделения.

2. Нажмите ручку поворота (зеленый кружок) на любом из выбранных объектов, и тащите
ее в нужном направлении, чтобы повернуть объект. При повороте одного объекта все
прочие выделенные объекты будут поворачиваться автоматически.



CHAPTER 5
РАБОТА С ОБЪЕКТАМИ

83

Использование жеста поворота

Поворот объекта от центра:

1. Выберите объект.

2. С помощью указательных пальцев нажмите на противоположные стороны объекта.

3. Двигайте пальцы по кругу вокруг центра объекта, чтобы повернуть его.

Поворот объекта вокруг угла:

1. Выберите объект.

2. С помощью указательных пальцев нажмите на угол, вокруг которого вы хотите
повернуть объект.

3. Двигайте пальцы по кругу вокруг угла объекта, чтобы повернуть его.

Поворот нескольких объектов:

1. Выделите объекты.

2. С помощью указательных пальцев нажмите на противоположные стороны одного из
объектов.

3. Двигайте пальцы по кругу.

NOTE

Объекты поворачиваются вокруг своих центров вне зависимости от того, где вы
нажимаете на экран.
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Отражение объектов
Вы можете зеркально отобразить объект на странице.

NOTE

Нельзя отразить объект, если он заблокирован на месте (см. LockingObjects.htm).

Зеркальное отражение объекта

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите Flip > Up/Down («Повернуть» >
«Вверх/Вниз») или Flip > Left/Right («Зеркально отразить» > «Влево/Вправо»).

Зеркальное отражение нескольких объектов

1. Выделите объекты.

2. Нажмите на стрелку меню и выберите пункт Flip > Up/Down («Повернуть» >
«Вверх/Вниз») или Flip > Left/Right («Зеркально отразить» > «Влево/Вправо»).

Группировка объектов
Вы можете создавать группы объектов, что дает возможность работать со всеми
сгруппированными элементами одновременно. После создания группы вы можете выделять,
перемещать, поворачивать или изменять размеры группы, как если бы это был один объект.
Однако если вы хотите работать с отдельным объектом в группе, необходимо сначала
разгруппировать объекты.

Группировка объектов вручную
Объекты можно группировать и разгруппировывать вручную с помощью меню илижеста
встряхивания.

Использование меню

Группировка объектов

1. Выделите объекты.

2. Нажмите стрелку меню любого из выбранных объектов и выберите пункт Group >
Group («Группировка» > «Группировать»).
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Разгруппирование объектов

1. Выделите группу.

2. Нажмите на стрелку меню группы и выберите пункт Group > Ungroup («Группа» >
«Разгруппировать»).

Использование жеста встряхивания

NOTES

l Нельзя выполнить жест встряхивания с помощью мыши.

l Жест встряхивания работает только при касании поверхности интерактивного продукта.

Группировка объектов

Быстро встряхните пальцем над объектами три раза.

Разгруппирование объектов

Быстро встряхните пальцем над группой три раза.
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Автоматическая группировка объектов
Если вы пишете или рисуете несколько линий, ПОSMART Notebook автоматически
объединяет линии в один объект. Например, если вы пишете буквы слова, SMART Notebook
объединяет отдельные буквы, позволяя вам работать с целым словом. Если вы хотите
писать слова на одной строке, но не хотите,чтобы они объединялись, оставляйте между ними
большой интервал, используйте разные перья или ненадолго положите перо в лоток перед
написанием другого слова (только для интерактивных досок).

Если SMART Notebook объединяет в один объект строки, с которыми вы хотели работать как
с отдельными объектами, можно разгруппировать их так, как описано выше.

Удаление объектов
Несмотря на то, что можно стирать цифровые чернила (см. Стирание цифровых чернил на
странице 36), некоторые типы объектов стирать нельзя, включая печатный текст, фигуры,
прямые линии, дуги и картинки. Чтобы убрать такие объекты со страницы, их следует
удалить.

NOTE

Нельзя удалить объект, если он заблокирован на месте (см. LockingObjects.htm). Чтобы
удалить заблокированный объект, его нужно сначала разблокировать.

Удаление объекта

1. Выберите объект.

2. Нажмите на стрелку меню таблицы и выберите Delete («Удалить»).
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Chapter 6: Вставка, упорядочивание и обмен
материалами

Вставка материалов из Галереи 88
Вставка материалов из GeoGebra 90
Вставка содержимого с веб-сайта SMART Exchange 91
Вставка материалов из других источников 92

Вставка изображений 93
Вставка изображений из файлов 93
Вставка изображений, полученных со сканера 93
Вставка изображений, полученных с камеры SMART Document Camera 94
Работа с изображениями 94
Создание прозрачных областей в изображениях 94

Вставкафайлов мультимедиа 95
Вставкафайлов, совместимых с плеером Adobe Flash 95
Вставка видеофайлов, совместимых с плеером Adobe Flash 97
Добавление звуковых файлов 98
Работа с мультимедийнымифайлами 98
Установка кодировщиков для дополнительных форматов 98

Вставка содержимого из других программ 98
Вырезание, копирование и вставка материалов из других программ 99
Импорт материалов при помощифункции захвата печати SMART Notebook Print
Capture 99
Импорт материалов при помощифункции написания документов
SMART Notebook Document Writer 101
Импорт файлов Microsoft PowerPoint 102
Импорт файлов из других программ для работы с интерактивными досками 103

Вставкаформул в математическом редакторе 104
Вставка веб-браузеров 106

Добавление веб-браузера 107
Настройка прокси-серверов 108

Вложениефайлов и веб-страниц 108
Организация и предоставление общего доступа к содержимому с помощью Галереи 110

Добавление содержимого в Галерею 110
Организация содержимого в Галерее 112
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Предоставление другим учителям доступа к содержимому 113
Подключение к категориям группового содержимого 114

Предоставление общего доступа к содержимому с помощью веб-сайта SMART Exchange 115

Вы можете выполнять вставку изображений, мультимедийных файлов и других материалов в
файлы *.notebook из различных источников. Среди этих источников могут быть галерея, веб-
сайт SMART Exchange® иматериалы из интернета.

После вставки материалов вы можете систематизировать их в галерее и предоставить к ним
общий доступ для других преподавателей с помощью галереи или веб-сайта
SMART Exchange.

Вставка материалов из Галереи
Галерея — это вкладка пользовательского интерфейса SMART Notebook, где можно
просматривать или искать материалы, которое потом можно добавить в своифайлы
*.notebook.

В состав Галереи входят примеры учебных занятий, которые в свою очередь включают
примеры конструктора занятий (см. Создание учебного задания на соответствие на
странице 133), интерактивных методик и 3D-моделей, чтобы помочь вам в создании
собственных учебных занятий.

Во время установки SMART Notebook ваш администратор может также установить
следующие элементы:

l Основные темы галереи представляют собой коллекцию из нескольких тысяч
изображений, мультимедийных объектов и т.п., организованных по тематическим
категориям.

l Инструментарий для учебных занятий представляет собой набор настраиваемых
инструментов ишаблонов, которыеможно использовать для создания интерактивных
занятий с продуманной методикой. Этот инструментарий помогает создать
занимательныематериалы, такие как игры со словами, опросы и задачи на
классификацию. Также предлагаются совместимыефайлы Adobe Flash для заданий со
скрытием, отображением и перетаскиванием.
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Галерея делится на две части. Верхняя часть галереи — это список категорий. Когда вы
выделяете категорию или подкатегорию в списке, ее содержимое отображается в нижней
части галереи.

TIP

Вы можете изменить размеры списка категорий и списка содержимого, нажав на границу
между ними и перетащив ее вверх или вниз.

Вы можете просмотреть список категорий и ознакомиться с содержимым каждой категории.
Эскизы в категориях позволяют предварительно просмотреть содержимое.

l В категории Pictures («Изображения»)изображения представлены в виде эскизов.

l В категории Interactive andMultimedia («Интерактивные средства и мультимедиа»)
видеообъекты представлены кадрами из видеороликов, звуковые объекты — значком
громкоговорителя в нижнем левом углу, афайлы, совместимые с плеером Adobe Flash,
представлены значком Adobe Flash или эскизом содержимого с маленьким значком
Adobe Flash в верхнем левом углу.

l В категории 3D Objects («Объекты 3D») модели 3D представлены в виде эскизов.

l В категории Notebook Files and Pages («Файлы и страницы Notebook») файлы
представлены изображением переплета, а страницы изображены с отогнутым верхним
правым углом.

l В категории Backgrounds and Themes («Фоны и темы»)фоновые рисунки показаны как
страницы с отогнутым нижним правым углом, а темы — в виде эскизов.

В галерее можно выполнять поиск элементов по ключевому слову.

Элемент, найденный в галерее через поиск или обзор, можно вставить в файл *.notebook.

Обзор Галереи

1. Если галерея не отображается, нажмитеGallery («Галерея» .

2. Нажмите значок плюса категории, чтобы увидеть ее подкатегории.

NOTE

Чтобы закрыть категорию, можно нажать значок минуса.

3. Выделите категорию или подкатегорию, чтобы отобразить содержимое.
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Выполнение поиска в Галерее

1. Если галерея не отображается, нажмитеGallery («Галерея» .

2. Введите ключевое слово в поле Type search terms here («Введите слова для поиска») , а

затем нажмите Search («Поиск») .

Будут выведены все материалы галереи, содержащие ключевое слово.

Добавление элемента Галереи в файл *.notebook

1. Если галерея не отображается, нажмитеGallery («Галерея» .

2. Найдите требуемый элемент галереи, воспользовавшись функцией поиска или обзора.

3. Дважды щелкните по эскизу элемента галереи.

o Если вы добавляете рисунок, файл, совместимый с плеером Adobe Flash,
видеофайл или аудиофайл, он появится на текущей странице.

o Если вы добавляетефоновый рисунок, он заменит существующийфоновый рисунок
страницы (см. Применениефонов и тем к страницам на странице 128).

o Если вы добавляете одну страницу из файла *.notebook, SMART Notebook вставит
ее перед текущей страницей.

o Если вы добавляетефайл *.notebook, SMART Notebook вставит страницы файла
перед текущей страницей.

Вставка материалов из GeoGebra
GeoGebra является интерактивным математическим ПО для любого уровня обучения. При
вставке виджетаGeoGebra в ПОSMART Notebook вы и ваши студенты сможете
воспользоваться геометрическими и алгебраическимифункциями, таблицами, графиками,
статистическимифункциями и калькулятором.

Вы такжеможете осуществить поиск рабочих листов в GeoGebraTube при помощи поиска по
ключевым словам. После того как рабочий лист будет найден, его можно добавить в ваш
файл *.notebook. GeoGebraTube (geogebratube.org) содержит тысячи рабочих листов,
созданных и опубликованных другими учителями.

NOTE

Более подробную информацию об использовании ПОGeoGebra см. в GeoGebraWiki
(wiki.geogebra.org).

http://www.geogebratube.org/
http://wiki.geogebra.org/
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Получение доступа к виджету GeoGebra

Нажмите кнопку Add-ons («Надстройки») , затем нажмитеGeoGebra.

Вставка виджета GeoGebra

1. Если виджет GeoGebra не отображается, нажмите Add-ons («Надстройки») , затем

нажмитеGeoGebra.

2. Выберите Insert GeoGebra Widget («Вставить виджет GeoGebra»).

Поиск по GeoGebraTube

1. Если виджет GeoGebra не отображается, нажмите Add-ons («Надстройки») , затем

нажмитеGeoGebra.

2. Введите ключевое слово в поле Search in FreeMaterials («Поиск по бесплатным
материалам») , а затем нажмите Search («Поиск»).

Виджет GeoGebra отобразит изображения эскизов рабочих листов, содержащих
ключевые слова.

Добавление рабочего листа GeoGebraTube в файл *.notebook

1. Если виджет GeoGebra не отображается, нажмите Add-ons («Надстройки») , затем

нажмитеGeoGebra.

2. Найдите рабочий лист GeoGebraTube, который необходимо добавить.

3. Нажмите эскиз рабочего листа, затем выберите Insert GeoGebra Widget («Вставить
виджет GeoGebra»).

На текущей странице появится рабочий лист.

TIP

Для получения более подробных сведений о рабочем листе нажмите на название
эскиза и перейдите на страницу загрузки рабочего листа в GeoGebraTube.

Вставка содержимого с веб-сайта
SMART Exchange
Веб-сайт SMART Exchange (exchange.smarttech.com) содержит тысячи учебных планов,
наборов вопросов, виджетов и прочего содержимого, которое можно загрузить на свой
компьютер, а потом открыть в SMART Notebook.

http://exchange.smarttech.com/
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NOTE

Вы такжеможете предоставить другим учителям доступ к своим учебным планам через
веб-сайт SMART Exchange. Дополнительную информацию см. в разделе Предоставление
общего доступа к содержимому с помощью веб-сайта SMART Exchange на странице 115.

Вставка содержимого с веб-сайта SMART Exchange

1. Нажмите SMART Exchange .

Веб-сайт SMART Exchange открывается в вашем веб-браузере.

2. Если вы не зарегистрированы на веб-сайте SMART Exchange, нажмите Join for free
(«Зарегистрироваться бесплатно»), затем следуйте инструкциям на экране, чтобы
создать учетную запись.

ИЛИ

Если у вас уже есть учетная запись, нажмите Sign In («Войти»), а затем следуйте
инструкциям на экране, чтобы войти в свою учетную запись на веб-сайте
SMART Exchange.

3. Найдите необходимое содержимое, воспользовавшись функцией поиска или просмотра,
а затем загрузите его на свой компьютер.

4. Импортирование содержимого в Галерею (см. Предоставление другим учителям доступа
к содержимому на странице 113).

Вставка материалов из других источников
Если вы или другие учителя вашейшколы создали материалы не в SMART Notebook, вы
можете добавлять эти материалы в файлы *.notebook. В частности, можно выполнять
следующие действия:

l добавлять изображения, файлы, совместимые с плеером Adobe Flash, видео- и
звуковыефайлы;

l Вырезать, копировать и вставлять материалы из других программ

l Импортировать материалы из других программ
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Вставка изображений
Вы можете помещать на страницы изображения из файлов, сканированные изображения или
изображения, полученные с SMART Document Camera.

NOTE

Такжеможно добавлять изображения из вкладкиGallery («Галерея»). Дополнительную
информацию см. в разделе Вставка материалов из Галереи на странице 88.

После добавления изображения вы можете определить в нем прозрачную область.

Вставка изображений из файлов
Вы можете добавить на страницу изображение.

ПОSMART Notebook поддерживает форматы BMP, GIF, JPEG, PNG, TIFF иWMF.

Вставка изображения из файла:

1. Выберите Insert > Picture («Вставка» > «Файл рисунка»).

Появится диалоговое окно Insert Picture File («Вставить файл изображения»).

2. Найдите и выделите изображение, который вы хотите добавить.

TIP

При выборе изображений удерживайте клавишу Ctrl, чтобы выбрать несколько
изображений.

3. Нажмите кнопку Open («Открыть»).

Изображение появится в верхнем левом углу страницы.

Вставка изображений, полученных со сканера
Если к вашему компьютеру подключен сканер, вы можете вставлять сканированные
изображения на страницу.

NOTE

Перед добавлением изображений со сканера в SMART Notebook вы должны установить на
компьютер драйвер и программное обеспечение сканера.
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Добавление изображения со сканера:

1. Выберите Insert > Picture From Scanner («Вставка» > «Изображение со сканера»).

Появится диалоговое окно Insert Scanned Picture («Вставка сканированного
изображения»).

2. Выберите сканер из списка.

3. Нажмите Scan («Сканировать»).

4. Следуйте инструкциям по работе со сканером для сканирования изображения.

Вставка изображений, полученных с камеры SMART Document Camera
Вы можете вставлять изображения, полученные с камеры SMART Document Camera на
страницу.

Вставка изображения, полученного с камеры SMART Document Camera:

1. Выберите пункт Insert > Picture From SMART Document Camera («Вставить» >
«Изображение из SMART Document Camera»).

На странице появится окно «SMART Document Camera».

2. Вставьте изображение в соответствии с инструкциями в Справке.

Работа с изображениями
Когда вы вставляете изображение в файл *.notebook, оно становится объектом. Поэтому
изображения можно перемещать, изменять их размер, вращать и вносить в них другие
изменения точно так же, как и в любые другие объекты.

Информацию о том, как работать с объектами, включая рисунки и изображения, в файлах
*.notebook, см. в разделе Chapter 5: Работа с объектами на странице 63.

Создание прозрачных областей в изображениях
В добавляемых на страницу изображениях можно создавать прозрачные области. Эта
функция полезна для удаления фона изображения. Любой цвет изображения можно сделать
прозрачным.

NOTE

Размер вставляемого в файл изображения можно уменьшить (см. Настройка параметров
оптимизации изображения на странице 229). Но если потом в таком изображении создать
прозрачную область, то изображение больше не будет оптимизированным.
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Создание прозрачной области в изображении

1. Выберите изображение.

2. Нажмите на стрелку меню изображения и выберите «Задать прозрачность
изображения».

Появится диалоговое окно Picture Transparency («Прозрачность изображения»).

3. Потяните за угол диалогового окна в соответствующем направлении, чтобы изменить его
размер.

4. Нажмите на любую область изображения, которую вы хотите сделать прозрачной.

NOTE

Нажатие на область делает прозрачной только эту область, даже если изображение
содержит такой же цвет в других областях.

5. НажмитеOK.

Вставкафайлов мультимедиа
На страницы можно добавлять мультимедийныефайлы, включая файлы, совместимые с
Adobe Flash Player, видео- и звуковыефайлы.

NOTE

Такжеможно добавлять мультимедийныефайлы из вкладкиGallery («Галерея»).
Дополнительную информацию см. в разделе Вставка материалов из Галереи на
странице 88.

Вставка файлов, совместимых с плеером Adobe Flash
Вы можете добавить на страницу файлы, совместимые с плеером Adobe Flash.

После добавления на страницу файла, совместимого с Adobe Flash, а также после вывода на
экран страницы, содержащейфайл, совместимый с Adobe Flash, автоматически начинается
воспроизведение этогофайла. Однако этим процессом можно управлять. Еслифайл
содержит кнопки, можно нажимать их на интерактивном продукте. Если жефайл не снабжен
кнопками, можно использовать пункты, появляющиеся при нажатии на стрелку меню этого
файла.

NOTES

l Файлы, совместимые с плеером Adobe Flash, размещаемые на странице, должны
быть самораспаковывающимися. Нельзя использовать файлы, совместимые с Adobe
Flash, загружающие или использующие другиефайлы, совместимые с плеером Adobe
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Flash.

l Нельзя перетаскивать файл, совместимый с плеером Adobe Flash из веб-браузера на
страницу.

l Если на компьютере не установлен плеер Adobe Flash, SMART Notebook предупредит
об этом при попытке поместить на страницу файл, совместимый с плеером Adobe
Flash.

l Вы можете установить плеер Adobe Flash, посетив сайт adobe.com, но для установки
необходимо использовать браузер Internet Explorer®. Если вы используете другой
браузер, файлы, совместимые с плеером Adobe Flash, не будут работать в
SMART Notebook.

l Чтобы писать поверх файла, совместимого с плеером Adobe Flash, с помощью
компонента распознавания рукописного текста, начните писать за пределамифайла и
продолжайте поверх него. Это позволит программному обеспечению SMART Notebook
распознать цифровые чернила как объект, отдельный от файла, совместимого с
плеером Adobe Flash.

Добавление файлов, совместимых с плеером Adobe Flash

1. Выберите Insert > Adobe Flash Player Compatible File («Вставка» > «Файлы,
совместимые с Adobe Flash Player»).

Появится диалоговое окноInsert Flash File («Вставить файл Flash»).

2. Найдите и выделитефайл, совместимый с плеером Adobe Flash, который вы хотите
добавить на страницу.

3. Нажмите кнопку Open («Открыть»).

Файл, совместимый с плеером Adobe Flash, появится в левом верхнем углу страницы.

http://www.adobe.com/
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Управление файлом, совместимым с плеером Adobe Flash

1. Выберитефайл, совместимый с плеером Adobe Flash.

2. Управляйтефайлом, выполняя любое из следующих действий:

o Чтобы запустить воспроизведениефайла, нажмите на стрелку меню файла и
выберите Flash > Play (Flash > «Воспроизведение»).

o Чтобы запустить воспроизведениефайла с начала, нажмите на стрелку меню
файла и выберите Flash > Rewind (Flash > «Назад»).

o Чтобы прокрутить воспроизведениефайла немного вперед и сделать паузу,
нажмите на стрелку меню файла и выберите Flash > Step Forward (Flash > «Шаг
вперед»).

o Чтобы прокрутить воспроизведениефайла немного назад и сделать паузу, нажмите
на стрелку меню файла и выберите Flash > Step Back (Flash > «Шаг назад»).

o Для непрерывного воспроизведения файла нажмите на стрелку меню файла и
выберите Flash > Loop (Flash > «Цикл»).

o Для отмены непрерывного воспроизведения файла нажмите на стрелку меню файла
и снимитефлажок Flash > Loop (Flash > «Цикл»).

Вставка видеофайлов, совместимых с плеером Adobe Flash
Вы можете добавить на страницу видеофайлы, совместимые с плеером Adobe Flash.

NOTE

ПОSMART Notebook поддерживает формат видеофайлов (FLV), совместимый с плеером
Adobe Flash. Если вы хотите, чтобы программное обеспечение SMART Notebook
поддерживало другие типы файлов, вы можете установить дополнительные кодировщики
(см. Установка кодировщиков для дополнительных форматов на следующей странице).

Добавление файлов, совместимых с плеером Adobe Flash

1. Выберите пункт меню Insert > Video («Вставка» > «Видео»).

Появится диалоговое окно Insert Video File («Вставить видеофайл»).

2. Найдите и выделитефайл, совместимый с плеером Adobe Flash, который вы хотите
добавить на страницу.

3. Нажмите кнопку Open («Открыть»).
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Добавление звуковых файлов
К любому объекту (кроме объектов, совместимых с Adobe Flash Player) можно добавить
звуковойфайл в файле *.notebook. Дополнительную информацию см. в разделеДобавление
звуков к объектам на странице 123.

Работа с мультимедийными файлами
Когда вы вставляетефайл мультимедиа в файл *.notebook, он становится объектом.
Поэтому этифайлы можно перемещать, изменять их размер, вращать и вносить в них другие
изменения точно так же, как и в любые другие объекты.

Информацию о том, как работать с объектами, включая мультимедийныефайлы, в файлах
*.notebook, см. раздел Chapter 5: Работа с объектами на странице 63.

Установка кодировщиков для дополнительных форматов
SMART Notebook поддерживает формат звука FLV иMP3. Чтобы SMART Notebook
поддерживал другие видео и аудиоформаты, можно установить дополнительный
кодировщик. После установки дополнительного кодировщика SMART Notebook
автоматически обнаружит его и будет поддерживать егоформаты видео и аудио.

Кодировщик Форматы видео Форматы звука Ссылка

MediaCoder Full
Pack 0.3.9

l ASF

l AVI

l MOV

l MPEG иMPG

l WMV

l AIF и AIFF

l WAV

mediacoderhq.com/dlfull.htm

NOTE

SMART Technologies ULC дает ссылку на эти программы в порядке любезности. Компания
не делает представления и не дает никаких гарантий относительно этих программ и любой
связанной с ними информации. Все вопросы, жалобы или претензии, касающиеся этих
программ, следует направлять разработчику соответствующего ПО.

Вставка содержимого из других программ
Если у вас есть материалы, созданные в других программах, и вы хотите использовать их в
своих файлах *.notebook, такие материалы можно перенести в ПОSMART Notebook,
выполнив следующие действия:

l Вырезание, копирование и последующая вставка

l Импорт содержимого

http://www.mediacoderhq.com/dlfull.htm
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Вырезание, копирование и вставка материалов из других программ
Вы можете вырезать или копировать содержимое из других программ в ПОSMART Notebook.

Вырезание содержимого из другой программы

1. В другой программе выделите содержимое, которое вы хотите вырезать, и выберите Edit
> Cut («Правка» > «Вырезать»).

2. В ПОSMART Notebook нажмите Paste («Вставить») .

Копирование содержимого из другой программы

1. В другой программе выделите содержимое, которое вы хотите скопировать, и выберите
Edit > Copy («Правка» > «Копировать»).

2. В ПОSMART Notebook нажмите Paste («Вставить») .

Импорт материалов при помощи функции захвата печати SMART Notebook Print
Capture
Во время установки ПОSMART Notebook на компьютер с операционной системой
Windows XP можно также установить функцию захвата печати SMART Notebook Print Capture.
SMART Notebook Print Capture работает как обычный драйвер принтера; единственное
отличие заключается в том, что захваченное изображение не печатается на бумаге, а
сохраняется в файл *.notebook. Каждая страница импортированногофайла отображается как
объект на отдельной странице, с сохранением исходногоформата и деления страниц.

NOTE

В случае установки SMART Notebook на компьютер с операционной системойWindows 7
илиWindows 8 материалы можно импортировать при помощифункции написания
документов SMART Notebook Document Writer (см. Импорт материалов при помощи
функции написания документов SMART Notebook Document Writer на странице 101).

Использование функции SMART Notebook Print Capture:

1. В исходном файле, который вам нужно экспортировать в файл *.notebook, выберите File
> Print («Файл» > «Печать»).

Появится диалоговое окноPrint («Печать»).

2. Выберите в списке принтеров SMART Notebook Print Capture.

3. При желании можно изменить ориентацию страниц и разрешение изображений (см.
Изменение ориентации страниц и разрешения изображений: на следующей странице).
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4. Укажите диапазон страниц, а затем нажмитеOK или Print («Печать»).

Еслифайл *.notebook не открыт, откроется новыйфайл *.notebook. Каждая страница
исходногофайла будет отображаться на отдельной странице.

ИЛИ

При наличии открытогофайла *.notebook каждая страница исходногофайла будет
вставлена в этот файл сразу за текущей страницей.

NOTE

Этот процесс может занять несколько минут.

Изменение ориентации страниц и разрешения изображений:

1. Нажмите кнопку Properties («Свойства») или Preferences («Настройки»).

Появится диалоговое окно SMART Notebook Print Capture Properties («Свойства захвата
экрана SMART Notebook»).

2. Выберите Portrait («Книжная») или Landscape («Альбомная»).

3. Выберите разрешение по умолчанию из выпадающего списка Resolution
(«Разрешение»).

ИЛИ

Выберите CUSTOMResolution («Пользовательское разрешение») в выпадающем
списке Resolution («Разрешение») , введите числа в полях Horizontal Resolution
(«Разрешение по горизонтали») и Vertical Resolution («Разрешение по вертикали»).

TIPS

o Используйте в обоих полях одинаковые значения, чтобы избежать искажения
изображения.

o Чем выше разрешение, тем больше изображение.

o Не используйте параметры Draft («Черновик»), Low («Низкое») илиMedium
(«Среднее») , поскольку изображение может масштабироваться
непропорционально.

4. НажмитеOK.
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Импорт материалов при помощи функции написания документов SMART Notebook
Document Writer
Во время установки ПОSMART Notebook на компьютер с операционной системойWindows 7
илиWindows 8 можно также установить функцию написания документов SMART Notebook
Document Writer. SMART Notebook Document Writer работает как обычный драйвер принтера,
единственное отличие заключается в том, что захваченное изображение не печатается на
бумаге, а сохраняется в файл *.notebook.

NOTE

В случае установки SMART Notebook на компьютер с операционной системойWindows XP
материалы можно импортировать при помощифункции захвата печати SMART Notebook
(см. Импорт материалов при помощифункции захвата печати SMART Notebook Print
Capture на странице 99).

Использование функции SMART Notebook Document Writer:

1. В исходном файле, который вам нужно экспортировать в файл *.notebook, выберите File
> Print («Файл» > «Печать»).

Появится диалоговое окноPrint («Печать»).

2. Выберите в списке принтеров SMART Notebook Document Writer.

3. При желании можно изменить ориентацию страниц (см. Изменение ориентации
страницы: на следующей странице).

4. Укажите диапазон страниц, а затем нажмитеOK или Print («Печать»).

Появится диалоговое окно.

5. Выберите SMART Notebook pages with images («Страницы SMART Notebook с
изображениями») , чтобы импортировать материалы из файла в виде изображений.

ИЛИ

Выберите SMART Notebook page with editable objects («Страницы SMART Notebook с
редактируемыми объектами») , чтобы импортировать материалы из файла в виде
редактируемых объектов.

NOTE

В случае импорта материалов в виде редактируемых объектов, некоторые объекты
могут отображаться некорректно. В этом случае можно импортировать материал в
виде изображений.
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6. НажмитеOK.

Откроется новыйфайл *.notebook. Каждая страница исходногофайла будет
отображаться на отдельной странице.

Изменение ориентации страницы:

1. Нажмите Properties («Свойства») или Preferences («Настройки»).

Откроется диалоговое окно Printing Preferences («Настройки печати»).

2. Выберите Landscape («Альбомная») или Portrait («Книжная») из выпадающего списка
Orientation («Ориентация»).

3. НажмитеOK.

Импорт файлов Microsoft PowerPoint
Вы можете импортировать материалы в файл *.notebook из различных источников, включая
файлы PowerPoint.

NOTE

ПОSMART Notebook не импортирует некоторые эффекты градиентов, узоров и
изображений. В результате эти эффекты могут отображаться в файлах *.notebook
некорректно.

TIP

Можно экспортировать файлы *.notebook в PowerPoint (см. Экспорт файлов на
странице 15).

Импорт файла PowerPoint:

1. Выберите File > Import («Файл» > «Импорт»).

Появится диалоговое окноOpen («Открыть»).

2. Выберите All PowerPoint Files (*.ppt;*.pptx) («Все файлы PowerPoint (*.ppt; *.pptx)») в
выпадающем списке Files of type («Типы файлов»).

3. Найдите и выделитефайл PowerPoint, который вы хотите импортировать.

4. Нажмите кнопку Open («Открыть»).

ПОSMART Notebook добавляет содержимоефайла PowerPoint в файл *.notebook.
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Импорт файлов из других программ для работы с интерактивными досками
Вы можете импортировать материалы в файлы *.notebook из различных источников, включая
другие программы для работы с интерактивными досками.

Если другие программы для работы с досками поддерживают используемыйформат файлов
интерактивной доски (CFF), вы можете экспортировать файл CFF из этих программ и затем
импортировать его в ПОSMART Notebook.

Или вы можете попробовать импортировать файл в родном формате другой программы для
работы с интерактивными досками.

NOTE

Вы такжеможете экспортировать файлы CFF (см. Экспорт файлов на странице 15).

Импорт файлов CFF

1. Выберите File > Import («Файл» > «Импорт»).

Появится диалоговое окноOpen («Открыть»).

2. Выберите All Common File Format Files (*.iwb) («Все файлы используемого формата
(*.iwb)») в выпадающем списке Files of type («Типы файлов»).

3. Найдите и выделитефайл, который вы хотите импортировать.

4. Нажмите кнопку Open («Открыть»).

Файл открывается.
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Импорт других файлов:

1. НажмитеOpen File («Открыть файл») .

Появится диалоговое окноOpen («Открыть»).

2. Выберите пункт All Files (*.*) («Все файлы (*.*)») в выпадающем списке Files of type
(«Типы файлов»).

3. Найдите и выделитефайл, который вы хотите импортировать.

4. Нажмите кнопку Open («Открыть»).

Если вы импортируетефайл, которыйПОSMART Notebook поддерживает, файл
откроется.

ИЛИ

Если вы импортируетефайл, которыйПОSMART Notebook не поддерживает, SMART
Notebook добавит его на вкладку «Вложения». Вы можете открывать такие вложенные
файлы с помощью стороннего программного обеспечения, но не можете добавлять их на
страницу.

Вставка формул в математическом
редакторе
С помощью математического редактора вы можете представить рукописныеформулы в
более удобном для чтения виде. Математический редактор распознает рукописный текст и
автоматически преобразует его в печатныйформат. Вы также сможете добавить
распознанную формулу на рабочий лист GeoGebra, еслиформат ее графика поддерживается
этим ПО.

Вставка уравнения на страницу

1. Нажмите кнопку Add-ons («Надстройки») , а затем выберите Insert Equation

(«Вставить формулу») .

Откроется математический редактор.

2. Выберите инструмент «Перо» и его цвет (см. раздел page 32).
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3. Напишитеформулу в разлинованной области редактора.

Рукописная формула будет преобразована в печатную формулу, которая появится ниже
разлинованной области. Рядом с распознаннойформулой появятся значки «Принять»
или «Отклонить».

4. Нажмите , чтобы сохранить распознанную формулу.

Печатная формула появится на странице.

ИЛИ

Нажмите , чтобы не сохранять распознанную формулу и закрыть математический

редактор.

Изменение распознанного уравнения

1. Нажмите Select («Выбрать») и дважды нажмите на странице на распознанное

уравнение.

В математическом редакторе появится рукописная формула.

2. Отредактируйте рукописную формулу с помощью инструмента «Ластик» и пера.

Отредактированная формула будет распознана и появится ниже разлинованной области.
Рядом с распознаннойформулой появятся значки «Принять» или «Отклонить».
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3. Нажмите , чтобы сохранить распознанную формулу.

В формулу будут внесены ваши исправления.

ИЛИ

Нажмите , чтобы не сохранять распознанную формулу и закрыть математический

редактор.

Формула не обновляется.

Добавление распознанного уравнения на рабочий лист GeoGebra

1. Вставка рабочего листаGeoGebra на страницу (см. Вставка материалов из GeoGebra на
странице 90).

2. Перетащитеформулу со страницы на виджет GeoGebra.

Формула автоматически появится на рабочем листе.

Вставка веб-браузеров
На страницу *.notebook можно добавить веб-браузер, чтобы использовать его для навигации
и демонстрации веб-страниц. Веб-браузер можно изменять точно так же, как и любой другой
объект в ПОSMART Notebook (см. Chapter 5: Работа с объектами на странице 63).

NOTE

При изменении размеров веб-браузера содержимое в его окне будет масштабироваться
автоматически, таким образом вы будете видеть веб-страницу целиком.
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Добавление веб-браузера

Вставка веб-браузера:

1. Выберите Insert > Internet Browser («Вставка» > «Веб-браузер»).

Появится веб-браузер.

2. Дважды нажмите в адресной строке, введите адрес нужной веб-страницы и нажмитеGo

(«Перейти») .

TIP

Если к используемому компьютеру не подключена клавиатура, нажмите

SMART Keyboard , чтобы показать экранную клавиатуру.

3. Для работы с веб-страницамиможно использовать следующие кнопки на панели
инструментов веб-браузера:

Кнопка Команда Действие

Назад Просмотреть предыдущую веб-страницу.

Вперед Просмотреть следующую веб-страницу.

Возврат на
закрепленную
страницу

Открыть закрепленную веб-страницу.

Зафиксировать
страницу

Закрепить текущую веб-страницу.
При первом открытиифайла *.notebook в окне веб-браузера
отображается закрепленная веб-страница. К закрепленной
странице можно вернуться в любое время в процессе
работы, нажав Return to Pinned Page («Возврат на

закрепленную страницу») .

Перезагрузить Перезагрузить текущую веб-страницу.

Переместить
панель

Изменить положение панели инструментов веб-браузера.
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Настройка прокси-серверов
Веб-браузеры в ПОSMART Notebook работают с любыми прокси-серверами, которые
отвечают требованиям стандарта RFC 2068 HTTP. Если системный администратор установил
ПОSMART Notebook в сети с прокси-сервером, потребуется создать правила политики
доступа для входящего и исходящего потоков данных для этого прокси-сервера. В
дальнейшем можно будет повысить безопасность сети, включив аутентификацию, например
базовую аутентификацию или аутентификацию диспетчера локальной сети NT (NTLM).

NOTE

Прокси-серверы замечательно защищают внутренние сети от несанкционированного
взлома, но их использование приводит к значительному увеличению сетевой задержки.

Вложение файлов и веб-страниц
Можно прикреплять копиифайлов, ярлыкифайлов и ссылки на веб-страницы с помощью
вкладки «Вложения».

Прикреплениефайлов или ссылок на веб-страницы позволит быстро найти и открыть эти
элементы во время презентациифайла *.notebook.

NOTES

l Файлы и ссылки на веб-страницы можно также связать с объектом на странице (см.
Добавление ссылок к объектам на странице 120).

l В качестве альтернативы добавлению ссылки на веб-страницу в файл *.notebook
можно добавить веб-браузер (см. Вставка веб-браузеров на странице 106).

Вложение копии файла:

1. Если вкладка Attachments («Вложения») не отображается, нажмите пункт Attachments

.

2. Нажмите Insert («Вставить») в нижней части вкладки Attachments («Вложения») , а
затем выберите Insert Copy of File («Вставить копию файла»).

Появится диалоговое окноInsert Copy of File («Вставить копию файла»).

3. Найдите и выделитефайл, который вы хотите вложить.
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4. Нажмите кнопку Open («Открыть»).

Имя и размерфайла появятся на вкладке Attachments («Вложения»).

NOTE

При вложениифайла размерфайла *.notebook увеличивается. Хотя SMART Notebook
сжимает файлы для экономииместа, одни типы файлов сжимаются лучше, чем
другие.

Вложение ярлыка файла:

1. Если вкладка Attachments («Вложения») не отображается, нажмите пункт Attachments

.

2. Нажмите Insert («Вставить») в нижней части вкладки Attachments («Вложения») , а
затем выберите Insert Shortcut to File («Вставить ярлык файла»).

Появится диалоговое окно Insert File Shortcut («Вставить ярлык файла»).

3. Найдите и выделитефайл, который вы хотите вложить.

4. Нажмите кнопку Open («Открыть»).

Имяфайла и ярлык появятся на вкладке Attachments («Вложения»).

NOTES

o SMART Notebook не экспортирует ярлыки. Если необходимо экспортировать
файловое вложение, прикрепите копию файла, а не ярлык.

o Убедитесь, чтофайл присутствует на компьютере, который будет использован во
время урока.

Вложение ссылок на веб-страницу:

1. Если вкладка Attachments («Вложения») не отображается, нажмите пункт Attachments

.

2. Нажмите кнопку Insert («Вставить») в нижней части вкладки Attachments («Вложения») ,
а затем выберите пункт Insert Hyperlink («Вставить гиперссылку»).

Появится диалоговое окноInsert Hyperlink («Вставка гиперссылки»).

3. Введите адрес веб-страницы в поле Hyperlink («Гиперссылка»).

4. Введите имя ссылки в поле Display name («Отображаемое имя»).

5. НажмитеOK.

Отображаемое имя иURL появятся на вкладке Attachments («Вложения»).
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Для открытия файла или веб-страницы с вкладки Attachments («Вложения»):

1. Если вкладка Attachments («Вложения») не отображается, нажмите пункт Attachments

.

На вкладке «Вложения» показан список всех вложений для текущегофайла.

o Если прикрепленный элемент представляет собой копию файла, в столбце Size
(«Размер») отображается размерфайла.

o Если прикрепленный элемент представляет собой ярлык нафайл, в столбце Size
(«Размер») отображается Shortcut («Ярлык»).

o Если прикрепленный элемент представляет собой ссылку на веб-страницу, в
столбце Size («Размер») отображается URL-адрес.

2. Чтобы открыть файл, дважды нажмите на его имени или ярлыке.

ИЛИ

Чтобы открыть веб-страницу, дважды нажмите на ссылку.

Организация и предоставление общего
доступа к содержимому с помощью Галереи
Галерея — это вкладка пользовательского интерфейса SMART Notebook, где можно
просматривать или искать материалы, которое потом можно добавить в своифайлы
*.notebook. Галерея содержит набор категорий, одной из которых является категория My
Content («Мое содержимое»).

Если вы используете одни и те жематериалы в нескольких файлах *.notebook, вы можете
добавить эти материалы в категорию My Content («Мое содержимое»). Вы можете
предоставить доступ к материалам в категорииMy Content («Мое содержимое») другим
учителям вашейшколы, импортируя или экспортируя файлы коллекций галереи. Вы также
можете подключиться к категории Team Content («Содержимое группы»), в которой находятся
материалы, предоставленные вами и другими учителями вашейшколы.

После добавления ваших материалов в Галерею вы можете вставлять их в файлы *.notebook,
как описано в разделе Вставка материалов из Галереи на странице 88.

Добавление содержимого в Галерею
Вы можете добавлять объекты и страницы SMART Notebook, а также вспомогательные
файлы в категорию «Мое содержимое» в галерее.
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Добавление объекта в Галерею:

1. Если галерея не отображается, нажмитеGallery («Галерея» .

2. Выделите объект, который требуется добавить в галерею.

3. Перетащите объект со страницы в категорию My Content («Мое содержимое») галереи
или в одну из ее подкатегорий.

NOTES

o Нельзя перетащить объект, если он заблокирован на месте (см.
LockingObjects.htm).

o Если вы хотите изменить имя элемента галереи, выделите элемент, нажмите
стрелку меню и выберите Rename («Переименовать»).

Добавление страницы в Галерею:

1. Продолжайте создавать и изменять объекты на странице до тех пор, пока она не будет
выглядеть точно так, как вы хотите.

2. Выберите File > Export Page as Gallery Item («Файл» > «Экспортировать страницу
как элемент галереи»).

Появится диалоговое окно Save Page as Gallery Item («Сохранить страницу как элемент
галереи»).

3. Выберите папку, в которую нужно сохранить страницу.

4. Введите имя страницы в поле File name («Имяфайла»).

5. Нажмите «Сохранить».

6. Если галерея не отображается, нажмитеGallery («Галерея» .

7. Выберите категорию My Content («Мое содержимое») (или одну из ее подкатегорий) в
списке категорий галереи, нажмите стрелку меню и выберите пункт Add to My Content
(«Добавить в мое содержимое»).

Появится диалоговое окно Add toMy Content («Добавить в «Мое содержимое») .

8. Найдите и выделите элемент, сохраненный в шаге 5.

9. Нажмите кнопку Open («Открыть»).
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Добавление поддерживаемого файла в Галерею:

1. Если галерея не отображается, нажмитеGallery («Галерея» .

2. Выберите категорию My Content («Мое содержимое») (или одну из ее подкатегорий) в
списке категорий галереи, нажмите стрелку меню и выберите пункт Add to My Content
(«Добавить в мое содержимое»).

Появится диалоговое окно Add toMy Content («Добавить в «Мое содержимое») .

3. Найдите и выделите элемент, который вы хотите добавить в галерею.

4. Нажмите кнопку Open («Открыть»).

NOTE

По умолчанию SMART Notebook присваивает новому элементу галереи имя на основе
исходного именифайла. Если вы хотите изменить имя элемента, выделите эскиз
элемента галереи, нажмите стрелку меню и выберите пункт Rename
(«Переименовать»).

Организация содержимого в Галерее
При добавлении объектов, страниц и поддерживаемых файлов в категорию галереи «Мое
содержимое», вам может понадобиться реорганизовать структуру категории. Вы можете
создавать подкатегории и перемещать элементы галереи между подкатегориями.

Для создания подкатегории выполните следующее:

1. Если галерея не отображается, нажмитеGallery («Галерея» .

2. Выберите категорию My Content («Мое содержимое») (или одну из ее подкатегорий) в
списке категорий галереи, нажмите стрелку меню и выберите New Folder («Новая
папка»).

Появится новая подкатегория.

3. Введите новое имя подкатегории и нажмите ENTER.
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Переименование подкатегории:

1. Если галерея не отображается, нажмитеGallery («Галерея» .

2. ВыберитеMy Content («Мое содержимое») в списке категорий галереи и перейдите к
подкатегории, которую требуется переименовать.

3. Выделите подкатегорию, нажмите на стрелку ее меню и выберите Rename
(«Переименовать»).

4. Введите новое имя подкатегории и нажмите ENTER.

Перемещение элемента Галереи в другую подкатегорию:

1. Если галерея не отображается, нажмитеGallery («Галерея» .

2. Перейдите к категории, содержащей элемент галереи, который вам нужно переместить.

Будет выведено содержимое категории.

3. Перетащите элемент в другую подкатегорию.

Предоставление другим учителям доступа к содержимому
Импортирование и экспортированиефайлов коллекций — это идеальный способ поделиться
своими пользовательскими категориями с другими учителями и использовать категории,
созданные другими учителями. Вы можете использовать файлы коллекций, чтобы
добавлять элементы в категорию «Мое содержимое» галереи. После импортирования файла
коллекции все его элементы появляются в новой подкатегории галереи.

Импортирование файла коллекции другого учителя

1. Если галерея не отображается, нажмитеGallery («Галерея» .

2. Выберите категорию My Content («Мое содержимое») (или одну из ее подкатегорий) в
списке категорий галереи, нажмите стрелку меню и выберите пункт Add to My Content
(«Добавить в «Мое содержимое»).

Появится диалоговое окно Add toMy Content («Добавить в «Мое содержимое») .

3. Перейдите к папке, содержащейфайл коллекции, который вам нужно импортировать.

NOTE

Файл коллекции имеет расширение *.gallery.

4. Выделитефайл коллекции и нажмитеOpen («Открыть»).

Коллекция появится в новой подкатегории.
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Экспортирование файла коллекции для предоставления общего доступа другим
учителям

1. Выделите категорию, содержащую элементы, которые вы хотите сохранить в
коллекции.

NOTE

SMART Notebook экспортирует выбранную категорию, но не экспортирует ее
подкатегории.

2. Нажмите на стрелку меню категории и выберите Export as Collection File
(«Экспортировать как файл коллекции»).

Появится диалоговое окно Save As («Сохранить как»).

3. Выберите папку, в которую следует сохранить файл коллекции.

4. Введите имяфайла в поле File name («Имяфайла») .

5. Нажмите «Сохранить».

Подключение к категориям группового содержимого
С помощью категорий «Групповое содержимое» можно подключиться к содержимому
Галереи в общей сетевой папке вашейшколы. К одной папке могут подключаться несколько
учителей. SMART Notebook автоматически делает ваши изменения доступными другим
учителям.

NOTE

К категории »Содержимое для группы» у вас имеются такие же права доступа, как к
сетевым папкам вашейшколы. Если вы имеете полный доступ к сетевой папке, вы можете
добавлять и удалять элементы в категории «Содержимое для группы» этой папки. Однако
если вы имеете доступ только для чтения, вы сможете копировать файлы из категории
«Содержимое для группы», но не сможете добавлять, редактировать или удалять
элементы.

Подключение к категории «Содержимое для группы»:

1. Если галерея не отображается, нажмитеGallery («Галерея» .

2. Нажмите Show additional Gallery actions («Показать дополнительные операции

Галереи») , а затем выберите Connect to Team Content («Подключение к папке

«Содержимое для группы»).

Появится диалоговое окноBrowse For Folder («Обзор папок»).
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3. Найдите и выделите папку, содержащую категорию Team Content («Содержимое для
группы»), к которой вы хотите подключиться, и нажмитеОК.

В Галерее появится категория «Содержимое для группы».

Добавление материалов в категорию «Содержимое для группы»:

Материалы в категорию «Содержимое для группы» добавляются так же, как и в
категорию «Мое содержимое» (см. Добавление содержимого в Галерею на
странице 110).

Предоставление общего доступа к
содержимому с помощью веб-сайта
SMART Exchange
Учебнымиматериалами ифайлами *.notebook можно обмениваться не только с коллегами в
пределах однойшколы (см. раздел Предоставление другим учителям доступа к
содержимому на странице 113), но и с учителями по всему миру, используя веб-сайт
SMART Exchange (exchange.smarttech.com).

Предоставление доступа к файлу *.notebook на веб-сайте SMART Exchange:

1. Откройтефайл *.notebook, к которому хотите открыть доступ.

2. Выберите File > Share on SMART Exchange («Файл» > «Совместно использовать на
сервере SMART Exchange»).

Появится диалоговое окно.

http://exchange.smarttech.com/
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3. Если вы не зарегистрированы на веб-сайте SMART Exchange, нажмите Not a member yet
(«Еще не вступил(а) в сообщество»), затем следуйте инструкциям на экране, чтобы
создать учетную запись.

ИЛИ

Если у вас уже есть учетная запись, введите свой адрес электронной почты в поле Email
Address («Адрес электронной почты») и свой пароль в поле Password («Пароль») , а
затем нажмите Sign In («Вход»).

TIPS

o Если вы забыли свой пароль, нажмите Forgot your password («Забыли
пароль?») и следуйте инструкциям на экране, чтобы сбросить пароль.

o Чтобы не вводить данные учетной записи веб-сайта SMART Exchange каждый раз
при использовании материалов, установитефлажок Keep me signed in
(«Оставаться в системе»).

4. Введите соответствующую информацию:

Управление Инструкции

Введите подробные
сведения о ресурсе

Введите заголовок для файла *.notebook.

Описание Введите описаниефайла *.notebook.

Предмет(-ы) Выберите предметы, при изучении которых можно
использовать данныйфайл *.notebook.

Класс(-ы) Выберите классы, при обучении которых можно
использовать данныйфайл *.notebook.

Ключевые слова Введите слова илифразы, которые другие пользователи
SMART Exchange могут вводить для поиска данногофайла
*.notebook, разделяя их запятыми.

5. Прочитайте соглашение о совместном использовании ресурсов.

6. Если вы согласны с условиями этого соглашения, нажмите Agree and Submit
(«Согласен и принимаю условия»).
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Chapter 7: Создание учебных заданий

Использование расширенных функций объектов 118
Создание пользовательских стилей художественного пера 118
Добавление ссылок к объектам 120
Добавление звуков к объектам 123
Добавление анимации к объектам 125

Использование расширенных функций страницы 125
Отображение границ страниц учащихся 125
Запись страниц с помощью средства записи уроков 126
Применениефонов и тем к страницам 128

Применение тем с помощью вкладки «Свойства» 128
Применениефона и тем с помощью галереи 131

Создание тем 132
Создание примеров учебных заданий 133

Создание учебного задания на соответствие 133
Создание учебных занятий типа «скрыть/показать» 135
Создание учебного задания на постепенное открытие 138
Создание других типов учебных заданий 140

ПОSMART Notebook позволяет не только представлять информацию учащимся, но и
привлекать их к процессу обучения с помощью интерактивных учебных занятий.

Во время создания учебных занятий можно добавлять в них такие объекты, как фигуры,
изображения и таблицы, и использовать такиефункции, как мастер создания занятий и жест
масштабирования.

В этом разделе описываются дополнительныефункции, которые вы можете использовать
для создания учебных занятий, и указаны способы создания наборов примеров учебных
занятий. Вы можете использовать эти примеры учебных занятий или разработать свои
собственные. Кроме того, можно использовать материалы и ресурсы галереи и веб-сайта
SMART Exchange.
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Использование расширенных функций
объектов
При создании учебных занятий вы можете использовать следующие расширенныефункции
объектов:

l Пользовательские стили художественного пера

l Ссылки на объекты

l Звуки объектов

l Анимация объектов

l Добавление ссылки на инструмент для объекта

Также объекты можно блокировать, если вы не хотите, чтобы они перемещались или
изменялись в процессе презентации учебных занятий.

Создание пользовательских стилей художественного пера
ПОSMART Notebook содержит восемь различных стилей художественного пера (см.
Написание или рисование цифровыми чернилами на странице 32). В дополнении к этим
стилям вы можете создавать свои собственные стили, используя изображения или объекты
выбранной страницы.

Создание пользовательского стиля художественного пера с помощью изображений

1. Нажмите Pens («Перья») .

Появляется кнопка инструмента «Перья».

2. Нажмите Pen Types («Типы перьев»), затем выберите Creative Pen
(«Художественное перо»).

3. Выберите тип линии.
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4. Если вкладка Properties («Свойства») не отображается, нажмите Properties

(«Свойства») .

5. Выберите «Тип линии».

6. Выберите Use a custom stamp image («Использовать пользовательское
изображение для клонирования»).

7. Нажмите кнопку Browse («Обзор»).

Появится диалоговое окноInsert Image File («Вставить файл изображения»).

8. Найдите и выделите изображение, которое хотите использовать для создания стиля
художественного пера.

9. Нажмите кнопку Open («Открыть»).

10. Пишите или рисуйте на странице цифровыми чернилами.

TIP

o Для восстановления стиля, созданного на основе типа линий по умолчанию,
выберите Use the default pattern («Использовать узор по умолчанию»).

o Если вы хотите сохранить созданный пользовательский стиль художественного
пера для последующего использования, нажмите Save Tool Properties
(«Сохранить свойства инструмента»). Позже настройки стиля художественного
пера можно будет сбросить (см. Настройка панели инструментов на
странице 225).

Создание пользовательского стиля художественного пера с помощью объектов

1. Нажмите Pens («Перья») .

Появляется кнопка инструмента «Перья».

2. Нажмите Pen Types («Типы перьев»), затем выберите Creative Pen
(«Художественное перо»).
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3. Если вкладка Properties («Свойства») не отображается, нажмите Properties

(«Свойства») .

4. Выберите «Тип линии».

5. Выберите Use a custom stamp image («Использовать пользовательское
изображение для клонирования»).

6. Нажмите Select object («Выбрать объект»), затем выделите нужный объект на
странице.

7. Пишите или рисуйте на странице цифровыми чернилами.

TIP

o Для восстановления стиля, созданного на основе типа линий по умолчанию,
выберите Use the default pattern («Использовать узор по умолчанию»).

o Если вы хотите сохранить созданный пользовательский стиль художественного
пера для последующего использования, нажмите Save Tool Properties
(«Сохранить свойства инструмента»). Позже настройки стиля художественного
пера можно будет сбросить (см. Настройка панели инструментов на
странице 225).

Добавление ссылок к объектам
Вы можете связать любой объект на странице с веб-страницей, другой страницейфайла,
файлом на компьютере или с вложением. Вложение представляет собой копию файла, ярлык
файла или ссылку на веб-страницу, добавленные на вкладку «Вложения».

NOTE

Вы можете отобразить анимированные индикаторы ссылок вокруг всех ссылок на странице
(см. Отображение ссылок на странице 178).

Добавление ссылок на веб-страницу:

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите Link («Ссылка»).

Появится диалоговое окноInsert Link («Вставить ссылку»).

3. НажмитеWeb Page («Веб-страница»), затем введите адрес веб-страницы в
полеAddress («Адрес»).
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4. Если вы хотите открывать ссылку, нажимая на значок, выберите Corner icon («Угловой
значок»).

ИЛИ

Если вы хотите открывать ссылку, нажимая в любом месте объекта, выберите пункт
Object («Объект»).

5. НажмитеOK.

Если вы выбрали вариант Corner icon («Угловой значок»), в нижнем левом углу

объекта появится значок .

Добавление ссылки на другую страницу файла:

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите Link («Ссылка»).

Появится диалоговое окноInsert Link («Вставить ссылку»).

3. Нажмите Page in this File («Страница в этом файле»), затем выберите вариант в поле
Select a page («Выбрать страницу»).

4. Если вы хотите открывать ссылку, нажимая на значок, выберите Corner icon («Угловой
значок»).

ИЛИ

Если вы хотите открывать ссылку, нажимая в любом месте объекта, выберите пункт
Object («Объект»).

5. НажмитеOK.

Если вы выбрали вариант Corner icon («Угловой значок»), в нижнем левом углу

объекта появится значок .

Добавить ссылку на файл на вашем компьютере:

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите Link («Ссылка»).

Появится диалоговое окноInsert Link («Вставить ссылку»).

3. Нажмите File on this Computer («Файл на этом компьютере»), затем выберите
местоположениефайла и введите его имя в поле File («Файл»).
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4. Если вы хотите прикрепить копию файла, выберите Copy of file («Копия файла»).

ИЛИ

Если нужно вставить ярлык файла, выберите Shortcut to file («Ярлык файла»).

5. Если вы хотите открывать ссылку, нажимая на значок, выберите Corner icon («Угловой
значок»).

ИЛИ

Если вы хотите открывать ссылку, нажимая в любом месте объекта, выберите пункт
Object («Объект»).

6. НажмитеOK.

Если вы выбрали вариант Corner icon («Угловой значок»), в нижнем левом углу

объекта появится значок .

Добавление ссылки к вложению:

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите Link («Ссылка»).

Появится диалоговое окноInsert Link («Вставить ссылку»).

3. Нажмите Current Attachments («Текущие вложения»), затем выберите вложение из
списка.

4. Если вы хотите открывать ссылку, нажимая на значок, выберите Corner icon («Угловой
значок»).

ИЛИ

Если вы хотите открывать ссылку, нажимая в любом месте объекта, выберите пункт
Object («Объект»).

5. НажмитеOK.

Если вы выбрали вариант Corner icon («Угловой значок»), в нижнем левом углу

объекта появится значок .
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Удаление ссылки:

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите Link («Ссылка»).

Появится диалоговое окноInsert Link («Вставить ссылку»).

3. Нажмите Remove Link («Удалить ссылку»).

Добавление звуков к объектам
К любому объекту (кромефайлов и виджетов, совместимых с плеером Adobe Flash) можно
добавить звук в виде звуковогофайла или звуковой записи, созданной с помощью
микрофона компьютера. Вы можете воспроизвести звук в ходе урока, нажав на значок в углу
объекта или на сам объект.

NOTE

SMART Notebook поддерживает формат звукаMP3. Если вы хотите, чтобы программное
обеспечение SMART Notebook поддерживало другие типы файлов, вы можете установить
дополнительные кодировщики (см. Установка кодировщиков для дополнительных
форматов на странице 98).

Добавление аудио-файла к объекту:

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите Sound («Звук»).

Появится диалоговое окно Insert Sound («Вставить звук»).

3. Нажмите «Обзор».

Появится диалоговое окноInsert File («Вставить файл»).

4. Найдите и выделите аудио-файл, затем нажмитеOpen («Открыть»).

5. Выберите опцию Corner Icon («Угловой значок») , если вы хотите воспроизводить
звуковойфайл при нажатии на значок в нижнем левом углу объекта.

ИЛИ

Выберите опцию Object («Объект») , если вы хотите воспроизводить аудио-файл при
нажатии на любое место объекта.

6. Нажмите Attach Sound («Вложить звук»).
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Добавление записанного звука к объекту:

1. Подключите микрофон к компьютеру и включите его.

2. Выберите объект.

3. Нажмите на стрелку меню объекта и выберите Sound («Звук»).

Появится диалоговое окно Insert Sound («Вставить звук»).

4. Нажмите Start Recording («Начать запись»).

5. Создайте запись с помощью микрофона.

IMPORTANT

ПОSMART Notebook останавливает запись через минуту. Убедитесь, что ваша запись
длится не более минуты.

6. Нажмите Stop Recording («Остановить запись»).

7. Введите название записи в поле Recording name («Название записи»).

8. Или нажмите Preview Recording («Прослушать запись») , чтобы прослушать звук
перед добавлением его к объекту.

9. Выберите опцию Corner Icon («Угловой значок») , если вы хотите воспроизводить
звуковойфайл при нажатии на значок в нижнем левом углу объекта.

ИЛИ

Выберите опцию Object («Объект») , если вы хотите воспроизводить аудио-файл при
нажатии на любое место объекта.

10. Нажмите кнопку Attach Recording («Вложить запись»).

Удаление звука объекта:

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите Sound («Звук»).

Появится диалоговое окно Insert Sound («Вставить звук»).

3. Нажмите кнопку Remove Sound («Удалить звук»).
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Добавление анимации к объектам
Вы можете добавить анимацию к объекту, чтобы он вылетал на страницу сбоку, вращался,
возникал постепенно, сжимался и др. Вы можете задать запуск анимации при открытии
страницы или при нажатии на объект.

Добавление анимации к объекту:

1. Выберите объект.

2. Если вкладка Properties («Свойства») не отображается, нажмите Properties

(«Свойства») .

3. НажмитеObject Animation («Анимация объекта»).

4. Укажите параметры в выпадающих спискахType («Тип»), Direction («Направление»),
Speed («Скорость»), Occurs («События»)иRepeats («Повторы»).

Использование расширенных функций
страницы
При создании учебных занятий вы можете использовать следующие расширенныефункции
страницы:

l Границы страниц учащихся

l Запись страницы

l Фоны и темы для страниц

Отображение границ страниц учащихся
Если учащиеся используют для ответов на вопросы и сдачи экзаменов ПОSMART Notebook
SE (Student Edition), вам может пригодиться возможность создания страниц с вопросами для
отображения границы страницы учащихся, показывающей область страницы, которая будет
видна на экранах компьютеров учащихся.

NOTE

Эта процедура применима, если вы используете ПОSMART Response в режимеCE.

Отображение границ страниц учащихся

1. Выберите View > Alignment («Вид» > «Выравнивание»).

Появится диалоговое окноAlignment («Выравнивание»).
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2. Нажмите Student Page Border («Границы страниц учащихся»).

3. УстановитефлажокShow a border around the area that will be visible in SMART
Notebook SE during an assessment («Показать границу вокруг области, которая
будет отображаться в ПО SMART Notebook SE во время выполнения экзамена»).

4. Выберите параметр Preset value («Предустановленное значение»)и выберите
разрешение экрана в выпадающем списке.

ИЛИ

Выберите Custom value («Пользовательское значение»), в соответствующих полях
введите значения ширины и высоты экранов учащихся.

5. НажмитеOK.

Вокруг области, которую смогут увидеть на своих экранах компьютеров учащиеся,
появится цветная граница.

Запись страниц с помощью средства записи уроков
Надстройка «Средство записи уроков» позволяет записывать действия, совершаемые вами
на странице. Впоследствии вы можете воспроизвести запись на той же странице с помощью
средства записи уроков или нового виджета воспроизведения.

NOTE

Средство записи SMART представляет собой предыдущий инструмент, но с новыми
возможностями. При использовании средства записи SMART вы можете записывать свой
действия в программах, отличных от SMART Notebook. При использовании средства записи
SMART вы можете вести запись всего экрана, указанного окна или прямоугольного участка
экрана. Если вы подключите к компьютеру микрофон, вы также сможете записывать
аудио.

Дополнительную информацию см. в разделе Работа со средством записи SMART на
странице 192.

Запись страницы

1. Нажмите кнопку «Надстройки» , затем нажмите «Средство записи уроков».

2. Нажмите кнопку «Новая запись».

По периметру записываемой страницы отображается граница красного цвета.

3. Выполните на текущей странице действия, которые требуется записать.



CHAPTER 7
СОЗДАНИЕ УЧЕБНЫХ ЗАДАНИЙ

127

4. Закончив выполнение этих действий, нажмите кнопку Stop Recording («Остановить

запись»).

TIPS

o Чтобы сохранить запись, просто сохранитефайл .notebook.

o Закройте надстройку «Средство записи уроков» на время проведения
презентаций. Виджет воспроизведения будет отображаться в нижней части
страницы. Можно разблокировать его и переместить в любое место на странице.

o Запись со страницы удалить невозможно.

Воспроизведение записи страницы с помощью надстройки «Средство записи уроков»

1. Откройте записанную вами страницу.

2. Если надстройка «Средство записи уроков» закрыта, нажмите кнопку «Надстройки»

, затем нажмите «Средство записи уроков».

3. Нажмите кнопку «Воспроизведение» на панели воспроизведения

Вы можете переключаться между режимами воспроизведения и паузы в

процессе воспроизведения записи.

4. Дополнительно можно выполнить следующие действия:

o Нажмите кнопку «Перемотка назад» для перемотки записи назад.

o Нажмите кнопку «Перемотка вперед» для перемотки записи вперед.

Воспроизведение записи страницы с помощью виджета воспроизведения

1. Откройте записанную вами страницу.

2. Если надстройка Lesson Recorder («Средство записи уроков») открыта, нажмите кнопку

в строке меню надстроек, чтобы закрыть ее.

Виджет воспроизведения будет отображаться в нижней части страницы.

TIPS

Можно разблокировать и перемещать виджет по странице, чтобы к нему можно было
легко получить доступ в ходе презентации.
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3. Нажмите кнопку «Воспроизведение» в виджете воспроизведения.

Вы можете переключаться между режимами воспроизведения и паузы в

процессе воспроизведения записи.

4. Дополнительно можно выполнить следующие действия:

o Нажмите кнопку «Перемотка назад» для перемотки записи назад.

o Нажмите кнопку «Перемотка вперед» для перемотки записи вперед.

Применениефонов и тем к страницам
Фон страницы можно применить с помощью вкладки «Свойства» или галереи.

Применение тем с помощью вкладки «Свойства»
С помощью вкладки «Свойства» можно применить фон страницы в виде одного цвета,
градиентного смешения двух цветов, узора или изображения.

Применение фона:

1. Выберите Format > Page > Set Background Fill («Формат» > «Страница» >
«Установить заливку фона»).

На вкладке Properties («Свойства») будут отображаться опцииFill Effects («Эффекты
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заливки»).
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2. Выберите тип заливки

Тип заливки Порядок действий

Без заливки
(прозрачный)

Выберите No fill («Без заливки»).

Сплошная заливка a. Выберите Solid fill («Сплошная заливка»).

b. Выберите один из следующих вариантов:
o Выберите один из 40 цветов палитры.

o НажмитеMore («Еще»)и выберите требуемый цвет в
диалоговом окне.

o Нажмите пипетку и выберите цвет на экране.

Градиент из двух
цветов

a. ВыберитеGradient fill («Градиентная заливка»).

b. Для каждого цвета выполните одно из следующих действий:
o Выберите один из 40 цветов палитры.

o НажмитеMore («Еще»)и выберите требуемый цвет в
диалоговом окне.

o Нажмите пипетку и выберите цвет на экране.

c. Выберите нужный вариант из выпадающего списка Style
(«Тип»).

Заливка узором a. Выберите Pattern fill («Заливка по шаблону»).

b. Выберите узор.

c. Нажмите Foreground color («Цвет переднего плана»),
выберите в диалоговом окне требуемый цвет, затем
нажмите «OK».

d. Нажмите Background color («Цвет фона»), выберите в
диалоговом окне требуемый цвет, затем нажмите «OK».

Рисунок a. Выберите Image fill («Заливка изображением»).

b. Нажмите «Обзор».
Появится диалоговое окноInsert Image File («Вставить файл
изображения»).

c. Найдите и выделите изображение, которое вы хотите
использовать в качествефона, и нажмитеOpen
(«Открыть»).

NOTE

При вставке большого изображения может открыться
диалоговое окно с предложением уменьшить размер
файла изображения либо оставить его без изменений.
Дополнительную информацию см. в разделе Настройка
параметров оптимизации изображения на странице 229.
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Удаление фона:

1. Выберите Format > Page > Set Background Fill («Формат» > «Страница» >
«Установить заливку фона»).

На вкладке Properties («Свойства») будут отображаться опцииFill Effects («Эффекты
заливки»).

2. Выберите No fill («Без заливки»).

Применение фона и тем с помощью галереи
Можно настроить страницу, все страницы группы или все страницы файла, используя фон
или тему из галереи.

Применение фонового рисунка или темы:

1. Если галерея не отображается, нажмитеGallery («Галерея» .

2. ВыберитеMy Content («Мое содержимое») в списке категорий галереи, чтобы
просмотреть фоновые рисунки и темы, созданные или импортированные вами (см.
Создание тем на следующей странице).

ИЛИ

ВыберитеGallery Essentials («Основные темы галереи») , чтобы просмотреть фоны и
темы, установленные с ПО.

3. Выберите Backgrounds and Themes («Фоны и темы»).

В галерее отображаются эскизы имеющихся фоновых рисунков и тем.

4. Нажмите на эскиз темы, которую вы хотите применить.

5. Нажмите на стрелку меню этого эскиза и выберите пункт Insert in Notebook («Вставить
в Notebook»).

Появится диалоговое окноInsert Theme («Вставить тему»).
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6. Выберите Insert theme on all pages («Вставить тему на всех страницах») , чтобы
применить фон или тему ко всем страницам в файле.

ИЛИ

Выберите Insert theme on all pages of current group («Вставить тему на всех
страницах текущей группы») , чтобы применить фон или тему ко всем страницам в
текущей группе.

ИЛИ

Выберите Insert theme on current page only («Вставить тему только на текущей
странице») , чтобы применить фон или тему только к текущей странице.

7. НажмитеOK.

Удаление фонового рисунка или темы:

1. Выполнитещелчок правой кнопкой на странице.

2. Выберите Remove Theme («Удалить тему»).

3. Выберите From All Pages («Со всех страниц») , чтобы удалить фон или тему со всех
страниц, к которым они была применены.

ИЛИ

Выберите From Page («Со страницы») , чтобы удалить фон или тему только с
выбранной страницы.

Создание тем
Вы можете использовать темы для настройки страниц. Вы можете создать тему и добавить
ее в галерею, чтобы она находилась в удобном для вас месте. Затем вы можете применить
эту тему к странице, ко всем страницам группы или ко всем страницам файла.

В галерее также содержится несколько тем.

Создание темы

1. Выберите Format > Theme > Create New Theme («Формат» > «Тема» > «Создать
новую тему».

2. Введите название темы в полеTheme name («Название темы»).

3. Задайтефон таким же образом, как для страницы (см. Применениефонов и тем к
страницам на странице 128).
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4. Добавьте и отредактируйте объекты темы таким же образом, как это делается на
странице (см. Chapter 4: Создание основных объектов на странице 31).

5. Нажмите «Сохранить».

Тема отобразится в категорииMy Content («Мое содержимое») галереи.

Создание темы на основе текущей страницы

1. Выберите Format > Theme > Create New Theme From Page («Формат» > «Тема» >
«Создать тему на основе страницы»).

2. Введите название темы в полеTheme name («Название темы»).

3. Нажмите «Сохранить».

Тема отобразится в категорииMy Content («Мое содержимое») галереи.

Создание примеров учебных заданий
В этом разделе представлены методы создания учебных занятий с использованием
примеров и содержатся сведения о том, как создавать другие типы учебных занятий.

Создание учебного задания на соответствие

NOTE

Для создания учебных занятий на соответствия нужно уметь:

l Использование конструктора занятий

l Добавление звуков к объектам (см. Добавление звуков к объектам на странице 123)

Конструктор занятий позволяет создавать задания на соответствие, классификацию,
перетаскивание меток, игры и другие занятия с использованием собственных материалов.

Используя Конструктор занятий, можно сделать один из объектов на странице объектом
задания. После чего нужно будет определить, какие из объектов на странице будут
приниматься при перетаскивании на объект задания, а какие — отклоняться.

Создание учебного задания на соответствие:

1. Создайте объект, который хотите использовать как объект задания, а затем создайте
объекты, которые будут приниматься или отклоняться при перетаскивании на уже
созданный объект задания.
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2. Нажмите Add-ons («Надстройки») , затем выберите Activity Builder («Конструктор

занятий»).

3. Выберите объект, который хотите использовать как объект задания, затем нажмите Edit
(«Правка»).

4. Перетащите в список Accept these objects («Принять эти объекты») объекты, которые
будут приняты.

Рядом с объектами, которые будут приняты, появится значок зеленой галочки .

5. Перетащите в список Reject these objects («Отклонить эти объекты») объекты, которые
будут отклонены.

Рядом с объектами, которые будут отклонены, появится значок красного крестика .

NOTES

o Для быстрого выбора и добавления всех оставшихся объектов на странице в
список принимаемых или отклоняемых объектов нажмите всоответствующем
спискеAdd All Remaining («Добавить все оставшиеся»).

o Для удаления объекта из списка перетащите его на значок корзины .

6. Нажмите «Готово».

Изменение настроек учебного задания на соответствие:

1. Нажмите Add-ons («Надстройки») , затем выберите Activity Builder («Конструктор

занятий»).

2. Выберите объект задания, затем нажмите Edit («Правка»).

TIP

Если не знаете, какой из объектов на странице является объектом задания, нажмите
Identify («Идентификация»). На экране поверх каждого объекта задания на странице
появятся диагональные линии синего цвета, которые исчезнут через три секунды.

3. Нажмите кнопку Settings («Настройки»).

4. Выберите нужный вариант анимации для принимаемых объектов в первом выпадающем
списке Animation («Анимация»).

5. Дополнительно можно установить флажок Also play the object’s sound («Также
воспроизвести звуковое сопровождение объекта») , чтобы при перетаскивании
принимаемого объекта на объект-задание воспроизводить включенное в этот объект
звуковое сопровождение (см. Добавление звуков к объектам на странице 123).



CHAPTER 7
СОЗДАНИЕ УЧЕБНЫХ ЗАДАНИЙ

135

6. Выберите нужный вариант анимации для отклоняемых объектов в первом выпадающем
спискеAnimation («Анимация»).

7. Дополнительно можно установить флажок Also play the object’s sound («Также
воспроизвести звуковое сопровождение объекта») , чтобы при перетаскивании
отклоняемого объекта на объект задания воспроизводить включенное в этот объект
звуковое сопровождение (см. Добавление звуков к объектам на странице 123).

8. Нажмите «Готово».

Презентация учебного задания на соответствие:

1. Перетащите объекты на объект задания (или попросите учащихся сделать это).

o В случае принятия объекта будет воспроизведена анимация для принятых объектов
(по умолчанию исчезновение).

o В случае отклонения объекта будет воспроизведена анимация для отклоненных
объектов (по умолчанию возврат назад).

2. Когда будете готовы, нажмите Add-ons («Надстройки») , затем Activity Builder

(«Конструктор занятий»), а после Reset All («Сбросить все»).

Удаление учебного задания на соответствие:

1. Нажмите Add-ons («Надстройки») , затем выберите Activity Builder («Конструктор

занятий»).

2. Выберите объект задания, затем нажмите Clear Properties («Очистить свойства»).

Создание учебных занятий типа «скрыть/показать»

NOTE

Следующие задачи необходимо выполнить при создании учебных занятий типа
«скрыть/показать»:

l Перемещение объектов (см. Перемещение объектов на странице 71)

l Блокировка объектов (см. LockingObjects.htm)

l Изменение размера объектов с помощью жеста масштабирования (см. Использование
жеста масштабирования на странице 80)
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Можно скрыть объект, затем постепенно отобразить его с помощью следующих способов:

l Добавьте на страницу затенение экрана. В ходе презентации постепенно удаляйте
затенение, открывая текст и графику по мере готовности к их обсуждению (см.
UsingTheScreenShade.htm).

l Закрывайте объекты слоем цифровых чернил, а затем стирайте чернила (см.
Написание, рисование и стирание цифровых чернил на странице 32).

l Закрывайте объекты другими объектами, а затем изменяйте порядок расположения
объектов в стеке (см. Изменение порядка объектов в стеке на странице 75).

l Используйте анимацию объектов (см. Добавление анимации к объектам на
странице 125).

Или можно скрыть объект за заблокированным объектом, затем с помощью жеста
масштабирования увеличить и показать скрытый объект, если вы работаете с
интерактивным продуктом SMART, который поддерживает множественные касания.

Создание учебного занятия типа «скрыть/показать»:

1. Создайте или вставьте объект, который нужно скрыть.
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2. Создайте или вставьте объект, который нужно заблокировать.

3. Переместите объект, который нужно заблокировать, так, чтобы он находился поверх
объекта, который нужно скрыть.

4. Выберите объект, который нужно заблокировать, нажмите стрелку его меню и выберите
Locking > Lock in Place («Блокировать» > «Блокировать на месте»).
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5. Используйте жест масштабирования для увеличения и отображения скрытого объекта
при блокировке объекта на месте (см. Использование жеста масштабирования на
странице 80).

Создание учебного задания на постепенное открытие

NOTE

Для создания учебных занятий на постепенное открытие нужно уметь:

l Создание таблиц (см. Создание таблиц на странице 49)

l Изменение размеров ячеек (см. Изменение размеров таблиц, столбцов или строк на
странице 58)

l Установка изображения в качествефона таблицы (см. Изменение свойств таблицы на
странице 54)

l Добавление объектов в ячейки (см. Добавление объектов в таблицы на странице 51)

l Добавление и удаление затенения ячеек (см. Использование затенения ячеек на
странице 182)

Таблицы и затенения ячеек можно использовать для создания различных учебных занятий
на постепенное открытие. Два примера таких занятий:

l Учебное занятие на постепенное открытие типа «Составная картинка», когда учитель по
очереди открывает части изображения до тех пор, пока учащиеся не догадаются, что
изображено на рисунке.
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l Учебное занятие на постепенное открытие типа «Парные картинки», когда учитель
открывает содержимое ячейки, а учащиеся по очереди выбирают другие ячейки, пытаясь
найти дубликат открытой картинки.

Создание учебного задания на постепенное открытие «Составная картинка»:

1. Создайте таблицу, содержащую столько ячеек, сколько нужно для учебного задания на
постепенное открытие (см. Создание таблиц на странице 49).

2. Измените размеры ячеек до подходящих (см. Изменение размеров таблиц, столбцов
или строк на странице 58).

3. Выделите таблицу, нажмите стрелку меню этой таблицы, затем выберите Properties
(«Свойства»).

Появится вкладкаProperties («Свойства»).

4. Нажмите кнопку «Эффекты заливки».

5. Выберите Image fill («Заливка изображением»), нажмите Browse («Обзор»),
выберите рисунок, который хотите использовать для создания занятия на постепенное
открытие, затем нажмитеOpen («Открыть»).

6. Выберите Scale image to fit («Масштабировать изображение по размеру»).

7. Нажмите на стрелку меню таблицы и выберите Add Table Shade («Добавить
затенение таблицы»).
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Создание учебного задания на постепенное открытие «Парные картинки»:

1. Добавьте объекты, которые хотите использовать в данном учебном занятии.

2. Создайте таблицу, содержащую столько ячеек, сколько нужно для учебного задания на
постепенное открытие (см. Создание таблиц на странице 49).

3. Измените размеры ячеек до подходящих (см. Изменение размеров таблиц, столбцов
или строк на странице 58).

4. Перетащите объекты в ячейки таблицы.

5. Нажмите на стрелку меню таблицы и выберите Add Table Shade («Добавить
затенение таблицы»).

Презентация учебного задания на постепенное открытие

Нажмите на затенение одной из ячеек, чтобы открыть содержимое этой ячейки.

Для скрытия содержимого ячейки за затенением нажмите в углу ячейки.

Создание других типов учебных заданий
Инструменты для учебных заданий и примеры учебных заданий в галерее содержат
интерактивные объекты, которыеможно использовать для создания учебных заданий.
Подробные сведения об инструментах для учебных заданий, примерах учебных заданий и
галерее в целом см. в разделе Вставка материалов из Галереи на странице 88.

Веб-сайт SMART Exchange содержит тысячи учебных планов, наборов вопросов и прочего
содержимого, которое можно загрузить на свой компьютер, а потом открыть в
SMART Notebook. Для более подробной информации о веб-сайте SMART Exchange см.
страницу Вставка содержимого с веб-сайта SMART Exchange на странице 91.
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Создание занятий с помощью конструктора
учебных занятий (LAB)
С помощью конструктора учебных занятий улучшайте уроки, создавая и добавляя в них
интерактивные занятия. Такие занятия помогают учащимся запоминать понятия ифакты,
определять объекты, изучать словарные определения и многое другое.

Выберите один из видов заданий:

Задание на переворачивание карточек

В задании на переворачивание карточек учащиеся переворачивают карточки (аналогично
дидактическим карточкам). Вы можете добавлять текст или изображения как на лицевую,
так и на обратную сторону карточки. Учащиеся переворачивают карточки по одной, открывая
содержимое на обратной стороне. Задание на переворачивание карточек развивает память и
закрепляет знания. Для создания задания на переворачивание карточек см. Добавление
задания на переворачивание карточек на противоположной странице.

Задание суперсортировки

В задании суперсортировки учащиеся должны рассортировать предметы по категориям.
Категории сортировки — это группы, в которые учащиеся будут перемещать элементы для
сортировки. Элементы сортировки — это слова или термины, которые студенты должны
переместить в категории сортировки. Вы задаете категории и их содержимое, а затем
оцениваете знание учащимися каждой категории и элементов, которые в нее входят. Для
создания задания суперсортировки см. Добавление суперсортировки на странице 145.

Задание «Найди соответствие!»

В задании «Найди соответствие!» учащиеся сопоставляют элементы на одной стороне доски
с элементами на другой стороне, перетаскивая их. Это невероятно увлекательное занятие
очень легко настроить! Чтобы приступить к составлению задания «Найди соответствие!» см.
Добавление задания «Найдите соответствие» на странице 149.

Задание «Заполните пропуски»

В задании «Заполните пропуски» учащиеся перетаскивают пропущенное содержимое, чтобы
получить грамматически правильные предложения или определить части речи. См. раздел
Добавление задания на заполнение пропусков на странице 147.

Задание на сортировку



CHAPTER 8
ИСПОЛЬЗОВАНИЕ КОНСТРУКТОРА УЧЕБНЫХ ЗАНЯТИЙ (LAB)

143

Учащиеся выполняют задание на порядок сортировки, играя сортируя элементы указанным
вами образом. Попробуйте сортировать целые числа от меньшего к большему, этапы
процесса по порядку или другие элементы в желаемой последовательности. См. Добавление
задания на сортировку на странице 151.

Задание «Кричи!» для мобильных устройств

«Кричи!» — это инструмент создания материалов, с которым учащиеся и учителя могут
работать в конструкторе учебных занятий (LAB). С помощью своих устройств учащиеся могут
быстро создавать и отправлять изображения и тексты в занятия LAB, а учителя могут легко
проверять материалы. См. Добавление задания «Кричи!» на странице 153.

Добавление задания на переворачивание
карточек
Приформировании задания на переворачивание карточек можно создать сколько угодно
карточек, а также выбрать различные темы, например «Остров обезьян», «Джунгли», «Марс»
или «Луна».

Можно просмотреть задание в окнеAdd an Activity («Добавить занятие»).

Чтобы просмотреть занятие, выполните следующие действия:

1. Нажмите Preview this Activity («Просмотреть это занятие»).

Откроется окно Activity Preview («Предварительный просмотр задания») , в котором
будет указана подробная информация о задании.

2. Нажмите Cancel («Отмена»), чтобы закрыть окно, или Add this Activity («Добавить
занятие») , чтобы продолжить создание занятия.

Добавление задания на переворачивание карточек:

1. Откройте конструктор учебных занятий, нажав значок панели инструментов на

панели инструментов Notebook.

Откроется окно «Добавить занятие».

2. В окне Choose Design («Выбор дизайна») Template and Theme («Шаблон и тема»)
выберите тему для карточек: либо Flippin’ Monkeys («Переворачивающиеся
обезьянки») , либо Low gravity Flip Out («Переворот с низкой гравитацией»).
Нажмите на изображение нужного эскиза. Вокруг эскиза появится голубая рамка.
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3. Нажмите «Далее».

Откроется диалоговое окно Add content («Добавить содержимое»).

4. Нажмите на подсвеченные синим клетки под обратной и лицевой сторонами карточки и
начните печатать, чтобы добавить текст на обе стороны карточки, или же нажмите на
значок каталога, чтобы добавить изображение. См. Совет ниже.

Вы можете создать сколько угодно карточек. Если вы создадите более 12 карточек, то
дополнительные будут находиться в середине рабочего стола Notebook, рядом с
колодой отбоя.

Расположение карт выбирается наугад.

Можно скопировать или перетащить элементы, связанные с категорией, или добавить
материалы в категорию из заранее сохраненного списка. Дополнительные сведения о
добавлении материалов см. в разделе Управление материалами в конструкторе
учебных занятий на странице 165.

Также можно посмотреть, сколько карточек вы создали.

TIP

Чтобы использовать изображение в занятии на переворачивание карточек, нажмите на
значок каталога в любом списке материалов. Выберите изображение в нужном
каталоге проводникаWindows, нажав Open («Открыть»). Изображение появится в
списке для обратной стороны или лицевой стороны , а также на самих картах.

5. Нажмите «Далее».

Появится диалоговое окно Add game components («Добавить игровые компоненты») . При
необходимости можно выбрать один из игровых компонентов. См. Добавление игровых
компонентов в занятия на странице 163.

6. Нажмите «Готово». LAB создаст занятие, которое будет готово к работе через пару
секунд.
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7. Учащиеся переворачивают карты и открывают содержимое на обратной стороне.
Например, на обратной стороне карты может быть написано «бежать», а на лицевой —
«глагол». После того, как карта была перевернута и вы обсудили ее содержание, карту
можно убрать в колоду сброса.

TIPS

o Перемещаться по конструктору учебных занятий можно, нажимая на кнопки
навигации в верхней части мастера создания занятий.

o Можно просмотреть задание в меню Add an Activity («Добавить занятие»).

Нажмите Preview this Activity («Просмотреть это занятие») , чтобы открыть
предварительный просмотрзадания на переворачивание карточек.
Предварительный просмотр позволит вам узнать о выбранном задании
дополнительную информацию.

Нажмите Cancel («Отмена»), чтобы закрыть окно, или Add this Activity
(«Добавить занятие») , чтобы продолжить создание занятия.

o Нажмите на кнопку Activity Restart («Сброс занятия») , чтобы сбросить

текущее занятие. Эта кнопка расположена в верхнем правом углу открытой
страницы занятия LAB.

o Нажмите на кнопку Activity Edit («Редактировать занятие») , чтобы

открыть окно Add an Activity («Добавить занятие»).Эта кнопка расположена в
верхнем правом углу открытой страницы занятия LAB.

Добавление суперсортировки
В задании суперсортировки учащиеся должны рассортировать элементы в одну или две
категории. Элементы пропадают, если учащийся помещает их в правильную категорию, и
появляются снова в противном случае. Чтобы занятие стало более увлекательным, добавьте
дополнительные игровые компоненты.

Можно просмотреть задание в окнеAdd an Activity («Добавить занятие»).
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Чтобы просмотреть занятие, выполните следующие действия:

1. Нажмите Preview this Activity («Просмотреть это занятие»).

Откроется окно Activity Preview («Предварительный просмотр задания») , в котором
будет указана подробная информация о задании.

2. Нажмите Cancel («Отмена»), чтобы закрыть окно, или Add this Activity («Добавить
занятие») , чтобы продолжить создание занятия.

Чтобы добавить задание на суперсортировку, выполните следующие действия:

1. Чтобы открыть конструктор учебных занятий, нажмите значок панели инструментов

на панели инструментов Notebook. Откроется окно Add an activity («Добавить

занятие»).

2. Найдите в нем задание суперсортировки и нажмите Add this Activity («Добавить
занятие»).

Откроется окно Choose design («Выберите дизайн») Template and Theme («Шаблон и
тема») .

3. Выберите одну из тем суперсортировки, например, «Джунгли» или «Сортировка в
космосе» . Выбранное задание будет подсвечено синим.

4. Нажмите Next («Далее»).

Откроется окно Add an Activity («Добавить занятие») Add Content («Добавить
содержимое») .

5. В поле «Название категории» укажите название, которое будет использоваться для
данной категории.

6. Напишите названия материалов в категории, скопируйте или перетащите элементы
категории или отредактируйте их в полеCategory Content («Материалы
категории»).Также можно добавить материалы категории из ранее сохраненного списка
или вставить их из таблицы Excel® или текстового документа. Дополнительные
сведения о добавлении материалов см. в разделе Управление материалами в
конструкторе учебных занятий на странице 165.

7. Повторите те же действия для категории справа.

8. Нажмите «Далее». Появится диалоговое окно «Добавить игровые компоненты». При
необходимости можно выбрать один из игровых компонентов. См. Добавление игровых
компонентов в занятия на странице 163.

9. Нажмите «Готово».

LAB создаст занятие, которое будет готово к работе через пару секунд.
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TIPS

l Перемещаться по конструктору учебных занятий можно с помощью кнопок навигации

в верхней части мастера создания занятий.

l Можно просмотреть задание в меню Add an Activity («Добавить занятие»).

Нажмите Preview this Activity («Просмотреть это занятие») , чтобы открыть
предварительный просмотрзадания суперсортировки. Предварительный просмотр
позволит вам узнать о выбранном задании дополнительную информацию.

Нажмите Cancel («Отмена»), чтобы закрыть окно, или Add this Activity («Добавить
занятие») , чтобы продолжить создание занятия.

l Используйте кнопку «Сброс занятия» , чтобы сбросить текущее занятие. Эта

кнопка расположена в верхнем правом углу страницы занятия LAB.

l Нажмите на кнопку Activity Edit («Редактировать занятие») , чтобы открыть

окно Add an Activity («Добавить занятие»).Эта кнопка расположена в верхнем правом
углу страницы занятия LAB.

Добавление задания на заполнение
пропусков
«Заполните пропуски» — это веселое задание, в котором учащимся нужно вставить
пропущенную информацию на место. Напишите предложение, укажите до десяти пропусков,
и пусть учащиеся перетаскивают слова на правильныеместа.

Можно просмотреть задание в окнеAdd an Activity («Добавить занятие»).

Чтобы просмотреть занятие, выполните следующие действия:

1. Нажмите Preview this Activity («Просмотреть это занятие»).

Откроется диалоговое окно Activity Preview («Просмотр занятия») «Заполните пропуски».
В этом окне будет указана подробная информация о задании.

2. Нажмите Cancel («Отмена»), чтобы закрыть окно, или Add this Activity («Добавить
занятие») , чтобы продолжить создание занятия.
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Добавление задания «Заполните пропуски»:

1. Откройте конструктор учебных занятий, нажав значок панели инструментов LAB

на панели инструментов Notebook.

Откроется окно «Добавить занятие».

2. Найдите в нем задание «Заполните пропуски» и нажмите Add this Activity («Добавить
занятие»).

Откроется страница Choose Design («Выберите дизайн»)в окнеAdd an Activity («Добавить
занятие»).

Выберите тему, нажав на нее. желаемую тему. Вокруг выбранной темы появится
голубая рамка.

3. Нажмите «Далее».

Откроется диалоговое окно Add Content («Добавить содержимое») .

Введите текст в области Edit Content («Редактировать материалы»).Можно использовать
до 300 символов.Счетчик указывает, сколько осталось символов.Пропуски вы укажете
на следующем шаге.

4. Нажмите Define Blank Spaces («Определить пропуски»).

Появится диалоговое окно Add Blank Spaces («Добавить пропуски»).

5. В написанном вами тексте нажимайте на слова, на месте которых будут пропуски, или
перетаскивайте на них рамку пропуска снизу задания. Можно пропускать только части

слов, перетаскивая синие ручки рамки.

Вокруг текста, который вы выбрали в качестве пропуска, появится прозрачная голубая
рамка.

6. Когда вы выберете пропуски вместо нужных слов, нажмите Next («Далее»).

Появится диалоговое окно Add game components («Добавить игровые компоненты») . При
необходимости можно выбрать один из игровых компонентов. См. Добавление игровых
компонентов в занятия на странице 163.

7. Нажмите «Готово».

Конструктор учебных занятий создаст занятие, которое будет готово к работе через пару
секунд. Появится предложение с пропусками вместо некоторых слов.

8. Учащиеся должны перетаскивать слова на подходящие пропуски в предложении.
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9. Нажмите кнопку Check answers («Проверить ответы») , которая появится при
завершении задания.

Около заполненных пропусков будут появляться галочки или крестики, обозначая,
соответственно, правильные и неправильные ответы. Ответы можно исправлять, меняя
местами.

Добавление задания «Найдите
соответствие»
Учащиеся выполняют анимированное занятие «Найди соответствие!», чтобы перетаскивая
соответствующие элементы в подводный резервуар в задании «Увлекательный поиск
соответствий», или в лабораторные пробирки в задании «Соответствующие пробирки».
Чтобы занятие стало более увлекательным, добавьте игровые компоненты.

Чтобы просмотреть занятие, выполните следующие действия:

1. Нажмите Preview this Activity («Просмотреть это занятие»).

Откроется диалоговое окно Activity Preview («Просмотр занятия») «Найди
соответствия!». В этом окне будет указана подробная информация о задании.

2. Нажмите Cancel («Отмена»), чтобы закрыть окно, или Add this Activity («Добавить
занятие») , чтобы продолжить создание занятия.

Добавление задания «Найдите соответствие»:

1. Откройте конструктор учебных занятий, нажав значок панели инструментов на

панели инструментов Notebook.

Откроется окно «Добавить занятие».

2. Найдите в нем задание «Найди соответствие!» и нажмите Add this Activity («Добавить
занятие»).

3. В разделе Template and Theme («Шаблон и тема») выберите ImmersiveMatching
(«Увлекательный поиск соответствий») илиMatching Beakers («Соответствующие
пробирки») . Вокруг выбранной темы появится голубая рамка.
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4. В разделе Answers («Ответы») в пункте Check matches («Проверка соответствий»)
выберите Check answers right away («Проверять ответы немедленно») , чтобы сразу
же отклонять неправильные ответы, или Check answers after students have finished
(«Проверить ответы, как только учащиеся завершат работу») , чтобы отклонять
неправильные ответы в конце задания.

5. Нажмите Next («Далее») , чтобы перейти на страницу Add Content («Добавить
содержимое») .

6. В полях Category Name («Название категории») укажите названия, которые будут
использоваться для каждой категории.

7. Напишите названия материалов в категории, скопируйте или перетащите элементы
категории или отредактируйте их в полеCategory Content («Материалы
категории»).Также можно добавить материалы категории из ранее сохраненного списка
или вставить их из таблицы или текстового документа.Дополнительные сведения о
добавлении материала см. в разделе Управление материалами в конструкторе учебных
занятий на странице 165.

TIP

Чтобы использовать в занятии изображение, нажмите на значок каталога в любом
списке материалов. Найдите и выделите изображение, затем нажмитеOpen
(«Открыть»). Изображение появится в списке материалов. Несмотря на то, что можно
создать любое количество элементов, в занятии будут использованы только первые
10 из них. Создайте не менее двух пар соответствий, чтобы продолжить.

8. Повторите те же действия для категории справа.

9. Нажмите «Далее».

Появится диалоговое окно Add game components («Добавить игровые компоненты») . При
необходимости можно выбрать один из игровых компонентов. См. Добавление игровых
компонентов в занятия на странице 163.
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10. Нажмите «Готово».

Конструктор учебных занятий создаст занятие, которое будет готово к работе через пару
секунд.

TIPS

o Перемещаться по конструктору учебных занятий можно, нажимая на кнопки
навигации в верхней части мастера создания занятий.

o Можно просмотреть задание в меню Add an Activity («Добавить занятие»).

Нажмите Preview this Activity («Просмотреть это занятие»). Откроется окно
предварительного просмотра задания, в котором будет указана подробная
информация о задании.

Нажмите Cancel («Отмена»), чтобы закрыть окно, или Add this Activity
(«Добавить занятие») , чтобы продолжить создание занятия.

o Нажмите на кнопку Activity Restart («Сброс занятия») , чтобы сбросить

текущее занятие. Эта кнопка расположена в верхнем правом углу открытой
страницы занятия LAB.

o Нажмите на кнопку Activity Edit («Редактировать занятие») , чтобы

открыть окно Add an Activity («Добавить занятие»).Эта кнопка расположена в
верхнем правом углу открытой страницы занятия LAB.

Добавление задания на сортировку
В задании на порядок сортировки учащиеся расставляют элементы по порядку исходя из
ваших указаний. Попробуйте расставить целые числа от меньшего к большему, этапы
научного алгоритма по порядку или другие элементы в желаемой последовательности.

Можно просмотреть задание в окнеAdd an Activity («Добавить занятие»).

Чтобы просмотреть занятие, выполните следующие действия:

1. Нажмите Preview this Activity («Просмотреть это занятие»).

Откроется диалоговое окно Activity Preview («Просмотр занятия») на порядок
сортировки. В этом окне будет указана подробная информация о задании.
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2. Нажмите Cancel («Отмена»), чтобы закрыть окно, или Add this Activity («Добавить
занятие») , чтобы продолжить создание занятия.

Добавление задания на сортировку:

1. Откройте конструктор учебных занятий, нажав значок панели инструментов LAB

на панели инструментов Notebook.

Откроется окно «Добавить занятие».

2. Найдите в нем задание на порядок сортировки и нажмите Add this Activity («Добавить
занятие»).

3. Выберите нужную тему в разделе Template and Theme («Шаблон и тема»).Вокруг
выбранной темы появится голубая рамка.

4. В разделе Answers («Ответы») нажмите Correct/Incorrect («Верно/Неверно») , чтобы
расстановка материалов оценивалась, или выберите Preference («По желанию») ,
чтобы учащиеся расставляли элементы по собственному желанию.

5. В разделе Answers («Ответы») выберите Check answers right away («Проверять
ответы немедленно») , чтобы проверить ответы, как только элементы будут
рассортированы, или Check answers after students have finished («Проверить ответы,
как только учащиеся завершат работу») , чтобы проверить ответы в конце занятия.

6. Нажмите Next («Далее»). Откроется диалоговое окно Add Content («Добавить
содержимое») .

7. В диалоговом окне Item order («Сортировка элементов») укажите нужный порядок
сортировки. Можно выбрать First→ Last («Первый»→ «Последний»), Smallest→
Biggest («Меньший»→ «Больший»), Highest→ Lowest («Наибольший» →

«Наименьший»)или Custom («Порядок пользователя»).

Если вы выбралиCustom («Порядок пользователя»), укажите условия сортировки,
например «Высокий» и «Низкий».

Если вы хотите поменять порядок, сначала выберите нужный, например First→ Last
(«Первый»→ «Последний»), а затем нажмите «Поменять порядок». Порядок станет
таким: Last→First («Последний»→ «Первый»).

8. Укажите элементы, которые нужно будет отсортировать.

Несмотря на то, что можно создать любое количество элементов, в занятии будут
использоваться только первые 10 из них.
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9. TIP

Чтобы использовать в занятии изображение, нажмите на значок каталога в списке
материалов. Найдите и выделитефайл, затем нажмитеOpen («Открыть»).
Изображение появится в списке материалов. Создайте не менее двух элементов,
чтобы продолжить.

10. Нажмите «Далее».

Появится диалоговое окно Add game components («Добавить игровые компоненты») . При
необходимости можно выбрать один из игровых компонентов. См. Добавление игровых
компонентов в занятия на странице 163.

11. Нажмите «Готово».

Конструктор учебных занятий создаст занятие, которое будет готово к работе через пару
секунд.

12. Учащиеся должны перетаскивать элементы в правильном порядке (сверху вниз). Если
сортировка выполнена правильно, элементы начнут слегка двигаться.

TIP

Около каждого ответа появится зеленая галочка или красный крестик, обозначая,
соответственно, правильный и неправильный ответы. До тех пор, пока все ответы не станут
правильными, их можно менять местами.

Если вы выбралиCheck answers right away («Проверять ответы немедленно»), то они
будут проверяться сразу после получения. Верные ответы будут приняты, а неверные —
отклонены.

Если вы выбралиCheck answers after students have finished («Проверить ответы, как
только учащиеся завершат работу»), то проверка ответов произойдет после того, как
учащиеся ответят на все вопросы, что позволит дольше обсуждать вопросы.

Добавление задания «Кричи!»
С помощью веб-браузеров своих устройств учащиеся могут быстро создавать и отправлять
изображения и тексты в занятия создания материалов LAB, а учителя могут легко проверять
материалы.

Чтобы получить наилучшие впечатления от работы с заданием «Кричи!» см. Рекомендуемые
параметры систем, устройств, браузеров и операционных систем на странице 160.
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IMPORTANT

Если вы используете пробную версию программного обеспечения SMART Notebook для
совместного обучения, может появиться уведомление reCaptcha. Для работы с заданием
«Кричи!» необходимо подтвердить пробную версию. Более подробную информацию см. в
разделе Подтверждение пользователя в задании «Кричи!» на противоположной странице.

Можно просмотреть задание в окнеAdd an Activity («Добавить занятие»).

Чтобы просмотреть занятие, выполните следующие действия:

Нажмите Preview this Activity («Просмотреть это занятие»), и откроется диалоговое
окно Activity Preview («Просмотр задания «Кричи!») . В этом окне будет указана
подробная информация о задании.

Нажмите Cancel («Отмена») , чтобы закрыть окно, или Add this Activity («Добавить
занятие») , чтобы продолжить создание занятия.

Добавление задания «Кричи!»:

1. Откройте конструктор учебных занятий, нажав значок панели инструментов на

панели инструментов Notebook. Откроется окно Add an Activity («Добавить занятие») .

2. Найдите в нем задание «Кричи!» и нажмите Add this Activity («Добавить занятие»).

Откроется страница Choose design («Выберите дизайн»)для задания «Кричи!».Выберите
тему.Можно выбрать либо темуArranged Randomly («Произвольно»), либо тему
Categorized («По категориям»).

3. Нажмите кнопку Next («Далее»).

Откроется страница Add content («Добавить содержимое») . Если ранее вы выбрали
вариант «По категориям» , то потребуется создать минимум две категории.

В поле Contribution Categories («Категории загруженных материалов»)укажите названия
для категорий, в которых будут находиться отправленные учащимися материалы.

В поле Acceptable Contributions («Допустимыематериалы»)выберите тип материалов:
Text («Текст») или Images («Изображения»).

4. Укажите максимально допустимое количество загружаемых с одного устройства
текстов или изображений.

5. НажмитеOff («Выключить») илиOn («Включить») под надписью Display contributor
names («Показывать имя отправителя») , чтобы отобразитьть или скрыть имя
отправителя.
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6. Нажмите Next («Далее»). Появится диалоговое окно Add game components («Добавить
игровые компоненты») . При необходимости можно выбрать один из игровых
компонентов. См. Добавление игровых компонентов в занятия на странице 163.

7. Нажмите «Готово».

Конструктор учебных занятий создаст занятие, которое будет готово к работе через пару
секунд. Чтобы начать выполнение задания и позволить учащимся добавлять
материалы, см. Добавление материалов учащихся в задание «Кричи!» на следующей
странице.

Запуск задания «Кричи!»:

1. После создания задания «Кричи!» необходимо подтвердить, что параметры Display
Contributor Names («Отображать имена пользователей, выполнивших загрузку») и
Contributions per Device («Количество загрузок с одного устройства») выбраны
правильно.

2. Нажмите Start Activity («Начать занятие»).

Появится окно LAB Student Contribution Activity («Загрузка материалов учащимися в
LAB»). Оно включает в себя URL-адрес, который учащиеся должны указать в своих
браузерах, и созданный идентификационный номер занятия, который учащиеся укажут

на веб-сайте конструктора учебных занятий SMART Notebook. Значок занятия

станет зеленым. Это значит, что занятие в настоящиймомент запущено.

3. Учащиеся должны будут перейти на страницу classlab.com и ввести свои имена и
идентификационный номер занятия. Теперь студенты подключены к занятию.

Материалы, добавленные учащимися, появятся на странице конструктора учебных
занятий Notebook. См. Добавление материалов учащихся в задание «Кричи!» на
следующей странице.

NOTE

Чтобы удалить добавленныйматериал, перетащите его в мусорную корзину слева вверху
страницы конструктора учебных занятий. Удаленныйматериал нельзя восстановить.

Подтверждение пользователя в задании «Кричи!»
Если вы используете пробную версию программного обеспечения SMART Notebook для
совместного обучения, при первом запуске задания «Кричи!» в конструкторе учебных
занятий может появиться уведомление reCaptcha.
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Если вы увидели это уведомление, то перед использованием задания «Кричи!» нужно
подтвердить пробную версию. После регистрации в качестве пробного пользователя вы
больше не будете получать уведомления reCaptcha.

Подтверждение пользователя пробной версии:

1. Если вы увидели уведомление reCaptcha в диалоговом окне LAB Student Contribution
Activity («Задание LAB с добавлением материалов учащихся») , установитефлажок I’m
not a robot («Я не робот») .

Появится изображение с вопросом.

2. Ответьте на вопрос и нажмите Verify («Проверить»).

Если вы ответили правильно, то появится зеленая галочка в поле I’m not a robot («Я не
робот») .

3. Нажмите Start Activity («Запустить задание») , чтобы начать работу с заданием
«Кричи!». См. Добавление задания «Кричи!» на странице 153.

Добавление материалов учащихся в задание «Кричи!»
Учащимся очень понравится загружать материалы в задания конструктора учебных занятий.
Онимогут добавлять текст или изображения, в зависимости от требований задания.
Учащиеся могут распределять элементы по категориям или загружать материалы и
обсуждать их.

Добавление текстовых материалов учащихся

После того, как учащиеся войдут в занятие с помощью диалогового окна LAB Student
Contribution Activity («Загрузка материалов учащимися в LAB») в браузерах своих
компьютеров или мобильных устройств, откроется окно Activity response («Ответ») .

1. Теперь учащиеся могут ввести ответ в текстовое окно. Учащийся может написать в окне
до 150 символов (включая пробелы), и может давать ответы столько раз, сколько
скажет учитель.
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Если ранее вы выбрали вариант «По категориям» , то в текстовом окне также будет
находиться меню категорий.

После написания ответов учащиеся выбирают категорию, в которую они хотят добавить
ответ, из выпадающего менюSelect a category («Выберите категорию»).
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2. Учащиеся должны нажать Send Response («Отправить ответ») , чтобы отправить
ответы на страницу конструктора учебных занятий Notebook.

Материалы, добавленные учащимися, появятся на странице занятия в конструкторе
учебных занятий Notebook.

При выбранном виде Categorized («По категориям») , нажмите , чтобы сократить

работу окна идентификации и просмотреть загруженныематериалы, которые появятся в

правой части страницы занятия. Нажмите , чтобы заново открыть окно.

Добавление изображений, загружаемых учащимися

1. После того, как учащиеся войдут в занятие с помощью диалогового окна LAB Student
Contribution Activity («Загрузка материалов учащимися в LAB») , откроется окно Activity
response («Ответ») .
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2. Учащийся нажимает Select an image («Выбрать изображение»).

Откроется файловыйменеджер устройства.

3. Выделите изображение и нажмитеOpen («Открыть»).

Как и в случае с текстовымиматериалами, загруженные изображения появятся на
странице конструктора учебных занятий Notebook.

Чтобы увеличить загруженное изображение, учитель может нажать на него на странице
Notebook.

Чтобы изображение вернулось к изначальному размеру, нажмите вне увеличенного
изображения или нажмите на крестик в его правом верхнем углу.

NOTE

Чтобы удалить добавленныйматериал, перетащите его в мусорную корзину слева вверху
страницы конструктора учебных занятий. Удаленныйматериал нельзя восстановить.

4. Чтобы покинуть задание, учащемуся нужно нажать на символ выхода из приложения в

браузере своего устройства .

Управление заданием «Кричи!»
Можно управлять сессией задания «Кричи!» следующим образом: перемещать загруженные
учащимися тексты и изображения по рабочему столу Notebook, приостанавливать загрузку
материалов и отключать отображение имени учащегося, загрузившего материалы. Кроме
того, задание можно сохранить и использовать позднее.

Перемещение текстов или изображений, добавленных учащимися:

1. Наведите стрелку курсора на объект на рабочем столе занятия в конструкторе учебных
занятий.

2. Нажмите левой кнопкой мыши на объект и перетащите его в другое место на странице.

Чтобы приостановить добавление материалов учащимися на рабочий стол Notebook
необходимо выполнить следующие действия:

1. Нажмите на синюю кнопку Pause Contributions («Приостановить добавление
материалов») в диалоговом окне LAB Student Contribution Activity («Загрузка
материалов учащимися в LAB»).

Кнопка станет зеленой и на ней появится надпись Resume («Продолжить»).
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Учащиеся увидят на своих компьютерах или устройствах сообщение Activity Paused
(«Занятие приостановлено»).

2. Снова нажмите на нее, чтобы продолжить выполнение задания.

Кнопка станет синей и на ней появится надпись Pause Contributions («Приостановить
добавление материалов»).

Сообщение Activity Paused («Занятие приостановлено») исчезнет, и можно продолжить
загрузку материалов.

Отображения/сокрытие имени учащегося, добавившего материал:

1. Нажмите на ползунок Off On («Выкл./Вкл.») около надписи Display Contributor Names
(«Отображать имена пользователей, выполнивших загрузку»).

2. [Введите второйшаг процедуры здесь.]

Завершение, сохранение и перезапуск задания «Кричи!»:

1. Нажмите End and Save («Завершить и сохранить») в диалоговом окне LAB Student
Contribution Activity («Загрузка материалов учащимися в LAB»).

Появится диалоговое окно Contribution for this activity has ended («Загрузка материалов
для этого занятия завершена») .

2. Нажмите Restart Activity («Возобновить занятие») , чтобы продолжить работу с тем же
занятием.

NOTE

Одновременно можно запускать только одно задание.

Рекомендуемые параметры систем, устройств, браузеров и
операционных систем
В данном разделе описаны устройства, веб-браузеры, операционные системы и пропускная
способность сети, работа с которыми позволит в полной мере воспользоваться всеми
функциями занятия «Кричи!» из конструктора учебных занятий. Также указаны версии
драйверов продукта SMART, обеспечивающих наилучшую работу с интерактивными
продуктами SMART, и список веб-сайтов, к которым должен иметься доступ для правильной
работы задания «Кричи!».
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NOTE

При работе с заданием «Кричи!» учащиеся могут проверить доступ к сайту на странице
http://classlab.com/connection/check.html.

Рекомендуемые устройства
l Любой ноутбук илиMacBook

l iPad 2 или более поздней версии

l iPad Air

l iPadmini

l Microsoft® Surface RT2 или Pro

l SamsungGalaxy Note (8" и 10")

l Google Nexus 2013 или более поздней версии (7" и 10")

l Любая версия Google Chromebook

IMPORTANT

В данныймомент использование задания «Кричи!» не поддерживают следующие
устройства:

o iPad 1 (1-е поколение)

o SamsungGalaxy Tab 3

Рекомендуемые мобильные устройства
l iPhone 5C - 8ГБ, MG2E2C/A

l iPhone 6 Plus - 16ГБ, MG9M2CL/A

l iPhone 4S - 16ГБ, MC924LL/A

l iPod touch - 16ГБ, A1421

l SamsungGalaxy S4 - 16ГБ, SGH-I337M

l SamsungGalaxy S5 - 16ГБ, SM-G900W8

l Nexus 5 - 16ГБ, - LG-D820

l Nexus 6 - 32ГБ, - XT1103

l Motorola moto g - 8ГБ, XT1032

l Nokia Lumia 635 -Windows phone, RM-975

l HTC Desire 510 - 8ГБ

http://classlab.com/connection/check.html
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Рекомендуемые веб-браузеры
l Google Chrome™ 30 или более поздней версии

l Safari 7 или более поздней версии

l Firefox® 40 или более поздней версии

l Firefox ESR

l Internet Explorer® 10 или более поздней версии

l Internet Explorer 11Metro

l NOTE

Устройства наОС Android™ должны использовать вместо версий Chrome или Firefox
для Android.

Рекомендуемые операционные системы
l Windows® 7 или более поздней версии

l OS X 10.8 или более поздней версии

l iOS 8 или более поздней версии

l Android™ 4.2 или более поздней версии

l Текущая версия операционной системы ChromeOS™

Рекомендуемые параметры сети
Приминимальных требованиях к характеристикам сети, задание «Кричи!» обеспечивает
плодотворную совместную работу. Рекомендуемая скорость передачи данных в сети только
для задания — 0,3Мбит/с на одно устройство. Если в вашейшколе регулярно используются
другие инструменты Web 2.0, убедитесь, что пропускная способность сети позволит работать
с заданием. Если «Кричи!» используется совместно с другими онлайн-ресурсами (например,
потоковой передачей медиа), требуется еще большая пропускная способность (в
зависимости от характера используемых ресурсов).

Необходимый доступ к веб-сайтам
Чтобы задание «Кричи!» работало правильно, внесите следующие адреса в список
разрешенных URL-адресов:

l https://www.classlab.com

l http://id.smarttech.com

l https://smart-labc-prod.firebaseio.com

l https://smart-labc-prod-001.firebaseio.com

l https://smart-labc-prod-002.firebaseio.com
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l https://smart-labc-prod-010.firebaseio.com

l https://content.smarttech-prod.com

l https://metric.smarttech-prod.com

l https://google.com

l http://google-analytics.com

l https://www.gstatic.com (used by Google to load reCAPTCHA)

Добавление игровых компонентов в занятия
Вы можете сделать задание более интересным и увлекательным для учащихся, используя
дополнительные игровые компоненты.

Игровые компоненты
Доступны пять различных игровых компонентов.

Таймер

Используйте таймер и отслеживайте продолжительность выполнения задания учащимися. В
диалоговом окне Timer («Таймер») можно выбрать отсчет 15 секунд, 30 секунд или 1 минуты
(обратный или прямой) , или жеможно самому указать время в минутах и секундах.

Игральные кости

Бросьте кубики, чтобы выбрать случайные числа. Выберите один или два кубика в
диалоговом окне Add Dice («Добавить кубик»).

Жребий
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Жребий позволяет произвольно выбрать учащихся или материалы занятия. Можно
использовать карточки, номера или списки учащихся. В диалоговом окне Hat Picker
(«Жребий») можно наугад выбрать обратные стороны карт или числа от 1 до 30. Также можно
наугад выбрать учащихся, указав их имена в поле Student List («Список учащихся»), или
использовать для этого заранее сохраненный список. Каждый элемент можно выбрать
только один раз.

Кнопка звукового сигнала

Учащиеся могут соревноваться за право быть следующим. Можно выбрать до четырех
кнопок звуковых сигналов в диалоговом окне Buzzer («Кнопка звуковых сигналов»).

Вращающийся барабан

Вращающееся колесо позволяет произвольно выбрать учащихся или материалы занятия.
Можно использовать карточки, номера или списки учащихся. В диалоговом окне Spinning
Wheel («Вращающееся колесо») можно выбрать генератор случайных чисел, чтобы наугад
выбрать обратные стороны карт или числа от 1 до 30. Можно добавить учащихся или
использовать для этого заранее сохраненный список учащихся. Каждый элемент можно
выбрать неограниченное число раз.

Чтобы добавить игровые компоненты в занятие, выполните следующие действия:

1. В диалоговом окне Add game components («Добавить игровые компоненты») нажмитеOn
(«Вкл.») рядом с любым игровым компонентом.

2. Выберите один из игровых компонентов.

3. Нажмите «Готово».

Конструктор учебных занятий создаст занятие, которое будет готово к работе через пару
секунд.
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Управление материалами в конструкторе
учебных занятий
Управлять материалами в категории конструктора учебных занятий очень просто.
Добавляйте в задания суперсортировки, порядка сортировки, «Найди соответствие!» и в
задание на переворачивание карточек новые элементы списков или добавляйте материалы
из заранее сохраненных списков.

Создание, редактирование и повторное использование списков материалов:

1.В окне конструктора учебных занятийManage Content Lists («Управление списками
материалов») нажмитеManage Content Lists («Управление списками материалов»).

Откроется диалоговое окноManage Content Lists («Управление спискамиматериалов») .

2. Нажмите Edit («Редактировать») рядом со списком, который нужно отредактировать.
Появится диалоговое окно Edit this list («Редактирование списка») .

3. Выберите один из следующих вариантов:

o Укажите в строке List name («Название списка») новое название списка.

o Редактировать List Content («Содержимое списка») , чтобы снова добавить
изображения, использовать или изменить ранее сохраненный список содержимого.

o Редактировать Student List («Список учащихся») , чтобы добавить ранее
сохраненный список учащихся.

4. Нажмите «Сохранить».

Выбор и добавление заранее сохраненных списков материалов для заданий:

l В занятии суперсортировки, в окнеAdd an Activity («Добавить занятие»)на страницеAdd
Content («Добавить содержимое»), нажмитеAdd from list («Добавить из списка»)в
пунктеCategory Content («Содержимое категории»), чтобы добавить заранее
сохраненный список в категории сортировки.Чтобы удалить заранее сохраненный
список, нажмитеClear («Очистить»).Чтобы сохранить новый список, нажмитеSave list
(«Сохранить список»).

l В занятии на переворачивание карточек, в окне Add an Activity («Добавить занятие»)на
страницеAdd Content («Добавить содержимое»), нажмитеAdd from list («Добавить из
списка»)в выпадающих спискахCard back («Задняя сторона карты»)илиCard face
(«Лицевая сторона карты»), чтобы добавить заранее сохраненный списокЧтобы удалить
заранее сохраненный список, нажмите Clear («Очистить»). Чтобы сохранить новый
список, нажмите Save list («Сохранить список»).



CHAPTER 8
ИСПОЛЬЗОВАНИЕ КОНСТРУКТОРА УЧЕБНЫХ ЗАНЯТИЙ (LAB)

166

l В занятии на порядок сортировки, в окне Add an Activity («Добавить занятие») на
странице Add Content («Добавить содержимое») , нажмите Lists («Списки») в пункте
Items to order («Элементы для сортировки»), чтобы добавить заранее сохраненный
список. Чтобы удалить заранее сохраненный список, нажмитеClear
(«Очистить»).Чтобы сохранить новый список, нажмитеSave list («Сохранить список»).

l В занятии «Найди соответствие!», в окне Add an Activity («Добавить занятие») на
странице Add Content («Добавить содержимое») , нажмите Lists («Списки») в пункте
Category Name (optional) («Название категории (необязательно)»), чтобы добавить
заранее сохраненный список. Чтобы удалить заранее сохраненный список, нажмите
Clear («Очистить»). Чтобы сохранить новый список, нажмите Save list («Сохранить
список»).

TIPS

l Можно добавить материалы из ранее сохраненной таблицы Excel®, выбрав и
скопировав нужные ячейки таблицы и вставив их в области Category content
(«Содержимое категории») диалогового окна Add content («Добавить содержимое») .

l Можно добавить материалы из ранее сохраненного текстового документа, выбрав в
нем и скопировав нужный текст и вставив его в области Category content («Содержимое
категории») диалогового окна Add content («Добавить содержимое») .
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Chapter 9: Работа с концептуальными
картами

Концептуальные карты стимулируют учащихся принимать более активное участие в занятии.
Для создания концептуальных карт можно использовать как стандартные взаимодействия,
так и специальные жесты для чернил.

Для начала работы с концептуальными картами см. Создание узлов концептуальных карт и
работа с ними выше.

Создание узлов концептуальных карт и
работа с ними

Чтобы создать корневой узел, выполните следующие действия:
Для начала работы откройте «Создание концептуальных карт» на панели инструментов.
Корневой узел появится автоматически. Далее можно добавить дополнительные узлы.

Чтобы создать корневой узел, выполните следующие действия:

1. Нажмите Start a new concept map («Создать новую концептуальную карту») в

меню Add-ons («Надстройки»).

Откроется корневой узел.

2. Чтобы редактировать текст, дважды нажмите на корневой узел. Нажмите Properties

(«Свойства») или Text («Текст») чтобы открыть меню Text («Текст»), в котором

можно выбрать размер, шрифт и цвет текста.
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Чтобы создать дополнительные узлы, выполните следующие действия:

1. Нажмите кнопку «+» в корневом узле. Появится новый узел и линия, соединяющая его с
корневым узлом.

2. Чтобы редактировать текст, дважды нажмите на узел.

Использование изображения в качестве узла

Чтобы использовать изображение в качестве узла, выполните следующие действия:

1. Откройте «Создание концептуальных карт» и перетащите либо скопируйте изображение,
чернила или текст на страницу Notebook.

2. С помощью маркера Notebook обведите изображение.

3. Изображение появится внутри узла. Переместите узел в любое место на странице
Notebook.
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4. Теперь с помощью маркера нарисуйте сплошную линию от нового узла к другому узлу.
Линия превращается в сегмент и соединяет два узла.

TIPS

o Используйте кнопки Undo («Отменить») и Redo («Восстановить») для

отмены или восстановления действия с концептуальной картой.
o При удалении корневого узла все другие узлы также будут удалены.
o Можно увеличивать и уменьшать размер узла, нажимая на маркер изменения

размера и перемещая его. См. Изменение размеров объектов на странице 80
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Chapter 10: Презентация учебных занятий и
упрощение совместного обучения

Подготовка перед презентацией 172
Настройка режима отображения страницы 173

Увеличение и уменьшение 173
Панорамирование страниц 174
Отображение страниц в режиме прозрачногофона 175
Отображение страниц в двухстраничном режиме 177
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объектов 184

Использование инструмента «Текстовое перо» 184
Написание текста инструментом «Текстовое перо» 184
Редактирование текста инструментом «Текстовое перо» 186

Добавление ссылок на инструменты для объектов 188
Использование инструмента «Стандартное перо» для создания исчезающих
объектов 190
Работа с блоками SMART 191

Операции с блоками SMART 191
Работа со средством записи SMART 192

Начало работы со средством записи SMART 193
Скрытие средства записи SMART 193
Изменение качества видео- и аудиозаписи 193
Изменениеформата видеофайлов записей 195
Изменение местоположения файла записи 196
Добавлениефилиграни к записям: 198
Запись действий 200
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Улучшение характеристик системы при записи 203
Уменьшение разрешения экрана и количества цветов 204
Отключение аппаратного ускорения 204
Предоставление общего доступа к записям 205

Работа с инструментами измерения 206
Работа с линейкой 206
Работа с транспортиром 208
Работа с транспортиром Геодрейек 211
Работа с циркулем 213

Очистка или сброс страниц после презентации 215
Очистка страниц 216
Сброс страниц 217

Режим двух пользователей при использовании интерактивной доски 218
Режим двух пользователей при использовании интерактивной доски SMART Board
серии D600 219
Режим двух пользователей при использовании интерактивной доски SMART Board
серии 800 219

Выбор инструментов 220

После создания учебных занятий в ПОSMART Notebook вы можете провести презентацию
этих учебных занятий для учащихся с помощью интерактивного продукта и презентационных
функций ПО.

Помимо презентаций учебных занятий вы такжеможете упростить совместное обучение
учащихся с помощью ПОSMART Notebook и интерактивных продуктов. Например, двое
учеников могут одновременно использовать интерактивную доску SMART Board серий D600
или 800.

Подготовка перед презентацией
Подготовив файлы *.notebook к презентации, сохраните их на CD- илиDVD-диске или на USB-
носителе. Это позволит начать презентацию файла при подключении USB-носителя или
загрузки CD илиDVD в компьютер, подключенный к интерактивному продукту. Можно также
открыть доступ к файлам из локальной сети, а затем просматривать их на интерактивном
продукте.

Далее необходимо подготовиться к презентации следующим образом:

l Настроить режим отображения страницы

l Проверить все ссылки в файле
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l Если в вашем классе есть несколько различных интерактивных продуктов переместите
окна на соответствующие экраны.

l Если в презентации присутствуют видео- или аудиофайлы, отрегулируйте уровень
громкости.

Настройка режима отображения страницы
Вы можете производить увеличение и уменьшение с помощью кнопки «Просмотр экранов»
или несколькими касаниями (если ваш интерактивный продукт поддерживает режим
нескольких касаний).

Кроме того, ПОSMART Notebook включает следующие режимы просмотра:

l Полноэкранный режим увеличивает область страницы до размеров интерактивного
экрана, скрывая строку заголовка, панель инструментов, панель задач и боковую
панель.

l Режим прозрачногофона позволяет видеть содержимое рабочего стола и окон,
расположенных за окном SMART Notebook, и продолжать работать с открытой
прозрачной страницей.

l Двухстраничный режим выводит на экран две страницы, расположенные рядом.

Увеличение и уменьшение
Вы можете производить увеличение и уменьшение с помощью кнопки «Просмотр экранов»
или несколькими касаниями (если ваш интерактивный продукт поддерживает режим
нескольких касаний).

Увеличение и уменьшение с помощью кнопки View Screens («Просмотр экранов»):

1. Нажмите кнопку View Screens («Просмотр экранов») .

2. Укажите коэффициент увеличения от 50% до 300%.

ИЛИ

Выберите Entire Page («Вся страница») , чтобы размер страницы совпадал с размером
экрана.

ИЛИ

Выберите Page Width («Ширина страницы») , чтобы установить ширину страницы
равнойширине экрана.
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Увеличение и уменьшение с помощью множественных касаний:

Двигайте пальцы в противоположных направлениях для увеличения.

ИЛИ

Двигайте пальцы по направлению друг к другу для уменьшения.

Появляется сообщение о текущем уровне увеличения.

Панорамирование страниц
Вы можете выполнять панорамирование страницы в увеличенном режиме, если ваш
интерактивный продукт поддерживает жесты панорамирования (см. раздел Увеличение и
уменьшение на предыдущей странице).
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Панорамирование:

1. Нажмите на экран двумя пальцами одной руки и удержите касание.

2. Не убирая пальцы с экрана, перемещайте их вверх, вниз, влево и вправо.

3. Когда на экране появится нужная область, отпустите пальцы.

Отображение страниц в режиме прозрачного фона
Режим прозрачногофона позволяет видеть содержимое рабочего стола и окон,
расположенных за окном SMART Notebook, и продолжать работать с открытой прозрачной
страницей. На прозрачной странице можно писать цифровыми чернилами и сохранять записи
в файл. Также можно отображать инструменты измерения, создавать снимки экрана и
выполнять другие действия. Если область экрана не содержит никаких объектов SMART
Notebook, можно выделять элементы рабочего стола и приложения, расположенные за окном
SMART Notebook, и работать с ними.

Отображение страниц в режиме прозрачного фона

Нажмите View Screens («Просмотр экранов») , затем выберите Transparent

Background («Прозрачный фон»).

Фон ПОSMART Notebook станет прозрачным, что позволит видеть рабочий стол и
приложения, расположенные за SMART Notebook, но все объекты на страницефайла
*.notebook останутся видимыми.

Появится панель инструментовTransparent Background («Прозрачныйфон»).
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Кнопка Команда Действие

Выбрать Выделяет объекты на текущей странице или
взаимодействует с объектами рабочего стола и
приложений, которые не являются объектами SMART
Notebook.

Перо и
выделение

Пишите или рисуйте на текущей странице цифровыми
чернилами.

Предыдущая
страница

Отображение предыдущей страницы текущегофайла.

Следующая
страница

Отображение следующей страницы текущегофайла.

Дополнительные
возможности

Открывает меню параметров, которое позволяет
добавлять затенение экрана, выбирать другие цифровые
чернила, выбирать художественное перо, добавлять
прямые линии, фигуры и выполнять другие действия.

Выход из
режима
прозрачного
фона

Возврат к стандартному виду.

Параметры
панели
инструментов

Отображаются дополнительные кнопки панели
инструментов.

NOTES

o На панели инструментов отображается номер текущей страницы и общее
количество страниц в файле.

o Если установлено ПОSMART Response, появляются дополнительные кнопки,
позволяющие вставлять вопросы и управлять экзаменами.

Отображение дополнительных кнопок на панели инструментов

Нажмите Toolbar Options («Параметры панели инструментов») .

Панель инструментов развернется для включения следующих кнопок.

Кнопка Команда Действие

Новая страница Вставка новой пустой страницы в текущийфайл.
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Кнопка Команда Действие

Отменить Отмена последнего действия.

Удалить Удаление всех выделенных объектов.

Очистить
страницу

Удаление всех цифровых чернил и всех объектов со
страницы.

Инструмент
захвата экрана

Открытие панели инструментов «Захват экрана».

Вставить
линейку

Добавление линейки на страницу (см. Работа с линейкой на
странице 206).

Вставить
транспортир

Добавление транспортира на страницу (см. Работа с
транспортиром на странице 208).

Вставить
транспортир
Геодрейек

Добавление транспортира Геодрейек на страницу (см.
Работа с транспортиром Геодрейек на странице 211).

Вставить
компас

Добавление циркуля на страницу (см. Работа с циркулем
на странице 213).

Отображение страниц в двухстраничном режиме
На экран можно вывести две страницы, расположенные рядом. На любой из этих страниц
можно рисовать, делать заметки, импортировать файлы и добавлять ссылки таким же
образом, как это делается на одной странице.

Когда отображаются две страницы, вы можете закрепить страницу, чтобы она продолжала
отображаться, пока вы будете просматривать другие страницы в сортировщике страниц.

Отображение страниц в двухстраничном режиме

Нажмите View Screens («Просмотр экранов») , затем выберите Dual Page Display

(«Двустраничный режим»).

Появится вторая страница. Красной рамкой обозначена активная страница.

Закрепление страницы

1. Отобразите на экране две страницы, если это не было сделано ранее.

2. Выберите страницу, которую необходимо отображать.
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3. Выберите View > Dual Page Display > Pin Page («Вид» > «Двустраничный режим» >
«Закрепить страницу»).

В верхних углах закрепленной страницы будут отображаться значки булавки .

Снятие закрепления страницы

Снимите выделение с пункта меню View > Dual Page Display > Pin Page («Вид» >
«Двустраничный режим» > «Закрепить страницу»).

Чтобы вернуться к обычному режиму отображения, выполните следующие действия:

Нажмите View Screens («Просмотр экранов») , затем выберите Single Page Display

(«Одностраничный режим»).

Отображение ссылок
Вы можете прикрепить копию файла, ярлык файла, ссылку на веб-страницу или звуковой
файл к любому объекту на странице (см. Добавление ссылок к объектам на странице 120).
Вы можете вывести анимированный индикатор вокруг каждого объекта, содержащего
ссылку.

Отображение ссылки при открытии страницы

Выберите View > Show All Links When Page Opens («Вид» > «Показывать все ссылки
при открытии страницы»).

При каждом открытии страницы анимированный индикатор будет отображаться вокруг
каждого объекта, содержащего ссылку. В зависимости от способа определения ссылок,
каждый индикатор окружает либо целый объект, либо значок в нижнем левом углу
объекта. Индикаторы автоматически исчезают через несколько секунд.

NOTE

Снимитефлажок View > Show All Links When Page Opens («Вид» > «Показывать
все ссылки при открытии страницы») , чтобы не отображать ссылки при открытии
страницы.
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Отображение ссылок на текущей странице

Выберите View > Show All Links («Вид» > «Показывать все ссылки»).

Анимированный индикатор появится вокруг каждого объекта, содержащего ссылку. В
зависимости от способа определения ссылок, каждый индикатор окружает либо целый
объект, либо значок в нижнем левом углу объекта. Индикаторы автоматически
исчезают через несколько секунд.

Перемещение окон между экранами
На одном компьютере можно работать с несколькими интерактивными продуктами. Можно
разделить экран компьютера на два и более экрана или же просматривать одни программы
на одном экране, а другие – на другом. Дополнительную информацию см. в разделе
«Подключение нескольких интерактивных досок к одному компьютеру»
(smarttech.com/kb/000315).

Если к одному компьютеру подключено несколько интерактивных продуктов, вы можете
перемещать окна с одного экрана на другой.

Перемещение окна с одного экрана на другой:

1. Если этого не было сделано ранее, откройте окно.

NOTE

Нельзя перемещать развернутые на весь экран и свернутые окна.

2. Коснитесь пальцем и удерживайте окно на первом экране.

3. Коснитесь второго экрана пальцем другой руки.

4. Уберите палец с первого экрана.

Окно исчезнет с первого экрана и появится на втором.

Настройка громкости
При воспроизведении видео или звуковогофайла уровень громкости можно настроить с

помощью кнопки Volume Control («Управление громкостью») , отрегулировав затем

громкость вашей операционной системы с помощью соответствующих элементов
управления.

NOTE

Убедитесь, что динамики включены.

http://www.smarttech.com/kb/000315
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Для добавления этой кнопки на панель инструментов, см. страницу Настройка панели
инструментов на странице 225.

Использование инструментов презентации в
классе
Во время представления учебных занятий учащимся можно использовать следующие
инструменты:

l Затенение экрана

l Затенение ячеек

l Волшебное перо

l Текстовое перо (для написания редактируемого текста чернилами)

l Стандартное перо (для создания исчезающих объектов)

l Блоки SMART

l Инструменты измерения

o Линейка

o Транспортир

o Транспортир Геодрейек

o Компас

Запись страниц с помощью средства записи уроков
Надстройка «Средство записи уроков» позволяет записывать действия, совершаемые вами
на странице. Впоследствии вы можете воспроизвести запись на той же странице с помощью
средства записи уроков или нового виджета воспроизведения.

NOTE

Средство записи SMART представляет собой предыдущий инструмент, но с новыми
возможностями. При использовании средства записи SMART вы можете записывать свой
действия в программах, отличных от SMART Notebook. При использовании средства записи
SMART вы можете вести запись всего экрана, указанного окна или прямоугольного участка
экрана. Если вы подключите к компьютеру микрофон, вы также сможете записывать
аудио.

Дополнительную информацию см. в разделе Работа со средством записи SMART на
странице 192.
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Запись страницы

1. Нажмите кнопку «Надстройки» , затем нажмите «Средство записи уроков».

2. Нажмите кнопку «Новая запись».

По периметру записываемой страницы отображается граница красного цвета.

3. Выполните на текущей странице действия, которые требуется записать.

4. Закончив выполнение этих действий, нажмите кнопку Stop Recording («Остановить

запись»).

TIPS

o Чтобы сохранить запись, просто сохранитефайл .notebook.

o Закройте надстройку «Средство записи уроков» на время проведения
презентаций. Виджет воспроизведения будет отображаться в нижней части
страницы. Можно разблокировать его и переместить в любое место на странице.

o Запись со страницы удалить невозможно.

Воспроизведение записи страницы с помощью надстройки «Средство записи уроков»

1. Откройте записанную вами страницу.

2. Если надстройка «Средство записи уроков» закрыта, нажмите кнопку «Надстройки»

, затем нажмите «Средство записи уроков».

3. Нажмите кнопку «Воспроизведение» на панели воспроизведения

Вы можете переключаться между режимами воспроизведения и паузы в

процессе воспроизведения записи.

4. Дополнительно можно выполнить следующие действия:

o Нажмите кнопку «Перемотка назад» для перемотки записи назад.

o Нажмите кнопку «Перемотка вперед» для перемотки записи вперед.
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Воспроизведение записи страницы с помощью виджета воспроизведения

1. Откройте записанную вами страницу.

2. Если надстройка Lesson Recorder («Средство записи уроков») открыта, нажмите кнопку

в строке меню надстроек, чтобы закрыть ее.

Виджет воспроизведения будет отображаться в нижней части страницы.

TIPS

Можно разблокировать и перемещать виджет по странице, чтобы к нему можно было
легко получить доступ в ходе презентации.

3. Нажмите кнопку «Воспроизведение» в виджете воспроизведения.

Вы можете переключаться между режимами воспроизведения и паузы в

процессе воспроизведения записи.

4. Дополнительно можно выполнить следующие действия:

o Нажмите кнопку «Перемотка назад» для перемотки записи назад.

o Нажмите кнопку «Перемотка вперед» для перемотки записи вперед.

Использование затенения ячеек
К ячейкам таблицы можно применить эффект затенения. Это позволит постепенно
открывать информацию в ячейках в ходе презентации.

NOTES

l Затенение ячеек необходимо удалить, если вы хотите изменить свойства ячейки,
вставить столбцы или строки, удалить столбцы, строки или ячейки или разделить или
объединить ячейки.

l Также вы можете добавить затенение экрана, закрывающее всю страницу (см.
UsingTheScreenShade.htm).

Добавление затенения ячейки:

1. Выделите ячейку.

2. Нажмите стрелку меню ячейки и выберите Add Cell Shade («Добавить затенение
ячейки»).
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Показать и скрыть содержимое ячейки:

1. Нажмите на затенение ячейки.

Затенение ячейки исчезает, появляется содержимое ячейки.

2. Нажмите в верхнем левом углу ячейки.

Появляется затенение ячейки, содержимое ячейки скрывается.

Удаление затенения ячейки:

1. Выделите ячейку.

2. Нажмите стрелку меню ячейки и выберите Remove Cell Shade («Удалить затенение
ячейки»).

Работа с инструментом «Волшебное перо»
Волшебное перо позволяет сделать следующее:

l Создать медленно исчезающий объект

l Открыть окно увеличения

l Открыть окно подсветки

Выбор инструмента«Волшебное перо»
Необходимо выбрать инструмент «Волшебное перо» перед его использованием.

Выбор инструмента «Волшебное перо»:

1. Нажмите Pens («Перья») .

Появляется кнопка инструмента «Перья».

2. Нажмите Pen Types («Типы перьев»), затем выберитеMagic Pen («Волшебное
перо»).
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Использование инструмента «Волшебное перо» для создания исчезающих объектов
С помощью инструмента «Волшебное перо» вы можете создать объект, который будет
медленно исчезать.

NOTE

Исчезающие объекты не сохраняются в файлах *.notebook.

Создание исчезающего объекта:

1. Выберите инструмент «Волшебное перо» (см. раздел Выбор инструмента«Волшебное
перо» на предыдущей странице).

2. Пальцем или пером напишите или нарисуйте объекты на интерактивном экране.

Объекты медленно исчезают.

Для задания числа секунд до исчезновения объекта:

1. Выберите инструмент «Волшебное перо» (см. раздел Выбор инструмента«Волшебное
перо» на предыдущей странице).

2. Если вкладка Properties («Свойства») не отображается, нажмите Properties

(«Свойства») .

3. Нажмите кнопку «Эффекты заливки».

4. Введите или выберите время в секундах до исчезновения объекта из выпадающего
списка Fade time («Время исчезновения»).

TIP

Можно сохранить изменения в параметрах по умолчанию инструмента «Волшебное
перо», нажав Save Tool Properties («Сохранить свойства инструмента») (см. раздел
Сохранение свойств инструмента на странице 71).

Использование инструмента «Текстовое перо»
Текстовое перо позволяет выполнять следующие действия:

l Делать записи с автоматическим преобразованием в редактируемый текст.

l Редактировать текст во время работы без помощи клавиатуры

Написание текста инструментом «Текстовое перо»
С помощью текстового пера вы можете делать записи с автоматическим преобразованием в
редактируемый текст.
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Написание редактируемого текста:

1. Нажмите Pens («Перья») .

Появляется кнопка инструмента «Перья».

2. Нажмите Pen Types («Типы перьев»), затем выберите Text Pen («Текстовое перо»).

3. Выберите тип линии.

TIP

Пишите аккуратно, печатными буквами, по горизонтальной линии. Хотя SMART
Notebook может преобразовывать написанный наклонно или письменными буквами
текст, это не всегда получается должным образом.

4. Сделайте запись цифровыми чернилами на странице.

Рукописный текст будет преобразован в печатный. Рядом с печатным текстом появятся
значки принятия и отмены.

5. Нажмите , чтобы принять печатный текст.

ИЛИ

Нажмите , чтобы вернуть запись, выполненную рукописным текстом.

TIPS

o Это действие можно выполнять, когда активно текстовое перо, и для этого не

нужно переключаться на инструмент выбора .

o Если вы не нажмете какую-либо из кнопок, печатный текст будет применен по
умолчанию.
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Редактирование текста инструментом «Текстовое перо»
С помощью текстового пера вы можете применять разметку и вносить правки в
редактируемый текст. Ненужный текст можно удалять, зачеркнув его с помощью пера. Для
выделения различных участков текста можно использовать цветные чернила. Также вы
можете применять другую разметку для вставки пробелов, вставки текста и замены старого
текста новым.

TIP

Вы можете выбрать цвет разметки, отличный от цвета редактируемого текста. Это
позволит учащимся проще видеть правки в ходе занятий, посвященных обучению письму.

Примеры доступной разметки приведены в следующей таблице:

Правка Инструкция Пример

Удаление
текста

Зачеркните текст.

Вставка
пробела

Нарисуйте вертикальную линию в
тексте.
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Правка Инструкция Пример

Вставка текста 1. Нарисуйте символ вставки ^ в том
месте, где необходимо
вставить текст.

2. Впишите новый текст в
появившееся текстовое поле.

TIP

Нажмите на тип линии или
нажмите «Цвет» , чтобы
выбрать новый цвет текста
вставки.

Под рукописным текстом будут
отображаться слова, наиболее
точно соответствующие
написанному.

3. Выберите слово, чтобы вставить
его в виде печатного текста. Также

можно нажать , чтобы
автоматически выбрать слово,
набранное полужирным текстом.
ИЛИ

Нажмите , чтобы отменить
вставку текста.

Замена текста 1. Нарисуйте окружность вокруг
участка текста, который вы хотите
заменить.

2. Впишите новый текст в
появившееся текстовое поле.
Под рукописным текстом будут
отображаться слова, наиболее
точно соответствующие
написанному.

3. Выберите слово, чтобы заменить

им печатный текст, или нажмите
, чтобы автоматически выбрать
слово, набранное полужирным
текстом.
ИЛИ

Нажмите , чтобы отменить
замену текста.
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Правка Инструкция Пример

Изменение
цвета текста

1. Нажмите на один из типов линии
или нажмите «Цвет» , чтобы
выбрать новый цвет печатного
текста.

2. Нарисуйте окружность вокруг
печатного текста, который
необходимо изменить.

3. Нажмите , чтобы автоматически
принять выбор нового цвета.
ИЛИ

Нажмите , чтобы отменить
выбор нового цвета.

Изменение
цвета слов с
помощью
жеста

1. Нажмите на один из типов линии
или нажмите «Цвет» , чтобы
выбрать новый цвет печатного
текста.

2. Зачеркните слово горизонтальной
линией и вернитесь к началу линии,
не отрывая пальца от поверхности.
Слово будет автоматически
окрашено в выбранный цвет.

Добавление ссылок на инструменты для объектов
Панель инструментов ПОSMART Notebook содержит средства, позволяющие создавать
базовые объекты на страницах и работать с ними. Если пользователи будут испытывать
затруднения при работе с панелью инструментов, вы можете привязать ссылку на
инструменты «Выбор», «Перья или Ластик» к объекту, что позволит создать
персонализированный инструмент, которыйможно разместить в любом месте страницы.
Инструмент можно активировать в любое время посредством нажатия на данный объект.

Добавление ссылки на инструмент для объекта

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите «Ссылка на инструмент».
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3. Выберите один из предложенных инструментов.

Данный объект будет связан с инструментом.

При нажатии на объект со ссылкой происходит запуск инструмента:

Перо o При нажатии на объект будет
активирован инструмент Pens
(«Перья»).

o Ввод содержимого можно будет
выполнять только при помощи
инструмента Pen («Перо»).

Ластик o При нажатии на объект будет
активирован инструмент Eraser
(«Ластик»).

o Позволяет стирать содержимое,
созданное с помощью перьев любых
типов.

Выбор o При нажатии на объект будет
активирован инструмент Select
(«Выбор»).

o Позволяет нажимать на другие
объекты, расположенные на
странице, чтобы открывать их меню
или перемещать их по странице.

TIPS

o Можно нарисовать свой объект, использовать объект из галереи или текстовый
объект.

o Можно предварительно задавать настройки цвета или типа линии перед
присвоением ссылки на инструмент «Перья» какому-либо объекту. Если вы
зададите новые настройки цвета или типа линии в инструменте «Перья»,
расположенном на панели инструментов, изменение будет автоматически
применено к связанному объекту.

Удаление ссылки на инструмент для объекта

1. Выберите объект.

2. Нажмите на стрелку меню объекта и выберите «Ссылка на инструмент».

3. Нажмите «Отсутствует».
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Использование инструмента «Стандартное перо» для создания
исчезающих объектов
Вы такжеможете рисовать объекты от руки, исчезающие через определенное время, с
помощью инструмента «Перо».

NOTE

Вы такжеможете от руки рисовать объекты, исчезающие через определенное время, с
помощью инструмента «Волшебное перо» (см. раздел Использование инструмента
«Волшебное перо» для создания исчезающих объектов на странице 184).

Написание или рисование исчезающими цифровыми чернилами:

1. Нажмите Pens («Перья») .

Появляется кнопка инструмента «Перья».

2. Нажмите Pen Types («Типы перьев»), затем выберите Pen («Перо»).

3. Выберите тип линии.

4. Если вкладка Properties («Свойства») не отображается, нажмите Properties

(«Свойства») .

5. Нажмите кнопку «Эффекты заливки».

6. Установитефлажок Enable ink to fade after you write it («Включить исчезновение
чернил после написания») , а затем введите или выберите время в секундах после
написания цифровыми чернилами, через которое чернила начинают исчезать, в
выпадающем списке Fade time («Время исчезновения»).

7. Пишите или рисуйте на странице цифровыми чернилами.
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Работа с блоками SMART
Блоки SMART являются бесплатной надстройкой, которая позволяет выполнять
арифметические операции вместе с классом. Для этого нужно написать цифры на странице и
затем соединить их с блоком SMART. Доступно семь различных типов арифметических
операций. Ознакомительную информацию по работе с блоками SMART вы сможете найти во
всплывающих окнах справки.

Доступ к блокам SMART:

Нажмите Add-ons («Надстройки») , затем выберите SMART Blocks («Блоки

SMART»).

Доступ к всплывающей справке блоков SMART:

1. Нажмите Add-ons («Надстройки») , затем выберите SMART Blocks («Блоки

SMART»).

2. Нажмите Learn More («Дополнительно»).

Операции с блоками SMART
Доступны следующие операции с блоками SMART.

SMARTBlock Функция

Блоки сложения поддерживают до двух входных значений. На выходе
получается сумма входных значений.

Блоки вычитания поддерживают до двух входных значений. На выходе
получается разность входных значений.

Блок умножения имеет два входа. Результат на выходе является
произведением входов.

Блоки деления поддерживают до двух входных значений. На выходе
получается частное входных значений.
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SMARTBlock Функция

Блоки степени поддерживают до двух входных значений. На выходе
получается число, для которого первое значение является основанием, а
второе — показателем.

Блоки квадратного корня поддерживают одно входное значение. На выходе
получается квадратный корень входного значения.

Блоки неизвестного значения поддерживают до двух входных значений. На
выходе производится выбор случайного значения.

Работа со средством записи SMART
Средство записи SMART позволяет записывать действия, выполняемые на интерактивном
продукте. Подключив к компьютеру микрофон, вы сможете записать также свой голос.

Созданную запись можно воспроизвести на любом компьютере с помощью видеоплеера
SMART или проигрывателяWindows Media®. Запись также можно передать другим
пользователям.

NOTES

l Проигрыватель Windows Media можно скачать с веб-сайта
www.windowsmedia.com/download.

l Если ваш компьютер удовлетворяет минимальным требованиям ПОSMART Notebook,
вы можете использовать средство записи SMART. Однако, чтобы достичь наилучшего
быстродействия, ПО рекомендуется устанавливать на компьютере с процессором
Pentium 4 или более мощным, звуковой картой и микрофоном, которые совместимы с
операционной системойWindows.

Если ваш компьютер удовлетворяет минимальным требованиям ПО
SMART Meeting Pro, вы можете использовать средство записи SMART. Однако, чтобы
достичь наилучшего быстродействия, ПО рекомендуется устанавливать на
компьютере с процессором Pentium 4 или более мощным, звуковой картой и
микрофоном, которые совместимы с операционной системойWindows.

http://www.windowsmedia.com/download
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Начало работы со средством записи SMART
Первый этап применения средства записи SMART заключается в запуске данного
приложения.

Запуск средства записи SMART

Нажмите на значок SMART Board в области уведомлений и выберите «Средство

записи».

NOTE

Если ваш компьютер в данныймомент не подключен к интерактивному продукту, в

правом нижнем углу на значке SMART Board отображается символ X .

Если ваш компьютер в данныймомент не подключен к интерактивному продукту, в

правом нижнем углу на значке SMART Board серого цвета отображается символ X .

В операционной системеWindows 7 выберите «Пуск» > «Все программы» > SMART
Technologies > SMART Tools > «Средство записи».

ИЛИ

В операционной системеWindows 8 перейдите на экран «Приложения», а затем найдите
и выберите «Средство записи».

Средство записи SMART появится на экране. В области уведомлений появится значок

«Средство записи SMART».

Скрытие средства записи SMART
Прижелании средство записи SMART можно скрыть, но сохранить возможность обращаться

к командам его меню с помощью значка «Средство записи SMART» .

Скрытие средства записи SMART

В средстве записи SMART выберите «Меню» > «Свернуть в системную область».

Средство записи SMART исчезнет с экрана.

Отображение средства записи SMART

Нажмите на значок «Средство записи SMART» в области уведомлений и выберите

«Показать».

Средство записи SMART появится на экране.

Изменение качества видео- и аудиозаписи
Вы можете изменить качество аудио- и видеозаписей средства записи SMART.
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Изменение качества видео- и аудиозаписей

1. Выберите в средстве записи SMART команду Menu > Options («Меню» >
«Параметры»).

NOTE

Если средство записи SMART скрыто, нажмите на значок «Средство записи SMART»

в области уведомлений, затем выберите «Настройка параметров».

Появится диалоговое окноOptions («Параметры»).

2. Выберите нужное качество звука в списке «Качество звука».

NOTE

Более высокое качество звука обеспечивает и более качественное воспроизведение
аудиозаписей, но при этом увеличивается размерфайла.

3. Выберите качество видеозаписи в списке «Качество видео».

ИЛИ

Выберите вариант «Другое» и задайте нужную частоту кадров.

NOTE

Более высокая частота кадров позволяет записать более качественное видео, но при
этом увеличивается размерфайла.

TIP

Если выбран вариант «Автоматический выбор (рекомендуется)», средство записи
SMART автоматически оценит характеристики вашего компьютера и подберет
оптимальную частоту кадров.

4. НажмитеOK.

Восстановление принятого по умолчанию качества видео- и аудиозаписей

1. Выберите в средстве записи SMART команду Menu > Options («Меню» >
«Параметры»).

NOTE

Если средство записи SMART скрыто, нажмите на значок «Средство записи SMART»

в области уведомлений, затем выберите «Настройка параметров».

Появится диалоговое окноOptions («Параметры»).
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2. Нажмите «Восстановить значения по умолчанию».

3. НажмитеOK.

Изменение формата видеофайлов записей
Вы можете изменить параметры средства записи SMART и выбрать нужныйформат
видеозаписи.

Изменение формата видеозаписи

1. Выберите в средстве записи SMART команду Menu > Options («Меню» >
«Параметры»).

NOTE

Если средство записи SMART скрыто, нажмите на значок «Средство записи SMART»

в области уведомлений, затем выберите «Настройка параметров».

Появится диалоговое окноOptions («Параметры»).

2. Выберите вкладкуVideo Format («Формат видео»).

3. Выберите «Видеофайлы Windows Media (*.wmv)» или «Видео средства записи
SMART (*.avi)».

NOTES

o Видеофайлы Windows Media можно воспроизвести с помощью проигрывателя
Windows Media любой версии. Проигрыватель Windows Media может также
воспроизводить видеофайлы cредства записи SMART, если на компьютере, где
воспроизводятся видеофайлы, установлено ПОSMART Notebook.

Видеофайлы Windows Media можно воспроизвести с помощью проигрывателя
Windows Media любой версии. Проигрыватель Windows Media может также
воспроизводить видеофайлы cредства записи SMART, если на компьютере, где
воспроизводятся видеофайлы, установлено ПОSMART Meeting Pro.

o Видеофайл cредства записи SMART можно преобразовать в видеофайл
Windows Media с помощью совместного доступа к записи (см. Предоставление
общего доступа к записям на странице 205).

4. НажмитеOK.

Восстановление принятого по умолчанию формата видеозаписи

1. Выберите в средстве записи SMART команду Menu > Options («Меню» >
«Параметры»).
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NOTE

Если средство записи SMART скрыто, нажмите на значок «Средство записи SMART»

в области уведомлений, затем выберите «Настройка параметров».

Появится диалоговое окноOptions («Параметры»).

2. Выберите вкладкуVideo Format («Формат видео»).

3. Нажмите «Восстановить значения по умолчанию».

4. НажмитеOK.

Изменение местоположения файла записи
Вы можете изменить параметры средства записи SMART и указать местоположениефайлов
записей.

Выбор другой папки для сохранения файлов средства записи SMART

1. Выберите в средстве записи SMART команду Menu > Options («Меню» >
«Параметры»).

NOTE

Если средство записи SMART скрыто, нажмите на значок «Средство записи SMART»

в области уведомлений, затем выберите «Настройка параметров».

Появится диалоговое окноOptions («Параметры»).

2. Нажмите на вкладку Target Files («Конечные файлы») .

3. Нажмите кнопку «Обзор», расположенную рядом с полем «Каталог сохранения по
умолчанию».

4. Выберите папку, в которой следует сохранять файлы, а затем нажмитеOK.

TIP

Для повышения быстродействия сохраняйтефайлы на жестком диске компьютера, а
не на сетевом диске.

5. НажмитеOK.

Выбор другой папки для сохранения временных файлов средства записи SMART

1. Выберите в средстве записи SMART команду Menu > Options («Меню» >
«Параметры»).
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NOTE

Если средство записи SMART скрыто, нажмите на значок «Средство записи SMART»

в области уведомлений, затем выберите «Настройка параметров».

Появится диалоговое окноOptions («Параметры»).

2. Нажмите на вкладку Target Files («Конечные файлы») .

3. Нажмите кнопку «Обзор», расположенную рядом с полем «Временный каталог
файлов».

4. Выберите папку, в которой следует сохранять временныефайлы, а затем нажмитеOK.

TIP

Для повышения быстродействия сохраняйтефайлы, включая временныефайлы, на
один диск. Это позволит уменьшить время, затрачиваемое на сохранение записей.

5. НажмитеOK.

Указание ограничения дискового пространства

1. Выберите в средстве записи SMART команду Menu > Options («Меню» >
«Параметры»).

NOTE

Если средство записи SMART скрыто, нажмите на значок «Средство записи SMART»

в области уведомлений, затем выберите «Настройка параметров».

Появится диалоговое окноOptions («Параметры»).

2. Нажмите на вкладку Target Files («Конечные файлы») .

3. Установитефлажок «Предупредить, если свободного места меньше», а потом
введите объем свободного места на диске, при котором будет выводиться сообщение о
недостатке свободного места на диске.

4. Введите минимальный размер свободного места на диске, начиная с которого средство
записи SMART приостановит запись.

5. НажмитеOK.

Восстановление заданного по умолчанию местоположения файлов записей

1. Выберите в средстве записи SMART команду Menu > Options («Меню» >
«Параметры»).
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NOTE

Если средство записи SMART скрыто, нажмите на значок «Средство записи SMART»

в области уведомлений, затем выберите «Настройка параметров».

Появится диалоговое окноOptions («Параметры»).

2. Нажмите на вкладку Target Files («Конечные файлы») .

3. Нажмите «Восстановить значения по умолчанию».

4. НажмитеOK.

Добавление филиграни к записям:
Вы можете изменить параметры средства записи SMART и добавить к фону записи
филигрань.

Добавление филиграни к записям

1. Выберите в средстве записи SMART команду Menu > Options («Меню» >
«Параметры»).

NOTE

Если средство записи SMART скрыто, нажмите на значок «Средство записи SMART»

в области уведомлений, затем выберите «Настройка параметров».

Появится диалоговое окноOptions («Параметры»).

2. Выберите вкладку «Филигрань» .

3. Выберите «Изображение».

4. Нажмите «Обзор».

5. Просмотрите и выберите нужное изображение и нажмите «Открыть».

6. Нажмите «Свойства».

Появится диалоговое окно «Свойствафилиграни». Выбранное изображение появится в
области «Предварительного просмотра».

7. Выполните следующее:

o Чтобы изменить местоположениефилиграни, перетащите изображение в другое
место области «Предварительный просмотр» .

o Чтобы изменить размерфилиграни, потяните за белый кружок в правом нижнем
углу изображения в области предварительного просмотра.

8. Задайте параметры «Прозрачность» и «Эффект».
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9. Нажмите кнопку OK. Диалоговое окно «Свойствафилиграни» закроется.

10. Чтобы после закрытия средства записи SMART вернуться к обычному режиму без
использования филиграни, выберите вариант «Отключать филигрань при закрытии
средства записи».

11. Нажмите кнопку OK. Диалоговое окно «Параметры» закроется.

Добавление текстовой филиграни к записям

1. Выберите в средстве записи SMART команду Menu > Options («Меню» >
«Параметры»).

NOTE

Если средство записи SMART скрыто, нажмите на значок «Средство записи SMART»

в области уведомлений, затем выберите «Настройка параметров».

Появится диалоговое окноOptions («Параметры»).

2. Выберите вкладку «Филигрань» .

3. Выберите «Текст».

4. Введите текст филиграни.

5. Нажмите «Свойства».

Появится диалоговое окноWatermark Properties («Свойствафилиграни»).Изображение
появится в областиPreview («Предварительный просмотр»).

6. Задайте параметры «Цвет», «Шрифт» и «Прозрачность».

7. Выполните следующее:

o Чтобы изменить местоположениефилиграни, перетащите изображение в другое
место области «Предварительный просмотр» .

o Чтобы изменить размерфилиграни, потяните за белый кружок в правом нижнем
углу изображения в области предварительного просмотра.

o Чтобы добавить в филигрань дополнительную информацию, выберите «Добавить
текущую дату», «Добавить текущее время» и/или «Добавить номер кадра»

8. Нажмите кнопку OK. Диалоговое окно «Свойствафилиграни» закроется.

9. Чтобы после закрытия средства записи SMART вернуться к обычному режиму без
использования филиграни, выберите вариант «Отключать филигрань при закрытии
средства записи».

10. Нажмите кнопку OK. Диалоговое окно «Параметры» закроется.
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Удаление филиграни из записей

1. Выберите в средстве записи SMART команду Menu > Options («Меню» >
«Параметры»).

NOTE

Если средство записи SMART скрыто, нажмите на значок «Средство записи SMART»

в области уведомлений, затем выберите «Настройка параметров».

Появится диалоговое окноOptions («Параметры»).

2. Выберите вкладку «Филигрань» .

3. Выберите вариант «Без филиграни».

4. НажмитеOK.

Запись действий
Средство записи SMART позволяет записывать действия на всем экране, в заданном окне
или в прямоугольной области экрана. Подключив к компьютеру микрофон, вы сможете
записать свое голосовое выступление.

Вы можете создать запись в формате видеофайла средства записи SMART, которыйможно
воспроизвести с помощью видеоплеера SMART, или в формате видеофайлаWindows Media,
которыйможно воспроизвести с помощью проигрывателяWindows Media. Если вы создали
запись в формате видеофайла средства записи SMART, то сможете преобразовать ее в
формат видеофайлаWindows Media или превратить в самораспаковывающийся файл и
передать пользователям, на компьютере которых не установлено ПОSMART.

NOTE

Вы такжеможете создавать видеофайлы в форматеWindows Media или
самораспаковывающиеся файлы из ранее созданных видеозаписей, чтобы передавать их
другим пользователям (см. раздел Предоставление общего доступа к записям на
странице 205).

Создание записи

1. В средстве записи SMART задайте нужные значения параметров качества, формата
видео, местоположения файла ифилиграни.

NOTES

o Если вы используете несколько экранов, выберите экран, с которого будете вести
запись.
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o Вы можете скрыть средство записи SMART, но сохранить возможность
обращаться к командам его меню с помощью значка «Средство записи SMART»

в области уведомлений.

2. Для записи действий на всем экране нажмите «Запись» .

NOTE

Если средство записи SMART скрыто, для записи действий на всем экране нажмите на

значок «Средство записи SMART» в области уведомлений и выберите

«Запись».

ИЛИ

Для записи действий в определенной области экрана нажмите стрелку вниз,

расположенную рядом с кнопкой «Запись» в средстве записи SMART, выберите

«Запись в области»и нарисуйте прямоугольник вокруг области, в которой вы хотите
вести запись.

ИЛИ

Для записи действий в окне нажмите стрелку вниз, расположенную рядом с кнопкой

«Запись» в средстве записи SMART, выберите «Запись окна»и выберите окно, в

котором вы хотите вести запись.

TIP

Чтобы уменьшить размерфайла записи, ограничьте запись прямоугольной областью
на экране или окном.

3. Выполните на экране действия, которые требуется записать. Если вы подключили к
компьютеру микрофон, говорите в микрофон.

Средство записи SMART показывает время, прошедшее с начала записи.

TIP

Анимация и другие специальные эффекты существенно увеличивают размерфайла
записи.
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4. Чтобы приостановить запись, нажмите кнопку «Пауза» . Чтобы возобновить запись,

нажмите кнопку «Запись» .

NOTES

o Чтобы приостановить запись, когда окно средства записи SMART скрыто,

нажмите на значок «Средство записи SMART» в области уведомлений и

выберите «Пауза».

o Чтобы возобновить запись, нажмите на значок «Средство записи SMART» в
области уведомлений и выберите «Запись».

5. После выполнения всех действий, которые требовалось записать, нажмите кнопку

«Остановить» в средстве записи SMART.

NOTE

Чтобы остановить запись, когда средство записи SMART скрыто, нажмите на значок

«Средство записи SMART» в области уведомлений и выберите «Остановить».

Появится диалоговое окно Save As («Сохранить как»).

NOTE

Если вы хотите завершить работу, не сохраняя записи, нажмите «Отмена», затем
нажмите «Да», чтобы подтвердить намерение удалить запись, и пропустите
остальныешаги этой процедуры.

6. Введите имяфайла.

7. Если вы хотите сохранить файл в другом месте, выберите новое местоположение.

8. Нажмите «Сохранить».

Пока средство записи SMART создает видеофайл, на экране будет отображаться
диалоговое окно «Завершение захвата».

После того как средство записи SMART создаст видеофайл, появится диалоговое окно
«Запись завершена». В этом диалоговом окне будет показано местоположение записи,
размерфайла и продолжительность записи.

9. Для просмотра записи закройте диалоговое окно и выберите «Воспроизвести запись».

10. Если вы хотите открыть совместный доступ к записи пользователям, у которых не
установлен видеоплеер SMART, и вы создали запись в видеоформате средства записи
SMART, выберите «Сделать запись доступной для совместного использования».
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11. НажмитеOK.

Если выбран пункт «Воспроизвести запись», файл будет воспроизведен на
проигрывателе по умолчанию.

Если выбран пункт «Сделать запись доступной для совместного использования»,
появится диалоговое окно «Сделать запись доступной для совместного
использования».Вы можете создать видеофайл в форматеWindows Media или
самораспаковывающегося файла, как описано далее.

Создание видеофайла в формате Windows Media или самораспаковывающегося файла

1. Создайте запись, как описано ранее. Убедитесь, что выбран режим Share Recording
(«Сделать запись доступной для совместного использования»).

Появится диалоговое окно Share Recording («Сделать запись доступной для совместного
использования»).

2. ВыберитеWMV, чтобы создать видеофайл в форматеWindows Media, и нажмите кнопку
«Далее».

ИЛИ

Выберите вариант «Самораспаковывающийся файл», чтобы создать
самораспаковывающийся файл, и нажмите кнопку «Далее».

3. Нажмите «Далее».

4. Нажмите «Обзор», выберите папку, в которой вы хотите сохранить файл, введите имя
файла и нажмите «Сохранить».

5. Нажмите «Далее».

6. Нажмите «Готово».

Улучшение характеристик системы при записи
Если при использовании средства записи SMART ваша система работает медленно или вас
не удовлетворяет качество записи, приведенные далее рекомендации помогут вам улучшить
характеристики системы.

l Уменьшите разрешение экрана компьютера и измените цветовые настройки экрана. При
маленьких экранах с малым количеством оттенков цвета быстродействие будет выше.

l Сохраняйтефайлы на локальныйжесткий диск. Сетевые диски более медленные, и при
их использовании быстродействие снижается.

l Отключите аппаратное ускорение.
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l Попробуйте заменить видеокарту. Некоторые видеокарты предлагают более высокий
уровень производительности. Видеокарты с интерфейсом PCI Express обладают более
высокой производительностью по сравнению с видеокартами с интерфейсами AGP и
PCI.

l Выберите более низкое качество видеозаписи. Вы должны соизмерять требования к
качеству видеозаписи с возможностями вашего компьютера. Видеофайлы более
высокого качества имеют больший размер, поэтому к компьютеру предъявляются
более высокие требования.

Уменьшение разрешения экрана и количества цветов
Если при использовании средства записи SMART ваша система работает медленно или вас
не удовлетворяет качество записи, вы можете уменьшить разрешение экрана и количество
цветов. При маленьких экранах с малым количеством оттенков цвета быстродействие будет
выше.

NOTE

Эта процедура может изменяться в зависимости от версии используемой операционной
системы Windows и настроек системы.

Уменьшение разрешения экрана и количества цветов

1. Откройте панель управленияWindows.

2. Нажмите «Экран», затем «Настройка параметров экрана».

3. Выберите более низкое значение из выпадающего списка Resolution («Разрешение»).

4. Выберите более низкое значение из выпадающего списка Colors («Цвет»).

NOTE

Количество отображаемых цветов не удастся изменить в ОС Windows 7 и более новых
версиях.

5. НажмитеOK.

Отключение аппаратного ускорения
Во время записи средство записи SMART постоянно делает снимки экрана. Некоторые
операционные системы делают снимки с экрана очень медленно, и это может повлиять на
качество записи. Чтобы повысить качество записи, отключите аппаратное ускорение или
обновите видеодрайвер и видеокарту.
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IMPORTANT

Отключение аппаратного ускорения может снизить производительность ПО
SMART Notebook.

NOTE

Эта процедура может изменяться в зависимости от версии используемой операционной
системы Windows и настроек системы.

Отключение аппаратного ускорения

1. Откройте панель управленияWindows.

2. Нажмите «Экран», затем «Настройка параметров экрана», затем
«Дополнительные параметры».

3. Выберите вкладку «Устранение неполадок» .

4. Перетащите ползунок «Аппаратное ускорение» в положение «Нет».

5. НажмитеOK.

6. Перезагрузите компьютер.

Предоставление общего доступа к записям
Если вы собираетесь использовать записи совместно с пользователями, на компьютере
которых установлено ПОSMART Notebook, создайте запись в формате видеофайла
средства записи SMART, которую они смогут воспроизвести в видеоплеере SMART. Если вы
хотите использовать записи совместно с пользователями, не имеющимиПО
SMART Notebook, создайте запись в формате видеофайлаWindows Media, которую они
смогут воспроизвести на видеоплеереWindows Media, или создайте
самораспаковывающийся файл, которыйможно будет воспроизвести на любом компьютере.

Если вы собираетесь использовать записи совместно с пользователями, на компьютере
которых установлено ПОSMART Meeting Pro, создайте запись в формате видеофайла
средства записи SMART, которую они смогут воспроизвести в видеоплеере SMART. Если вы
хотите использовать записи совместно с пользователями, не имеющимиПО
SMART Meeting Pro, создайте запись в формате видеофайлаWindows Media, которую они
смогут воспроизвести на видеоплеереWindows Media, или создайте
самораспаковывающийся файл, которыйможно будет воспроизвести на любом компьютере.
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Преобразование видеофайла средства записи SMART

1. Выберите «Меню» > «Сделать запись доступной для совместного использования» в
средстве записи SMART.

NOTE

Если средство записи SMART скрыто, нажмите на значок «Средство записи SMART»

в области уведомлений, затем выберите «Настройка параметров».

Появится диалоговое окно Share Recording («Сделать запись доступной для совместного
использования») .

2. ВыберитеWMV, чтобы создать видеофайл в форматеWindows Media.

ИЛИ

Выберите вариант «Самораспаковывающийся файл», чтобы создать
самораспаковывающийся файл, и нажмите кнопку «Далее».

3. Нажмите «Обзор».

4. Просмотрите и выберите видеофайл средства записи SMART, который вы хотите
преобразовать, и нажмите «Открыть».

5. Нажмите «Далее».

6. Чтобы изменить местоположение и имя преобразованногофайла, нажмите «Обзор»,
выберите папку, в которой вы хотите сохранить файл, введите имяфайла и нажмите
«Сохранить».

7. Нажмите «Далее».

8. Нажмите «Готово».

Работа с инструментами измерения
Работая с инструментами измерения ПОSMART Notebook, вы можете вывести на страницу
линейку, транспортир, транспортир Геодрейек или циркуль.

Работа с линейкой
Можно вставить на страницу линейку, настроить ее размер, длину, поворот и положение, а
затем рисовать вдоль ее краев.

Вставка линейки:

НажмитеMeasurement Tools («Инструменты измерения») и выберите Insert Ruler

(«Вставить линейку») .
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Появится линейка.

Перемещение линейки

Нажмите на среднюю часть линейки (отображается более темным синим полутоном), и
перетащите линейку в другое место на странице.

Изменение размеров линейки

1. Выделите линейку.

2. Потяните ручку изменения размера линейки (кружок в нижнем правом углу) для
увеличения или уменьшения размера линейки.

Увеличение длины линейки (без изменения шкалы)

Нажмите на дальний край линейки, между стрелкой меню и средством изменения
размеров, а затем тяните в направлении от линейки.

Уменьшение длины линейки (без изменения шкалы)

Нажмите на дальний край линейки, между стрелкой меню и средством изменения
размеров, а затем тяните в направлении к центру линейки.

Поворот линейки

Нажмите на верхнюю или нижнюю часть линейки (отображается более светлым синим
полутоном) и тащите линейку в том направлении, куда ее нужно повернуть.

На линейке отображается текущий угол поворота в градусах.

Переворот размеров:

Нажмите на символ переворота линейки .

Если метрические единицы отображались на верхней кромке линейки, они будут
отображаться на нижней кромке, и наоборот.
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Рисование с помощью пера и линейки:

1. Нажмите Pens («Перья») .

Появляется кнопка инструмента «Перья».

2. Нажмите Pen Types («Типы перьев»), затем выберите Pen («Перо») или Calligraphic
Pen («Каллиграфическое перо»).

3. Выберите тип линии.

4. Рисуйте вдоль края линейки.

Цифровые чернилаформируют прямую линию вдоль кромки линейки.

Удаление линейки:

1. Выделите линейку.

2. Нажмите на стрелку меню линейки и выберите Delete («Удалить»).

Работа с транспортиром
Можно вставить на страницу транспортир, настроить его размер, поворот и положение, а
затем рисовать вдоль его краев.
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Вставка транспортира:

НажмитеMeasurement Tools («Инструменты измерения») и выберите Insert

Protractor («Вставить транспортир») .

Появится транспортир.

Перемещение транспортира

Нажмите на внутреннюю часть транспортира (отображается более темным синим
полутоном), и перетащите его в другое место на странице.

Изменение размеров транспортира

Нажмите на внутренний круг чисел, а затем тащите в направлении от транспортира для
его увеличения или в направлении к центру – для уменьшения.

Поворот транспортира

Нажмите на наружный круг чисел и тащите транспортир в том направлении, куда его
нужно повернуть.

На транспортире отображается текущий угол поворота в градусах.
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Отображение транспортира в виде полного круга:

1. Нажмите на синий кружок около надписи 180º на внутреннем круге значений.

2. Нажмите на синий кружок еще раз, чтобы вернуться к отображению в виде полукруга.

Рисование с помощью пера и транспортира:

1. Нажмите Pens («Перья») .

Появляется кнопка инструмента «Перья».
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2. Нажмите Pen Types («Типы перьев»), затем выберите Pen («Перо») или Calligraphic
Pen («Каллиграфическое перо»).

3. Выберите тип линии.

4. Рисуйте вдоль края транспортира.

Цифровые чернилаформируют дугу вдоль кромки транспортира.

Отображение углов с помощью транспортира:

1. Выделите транспортир.

2. Перетаскивайте зеленый кружок, пока он не покажет правильное значение угла первых
двух пересекающихся линий.

3. Перетаскивайте белый кружок, пока он не покажет правильное значение угла второй из
двух пересекающихся линий.

4. Нажмите на зеленую стрелку в нижнем углу.

Линии и угол между ними будут отображаться в виде отдельного объекта.

Удаление транспортира:

1. Выделите транспортир.

2. Нажмите на стрелку меню транспортира и выберите Delete («Удалить»).

Работа с транспортиром Геодрейек
Вы можете вставить транспортир Геодрейек (также называемый угольником или рейсшиной)
на страницу и управлять его размером, углом поворота и местоположением.

Вставка транспортира Геодрейек:

НажмитеMeasurement Tools («Инструменты измерения») и выберите Insert

Geodreieck («Вставить транспортир Геодрейек») .
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Появится транспортир Геодрейек.

Перемещение транспортира

Нажмите на внутреннюю часть транспортира (внутри полукруга), и перетащите
транспортир в другое место на странице.

Изменение размеров транспортира

Нажмите полукруг и затем тащите в направлении от центра транспортира, чтобы
увеличить размер, или к центру, чтобы уменьшить размер.

Поворот транспортира

Нажмите на внешнюю часть транспортира (вне полукруга) и тащите транспортир в том
направлении, куда его нужно повернуть.

На транспортире отображается текущий угол поворота в градусах.

Рисование с помощью пера и транспортира Геодрейек:

1. Нажмите Pens («Перья») .

Появляется кнопка инструмента «Перья».
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2. Нажмите Pen Types («Типы перьев»), затем выберите Pen («Перо») или Calligraphic
Pen («Каллиграфическое перо»).

3. Выберите тип линии.

4. Рисуйте вдоль края транспортира.

Цифровые чернилаформируют прямую линию вдоль кромки транспортира.

Удаление транспортира:

1. Выделите транспортир.

2. Нажмите на стрелку меню транспортира и выберите Delete («Удалить»).

Работа с циркулем
Можно вставить циркуль на страницу, настроить егоширину, поворот и положение, а затем
использовать его для рисования окружностей и дуг.

Вставка циркуля:

НажмитеMeasurement Tools («Инструменты измерения») и выберите Insert

Compass («Вставить циркуль») .

Появится циркуль.

Перемещение циркуля

Нажмите на край циркуля, на котором находится острие, и перетащите циркуль в другое
место на странице.

Расширение циркуля

1. Нажмите на край циркуля, на котором находится грифель.

Появятся две стрелки синего цвета.
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2. Перетаскиванием задайте угол между острием и грифелем.

Число, отображаемое на рукоятке циркуля указывает текущий угол между острием и
грифелем.

Переворот циркуля:

Нажмите на символ переворота циркуля .

Грифель циркуля окажется на противоположной стороне от острия.

Поворот циркуля (без рисования)

Нажмите на ручку поворота (зеленый кружок) циркуля, и тащите циркуль в том
направлении, куда его нужно повернуть.

Рисование с помощью циркуля

1. Нажмите на кончик грифеля циркуля.

Курсор изменится на символ грифеля.

2. Тащите циркуль в том направлении, в котором его нужно повернуть.

Изменение цвета грифеля циркуля:

1. Нажмите Pens («Перья») .

Появляется кнопка инструмента «Перья».

2. Нажмите Pen Types («Типы перьев»), затем выберите Pen («Перо»).

3. Выберите тип линии.

Цвет грифеля циркуля изменится на новый.
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Удаление циркуля:

1. Выделите циркуль.

2. Нажмите на стрелку меню циркуля и выберите Delete («Удалить»).

Очистка или сброс страниц после
презентации
После презентации учебного занятия Вы можете очистить или выполнить сброс страниц в
файлах .notebook, чтобы использовать их повторно на последующих учебных занятиях.
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Очистка страниц
Вы можете стирать цифровые чернила и удалять отдельные объекты со страницы. Также со
страницы можно удалить все объекты или все объекты, созданные цифровыми чернилами
одновременно.

NOTE

Нельзя удалить заблокированные объекты (см. LockingObjects.htm) или объекты,
полученные в результате бесконечного клонирования (см. Клонирование объектов на
странице 79). Чтобы удалить все объекты со страницы, необходимо сначала
разблокировать все заблокированные объекты и снять выделение инструмента Infinite
Cloner («Бесконечное клонирование») со всех объектов, полученных в результате
бесконечного клонирования.

Стирание всех объектов с экрана:

1. Если этого не было сделано ранее, выведите на экран страницу, которую вы хотите
очистить.

2. Выберите Edit > Clear Page («Правка» > «Очистить страницу»).

NOTES

o Эта опция отключена, если страница не содержит объектов или если объекты
заблокированы или бесконечно клонированы.

o Этот вариант можно также выбрать следующим образом:

o Щелчок правой кнопкой на странице

o Нажатие стрелки меню страницы в сортировщике страниц

o Нажатие стрелки меню страницы во время редактирования групп страниц (см.
GroupingPages.htm)

o Нажатие Clear Page («Очистить страницу») , если такой вариант имеется

на панели инструментов (см. Настройка панели инструментов на
странице 225)

o Можно очистить все объекты с нескольких страниц одновременно. Выделите
эскизы страниц в сортировщике страниц, нажмите стрелку меню и выберите
Clear Page («Очистить страницу»).
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Удаление всех объектов цифровых чернил со страницы:

1. Если этого не было сделано ранее, выведите на экран страницу, которую вы хотите
очистить.

2. Выберите Edit > Clear Ink from Page («Правка» > «Очистить страницу от чернил»).

NOTES

o Этот вариант отключен, если страница не содержит объектов, созданных
цифровыми чернилами, или если цифровые чернила заблокированы или
бесконечно клонированы.

o Этот вариант можно также выбрать следующим образом:

o Щелчок правой кнопкой на странице

o Нажатие стрелки меню страницы в сортировщике страниц

o Нажатие стрелки меню страницы во время редактирования групп страниц (см.
GroupingPages.htm)

o Нажатие Clear Ink («Очистить чернила») , если такой вариант имеется на

панели инструментов (см. Настройка панели инструментов на странице 225)

o Можно очистить все объекты, созданные цифровыми чернилами, с нескольких
страниц одновременно. Выделите эскизы страниц в сортировщике страниц,
нажмите стрелку меню и выберите Clear Ink from Page («Очистить страницу от
чернил»).

Сброс страниц
Если вы вносили на страницу изменения (без сохранения), страницу можно сбросить до
состояния, предшествующего внесению изменений.

NOTE

При сбросе страницы файлы, совместимые с Adobe Flash Player, запущенные на странице,
не изменяются.

Сброс страницы:

1. Если этого не было сделано ранее, выведите на экран страницу, которую вы хотите
сбросить.



CHAPTER 10
ПРЕЗЕНТАЦИЯ УЧЕБНЫХ ЗАНЯТИЙ И УПРОЩЕНИЕ СОВМЕСТНОГО ОБУЧЕНИЯ

218

2. Выберите Edit > Reset Page («Правка» > «Сбросить страницу»).

Появляется диалоговое окно, в котором нужно подтвердить сброс.

NOTES

o Эта опция отключена, если на страницу не было внесено изменений со времени
последнего ее сохранения.

o Этот вариант можно также выбрать следующим образом:

o Щелчок правой кнопкой на странице

o Нажатие стрелки меню страницы в сортировщике страниц

o Нажатие стрелки меню страницы во время редактирования групп страниц (см.
GroupingPages.htm)

o Нажатие Reset Page («Сбросить страницу») , если такой вариант

имеется на панели инструментов (см. Настройка панели инструментов на
странице 225)

o Можно сбросить несколько страниц одновременно. Выделите эскизы страниц в
сортировщике страниц, нажмите стрелку меню и выберите Reset Page
(«Сбросить страницу»).

3. Нажмите Reset Page («Сбросить страницу»).

Режим двух пользователей при
использовании интерактивной доски
На интерактивной доске SMART Board серии D600 или 800 два пользователя одновременно
могут создавать объекты и управлять ими в ПОSMART Notebook. На способ работы в
режиме двух пользователей влияет модель интерактивной доски: SMART Board серии D600
или SMART Board серии 800.

Режим двух пользователей при использовании интерактивной доски удобен в следующих
сценариях:

l Два учащихся одновременно работают над заданием на интерактивной доске

l Учитель и учащийся одновременно работают над заданием на интерактивной доске

l Учитель или учащийся задают вопросы или задают задачи на интерактивной доске,
другой учащийся отвечает на вопросы или решает задачи
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Режим двух пользователей при использовании
интерактивной доски SMART Board серииD600
При использовании интерактивной доски SMART Board серии D600 одновременно два
пользователя могут работать с интерактивной доской, когда ПОSMART Notebook находится
в режиме работы двух пользователей. В режиме работы двух пользователей экран делится
пополам. Каждый пользователь может касаться своей половины экрана пальцем, чтобы
выполнить щелчок левой кнопкой мыши или перетаскивать объекты, писать с помощью пера
из лотка и стирать цифровые чернила с помощью ластика.

Чтобы переключиться из режима работы одного пользователя в режим работы двух
пользователей, необходимо нажать кнопку на панели инструментов.

Для отображения файла в режиме работы двух пользователей

Нажмите View Screens («Просмотр экранов») , затем выберите Dual Write Mode

(«Режим двойного рукописного ввода»).

Для возврата в режим работы одного пользователя

Нажмите Exit («Выйти») .

Режим двух пользователей при использовании
интерактивной доски SMART Board серии 800
На интерактивной доске SMART Board серии 800 два пользователя одновременно могут
создавать объекты и управлять ими в ПОSMART Notebook. Оба пользователя могут
создавать объекты и управлять ими в области страницы ПОSMART Notebook. Для
указанной области страницы ограничений ни для одного пользователя нет.

Режим работы двух пользователей активируется, когда вы берете перо из лотка для перьев.
Один из пользователей создает объекты и управляет ими с помощью пальцев
(«пользователь, работающий касаниями»). Другой создает объекты и управляет ими пером
(«пользователь, работающий пером»).

NOTE

В дополнение к варианту с пользователями, работающими пером и пальцами
одновременно, можно активировать режим двух пользователей, одновременно
работающих на доске перьями или с помощью касаний. Но оба пользователя должны
использовать один и тот же инструмент.
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Выбор инструментов
Для смены инструментов или настройки свойств касаний пользователь, работающий
касаниями, нажимает соответствующую кнопку на панели инструментов или на вкладке
«Свойства». Далее описывается пример:

Для смены инструментов или настройки свойств пера пользователь, работающий пером,
нажимает пером соответствующую кнопку на панели инструментов или во вкладке
«Свойства». Далее описывается пример:

NOTES

l Если пользователь, работающий пером, нажимает кнопку на панели инструментов
пальцем, а не пером, SMART Notebook изменяет выбранный инструмент для
пользователя, работающего касаниями, а не для пользователя, работающего пером.

l Когда оба пользователя выбирают несколько объектов на экране, цвет пунктирной
границы объектов, выбранных пользователем, работающим пальцами, будет
отличаться от границы объектов, выбранных пользователем, работающим пером.



Chapter 11

221

Chapter 11: Расширение функционала ПО
SMART Notebook с помощью
надстроек

Установка надстроек 221
Работа с надстройками 222
Определение отсутствующих надстроек 222
Отключение и удаление надстроек 222

Надстройки — это расширения для ПОSMART Notebook, созданные компанией
SMART Technologies и сторонними разработчиками программного обеспечения.

ПОSMART Notebook включает надстройки «Конструктор занятий» (см. Создание учебного
задания на соответствие на странице 133) и «Инструменты выравнивания» (см.
Выравнивание объектов на странице 73). Вы можете установить другие надстройки с веб-
сайта SMART Exchange, чтобы добавить в ПО различные специализированныефункции.
Кроме того, вы можете управлять всеми установленными надстройками с помощью
Диспетчера надстроек.

Установка надстроек
Вы можете искать, просматривать и устанавливать надстройки с веб-сайта SMART Exchange.

Установка надстройки

1. Выберите Add-ons > Manage Add-ons («Надстройки» > «Управление
надстройками»).

Появится диспетчер надстроек.

2. Выберите одну из надстроек на левой панели и нажмите Done («Готово»).
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Работа с надстройками
После установки надстройки вы можете использовать все еефункции как и любые другие
функции ПОSMART Notebook.

Просмотр надстройки

1. Нажмите кнопку «Надстройки» для просмотра списка надстроек.

2. Нажмите на значок надстройки, чтобы открыть ее.

3. Нажмите кнопку для возврата в список надстроек.

Просмотр версии и другой информации о надстройке

1. Выберите «Надстройки» > «Управление надстройками» на панели инструментов ПО

ИЛИ

Нажмите кнопку в строке меню надстроек.

Появится диспетчер надстроек.

2. Нажмите на имя надстройки.

3. Нажмите «О программе».

Определение отсутствующих надстроек
При открытии страницы файла *.notebook, для работы которой необходима надстройка,
отключенная или отсутствующая на вашем компьютере, в верхней части страницы
отобразится соответствующее сообщение. Нажмите на сообщение для запускаДиспетчера
надстроек. Диспетчер надстроек определит необходимую надстройку. Вы можете установить
эту надстройку (см. Установка надстроек на предыдущей странице) или включить ее (см.
Отключение и удаление надстроек выше).

Отключение и удаление надстроек
В некоторых ситуациях может потребоваться отключение или удаление ранее установленных
надстроек.

Если вы захотите отключить надстройку, она больше не будет отображаться в ПО
SMART Notebook, но все равно будет оставаться установленной на вашем компьютере.
Впоследствии вы можете включить эту надстройку.
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Если вы захотите удалить надстройку, она больше не будет отображаться в ПО
SMART Notebook, а также будет удалена с вашего компьютера.

Отключение надстройки

1. Выберите Add-ons > Manage Add-ons («Надстройки» > «Управление
надстройками»).

Появится диспетчер надстроек.

2. Нажмите на имя надстройки.

3. Нажмите Disable («Отключить»).

TIP

Для повторного включения надстройки нажмите Enable («Включить»).

Удаление надстройки

1. Выберите Add-ons > Manage Add-ons («Надстройки» > «Управление
надстройками»).

Появится диспетчер надстроек.

2. Дважды нажмите на имя надстройки.

3. Нажмите кнопку Remove («Удалить»).

NOTES

o Надстройки «Конструктор занятий» и «Инструменты выравнивания» невозможно
удалить.

o Можно удалять только те надстройки, которые были установлены после
установки ПОSMART Notebook.
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В данной главе представлена информация о настройке ПОSMART Notebook.

Настройка панели инструментов
Панель инструментов SMART Notebook позволяет выбирать и использовать различные
команды и инструменты. Вы можете настроить параметры панели инструментов, поместив
туда наиболее часто используемые инструменты.

После добавления или удаления кнопок с панели инструментов всегда можно вернуться к
набору кнопок по умолчанию. Кроме того, можно вернуть настройки по умолчанию всем
инструментам, если они были изменены и сохранены на вкладке Properties («Свойства») (см.
раздел Сохранение свойств инструмента на странице 71).
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Добавление и удаление кнопок с панели инструментов:

1. Нажмите Customize the toolbar («Настроить панель инструментов») .

ИЛИ

Выполнитещелчок правой кнопкой мыши на панели инструментов.

Появится диалоговое окноCustomize Toolbar («Настроить панель инструментов»).

2. Нажмите Actions («Действия») или Tools («Инструменты»).

3. Выполните следующее:

o Чтобы добавить кнопку на панель инструментов, нажмите значок нужной кнопки в
диалоговом окне и перетащите его на панель инструментов.

o Чтобы удалить кнопку с панели инструментов, нажмите ее значок на панели
инструментов и перетащите его за пределы панели инструментов.

o Чтобы переставить кнопки, нажмите нужный значок на панели инструментов и
перетащите его на новое место на этой панели.

NOTES

o Можно добавлять, удалять и переставлять кнопки только на панели инструментов,
выбранной нашаге 2. Например, если нашаге 2 вы нажали Actions («Действия») ,
можно только добавлять, удалять и переставлять кнопки на панели Actions
(«Действия»).

o Для расширения кнопки по строке захватите ее, переместите и удерживайте
между двух столбцов кнопок.

В случае использования экрана с небольшим разрешением, не растягивайте по
строке более двух кнопок, так как это может привести к чрезмерному увеличению
ширины панели по отношению к ширине окна ПОSMART Notebook.

4. Нажмите «Готово».

Восстановление набора кнопок по умолчанию:

1. Нажмите Customize the toolbar («Настроить панель инструментов») .

ИЛИ

Выполнитещелчок правой кнопкой мыши на панели инструментов.
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Появится диалоговое окноCustomize Toolbar («Настроить панель инструментов»).

2. Нажмите Restore Default Toolbar («Восстановить панель инструментов по
умолчанию»).

Восстановление настроек по умолчанию для инструментов:

1. Нажмите Customize the toolbar («Настроить панель инструментов») .

ИЛИ

Выполнитещелчок правой кнопкой мыши на панели инструментов.

Появится диалоговое окноCustomize Toolbar («Настроить панель инструментов»).

2. Нажмите Restore Default Tool Properties («Восстановить свойства инструмента по
умолчанию»).

Настройка ПО SMART Notebook
В данном разделе представлена информация о настройке ПОSMART Notebook.

Смена программы по умолчанию дляфайлов *.notebook
Если вместо ПОSMART Notebook вы устанавливаете программу SMART, которая может
открывать файлы *.notebook, вы можете настроить эту программу так, чтобы она стала
программой по умолчанию для файлов *.notebook. При желании вы снова сможете заменить
программу по умолчанию для файлов *.notebook на SMART Notebook.

Смена программы по умолчанию во время открытия файла:

1. Откройте какой-либофайл *.notebook с помощью ПОSMART Notebook (см. Открытие
файлов на странице 14).

Появится сообщение с вопросом, хотите ли вы сменить программу по умолчанию для
файлов *.notebook на SMART Notebook.

2. Нажмите Yes («Да»).

Для смены программы по умолчанию с использованием диалогового окна Preferences
(«Настройки»):

1. Выберите Edit > Preferences («Изменить» > «Настройка»).

На экране появится диалоговое окноSMART Notebook Preferences («Настройки SMART
Notebook»).
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2. НажмитеGeneral («Общие»).

3. НажмитеMake Default («Сделать программой по умолчанию»).

4. Если вы хотите, чтобы это сообщение появлялось на экране во время открытия файлов
*.notebook, когда программой по умолчанию не является SMART Notebook, выберите
вариант Tell me if SMART Notebook software isn’t the default program for .notebook files
(«Сообщать мне, если SMART Notebook не является программой по умолчанию для
файлов *.notebook»).

5. НажмитеOK.

Настройка параметров жестов
Взаимодействие с объектами в ПОSMART Notebook можно также осуществлять с помощью
жестов, включая жесты встряхивания и долгого нажатия.

Жест Имя Назначение

Жест встряхивания Группировка двух или
нескольких объектов.

Жест долгого нажатия Выполнениещелчка правой
кнопкой мыши.

Жесты встряхивания и долгого нажатия включены по умолчанию. Но вы можете отключить
эти жесты, если учащиеся будут непреднамеренно их выполнять.
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Отключение жеста встряхивания:

1. Выберите Edit > Preferences («Изменить» > «Настройка»).

На экране появится диалоговое окноSMART Notebook Preferences («Настройки SMART
Notebook»).

2. НажмитеGeneral («Общие»).

3. Снимитефлажок с пунктаUse the shake gesture to group and ungroup objects
(«Использовать жест встряхивания для группировки и разгруппировки объектов»).

4. НажмитеOK.

Отключение жеста долгого нажатия:

1. Выберите Edit > Preferences («Изменить» > «Настройка»).

На экране появится диалоговое окноSMART Notebook Preferences («Настройки SMART
Notebook»).

2. НажмитеGeneral («Общие»).

3. Снимитефлажок с пункта Press and hold to perform a right-click («Нажать и
удерживать для выполнения щелчка правой кнопки мыши»).

4. НажмитеOK.

Настройка параметров оптимизации изображения
Если в файле *.notebook содержатся большие изображения (размером более 1МБ), он может
открываться очень медленно. В этом случае можно уменьшить размер изображений без
заметной потери качества. В результате размерфайла *.notebook станет меньше, файл
будет открываться и работать быстрее.

Настройка параметров оптимизации изображения:

1. Выберите Edit > Preferences («Изменить» > «Настройка»).

На экране появится диалоговое окноSMART Notebook Preferences («Настройки SMART
Notebook»).

2. Нажмите Defaults («Настройки по умолчанию»).
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3. Выберите один из следующих вариантов из выпадающего списка Image optimization
(«Оптимизация изображения»):

o Выберите Ask every time I insert a large image («Спрашивать при каждом
добавлении большого изображения») , чтобы при добавлениифайла
изображения можно было выбрать уменьшение его размера или сохранение
исходного размера.

o Выберите Never change the resolution of inserted images («Никогда не изменять
разрешение добавляемых изображений») , чтобы всегда добавлять
изображения в исходном разрешении.

o Выберите Always change image resolution to optimize file size («Всегда изменять
разрешение изображения для оптимизации размера файла») , чтобы всегда
уменьшать размерфайла изображения при добавлении.

4. НажмитеOK.

Уменьшение размера изображения вручную
Если вы выбрали вариант Ask every time I insert a large image («Спрашивать при каждом
добавлении большого изображения») из выпадающего списка ImageOptimization
(«Оптимизация изображения»), его размер можно уменьшить вручную при добавлении
изображения в файл или позднее.

Уменьшение размера больших изображений на этапе добавления в файл:

1. Вставьте изображение, как описано в разделе Вставка изображений на странице 93.

После нажатия кнопкиOpen («Открыть») появится диалоговое окно ImageOptimization
(«Оптимизация изображения»).
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2. НажмитеOptimize («Оптимизировать») , чтобы уменьшить размерфайла
изображения.

ИЛИ

Нажмите Keep Resolution («Сохранить разрешение») , чтобы не уменьшать размер
файла изображения.

NOTES

o В случае добавления файла в формате BMP ПОSMART Notebook преобразует
его в файл формата PNG. Такое преобразование уменьшит размерфайла. В
результате, оптимизация файла *.notebook может оказаться излишней (см.
раздел Экспорт оптимизированногофайла выше), даже если размер исходного
BMP-файла превышал 1МБ.

o ПОSMART Notebook автоматически уменьшает размер графическогофайла,
если он превышает 5МБ или 5 мегапикселей, в зависимости от выбранного
варианта.

Уменьшение размера больших изображений после их добавления в файл:

1. Выберите изображение.

2. Нажмите стрелку меню выбранного изображения и выберите Image Optimization
(«Оптимизация изображения»).

Появится диалоговое окноImageOptimization («Оптимизация изображения»).

3. НажмитеOptimize («Оптимизировать»).

Экспорт оптимизированного файла
Если у вас есть ранее созданныефайлы, в которых содержатся большие изображения, или
если вы выбрали вариант Never change the resolution of inserted images («Никогда не
изменять разрешение добавляемых изображений») в выпадающем списке Image
Optimization («Оптимизация изображения») , вы можете экспортировать оптимизированные
версии этих файлов, которые будут содержать уменьшенные изображения. Этафункция
особенно полезна, когда нужно провести презентацию файла *.notebook на устаревшем или
маломощном компьютере.

Экспорт оптимизированного файла:

1. Выберите File > Export As > Optimized SMART Notebook File («Файл» >
«Экспортировать как» > «Оптимизированный файл SMART Notebook»).
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Появится диалоговое окноExport Optimized File («Экспортировать оптимизированный
файл»).

2. Выберите папку для сохранения новогофайла.

3. Введите имяфайла в полеFile name («Имяфайла»).

4. Нажмите «Сохранить».

Настройка параметров цветафона по умолчанию
Для новых страниц, добавляемых в файл, задан белый цвет фона по умолчанию. Цвет фона
по умолчанию можно изменить.

NOTE

Эта настройка коснется только новых страниц, а в случае применения темы она будет
заменена соответствующими параметрами этой темы.

Изменение цвета фона по умолчанию:

1. Выберите Edit > Preferences («Изменить» > «Настройка»).

На экране появится диалоговое окноSMART Notebook Preferences («Настройки SMART
Notebook»).

2. Нажмите Defaults («Настройки по умолчанию»).

3. Нажмите Change Color («Изменить цвет»), затем выберите цвет.

4. НажмитеOK.

Настройка параметров инструментов измерения
Линейка, транспортир и транспортир Геодрейек по умолчанию имеют синий цвет в ПОSMART
Notebook и лучше всего отображаются на светлом фоне.
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Можно изменить цвет этих инструментов измерения на желтый, если вы хотите использовать
их на темном фоне.

NOTE

Выполнение следующей процедуры изменит внешний вид инструментов измерения в
файлах *.notebook только для вашей копииПОSMART Notebook. Если вы откроете тот же
файл *.notebook на другой копии ПОSMART Notebook, инструменты измерения могут иметь
другой цвет.

Изменение цвета инструментов измерения:

1. Выберите Edit > Preferences («Изменить» > «Настройка»).

На экране появится диалоговое окноSMART Notebook Preferences («Настройки SMART
Notebook»).

2. Нажмите Defaults («Настройки по умолчанию»).

3. Выберите вариант Blue tint (recommended for light backgrounds) («Синий оттенок
(рекомендуется для светлого фона)») в выпадающем спискеMeasurement tool color
(«Цвет инструментов измерения») , чтобы изменить цвет инструментов измерения на
синий.

ИЛИ

Выберите вариант Yellow tint (recommended for dark backgrounds) («Желтый оттенок
(рекомендуется для темного фона)») в выпадающем спискеMeasurement tool color
(«Цвет инструментов измерения») , чтобы изменить цвет инструментов измерения на
желтый.

4. НажмитеOK.
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Настройка параметров отступов в ячейках таблиц
В ПОSMART Notebook 11 стало возможным задавать отступы в ячейках таблиц.

Выполните следующую процедуру для удаления отступов в ячейках таблиц. Этафункция
особенно полезна, если вы создали таблицы до обновления ПОSMART Notebook 11 и хотите,
чтобы содержимое таблицы отображалось без отступов в ячейках.

NOTE

Выполнение следующей процедуры изменит внешний вид таблиц в файлах *.notebook
только для вашей копииПОSMART Notebook. Если вы откроете тот жефайл *.notebook на
другой копии ПОSMART Notebook, таблицы будут отображаться с отступами в ячейках
(если данная процедура не была выполнена на этой копии ПОSMART Notebook).

Удаление отступов в ячейках таблиц:

1. Выберите Edit > Preferences («Изменить» > «Настройка»).

На экране появится диалоговое окноSMART Notebook Preferences («Настройки SMART
Notebook»).

2. Нажмите Defaults («Настройки по умолчанию»).

3. Снимитефлажок с пунктаAdd cell padding to table cells («Добавлять отступы в
ячейках таблиц»).

4. НажмитеOK.

5. Закройте, затем снова запустите ПОSMART Notebook.

Новые и ранее созданные таблицы в файлах .notebook будут отображаться без отступов
в ячейках.
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Установка языка
Утилита настройки языка SMART позволяет выбирать язык для определенного приложения
SMART или для всех приложений SMART, установленных на компьютере.

Для выбора языка выполните следующее:

1. Выберите «Параметры» > «Настройка языка».

Появится диалоговое окно «Настройка языка».

2. Выберите в первом выпадающем списке пункт «Все перечисленные приложения» ,
чтобы установить язык сразу для всех программ.

ИЛИ

Выберите в первом выпадающем списке конкретное приложение, чтобы установить
язык только для него.

3. Выберите нужный язык из второго выпадающего списка.

NOTES

o Если рядом с выбранным языком отображается значок , значит этот язык

установлен на компьютере.

o Если рядом с выбранным языком отображается значок , значит утилита

настройки языка SMART сможет загрузить язык с веб-сайта после нажатия
кнопки «OK».

o По умолчанию утилита настройки языка SMART использует настройки интернет-
браузера Internet Explorer для подключения к сети Интернет. Однако можно
использовать разные настройки для выполнения шагов в рамках следующей
процедуры.

TIP

Для отображения названий языков на языке оригинала (например, Deutschдля
немецкого языка) установитефлажокShow native names («Показать исходные
названия»).
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4. Если нужно использовать разные языки для проверки правописания и распознавания
рукописного текста, выберите их в выпадающих списках «Распознавание рукописного
текста» и «Проверка правописания» .

NOTE

Если в выпадающем списке появляется пункт «АВТО» , языковая настройка SMART
выделит выбранный вами язык или близкий язык в ином случае. Если ни один из
параметров недоступен, языковая настройка SMART выбирает текущий язык.

5. Если нужна другая раскладка клавиатуры, выберите ее из выпадающего спискаKeyboard
input language («Язык ввода для клавиатуры»).

IMPORTANT

Выпадающий список «Язык ввода для клавиатуры» доступен только при условии, что
на компьютере установлены несколько раскладок клавиатуры.

Раскладка, выбранная из выпадающего списка «Язык ввода для клавиатуры» , при
работе с ПОSMART будет автоматически применяться как к экранной клавиатуре, так
и к обычной клавиатуре, подключенной к компьютеру.

В некоторых ситуациях может понадобиться выбрать раскладку, отличную от
раскладки клавиатуры, подключенной к компьютеру (например, для обучения второму
языку). В таких случаях экранная клавиатура работает корректно, но клавиатура,
подключенная к компьютеру, может работать некорректно.

Для достижения наилучших результатов убедитесь, что выбранная раскладка
соответствует раскладке клавиатуры, подключенной к вашему компьютеру. Например
если к компьютеру подключена клавиатура с английской (США) раскладкой, выберите
из выпадающего спискаEnglish (United States) («Английский (США)»).

Дополнительные сведения о раскладках клавиатур см. в статье
http://msdn.microsoft.com/en-us/goglobal/bb964651.

6. Нажмите «OК».

Для настройки параметров соединения выполните следующее:

1. Выберите «Параметры» > «Настройка языка».

Появится диалоговое окно «Настройка языка».

2. Нажмите «Параметры подключения».

Появится диалоговое окно «Параметры подключения».

http://msdn.microsoft.com/en-us/goglobal/bb964651
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3. Выберите «Использовать настройки Internet Explorer».

ИЛИ

Выберите «Использовать другой прокси-сервер», а затем укажите хост, имя
пользователя и пароль в соответствующих полях.

4. Нажмите «OК».

Удаление ПО SMART
Служба поддержки SMART может предложить вам удалить ПОSMART перед установкой
новой версии. Вы можете сделать это с помощью Программы удаления SMART.

Для удаления ПО SMART выполните следующее:

1. В операционной системеWindows XP илиWindows 7 выберите «Пуск» >
«Все программы» > SMART Technologies > SMART Tools > «Программа удаления
SMART».

ИЛИ

В операционной системеWindows 8 перейдите на экран «Приложения» , а затем найдите
и выберите  «Программа  удаления SMART».

2. Нажмите «Далее».
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3. Проставьтефлажки напротив ПОSMART и сопутствующих пакетов, которые
необходимо удалить, а затем нажмите «Далее».

NOTES

o Некоторое ПОSMART взаимосвязано с другим ПОSMART. Например, если
поставить флажок напротив SMART  Notebook , программа удаления SMART
автоматически установит флажок напротив SMART Response , потому что ПО
SMART Response взаимосвязано с ПОSMART Notebook.

o Программа удаления SMART автоматически удаляет сопутствующие пакеты,
которые больше не будут использоваться. Если вы удалите пакет ПОSMART
полностью, Программа удаления SMART удалит все сопутствующие пакеты,
включая себя.

TIPS

o Для выбора всех приложений и сопутствующих пакетов нажмите «Выбрать все».

o Чтобы отменить выбор всех приложений и сопутствующих пакетов,
нажмите «Очистить все».

4. Нажмите «Удалить».

Программа удаления SMART выполнит удаление выбранного ПО и его сопутствующих
пакетов.

5. Нажмите «Готово».

Обновление и активация ПО SMART
После установки ПОSMART необходимо произвести его активацию. После активации ПО
необходимо установить обновления от SMART.

IMPORTANT

Для обновления и активации ПОSMART необходимо подключение к интернету.

Обновление ПО SMART
Компания SMART периодически выпускает обновления для своего программного
обеспечения и микропрограмм. (Микропрограммы — это программное обеспечение, которое
устанавливается на такие продукты, как интерактивная доска SMART Board.) Вы можете
использовать SMART Product Update (SPU) для проверки и установки этих обновлений.
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Системный администратор может установить SPU в полноэкранном режиме или в виде
панели. В полноэкранном режимеможно просматривать установленные версии, а также
загружать и устанавливать обновления, как описано в этом разделе. Версия в виде панели
позволяет только просматривать установленные версии.

Для автоматической проверки наличия обновлений

1. В операционной системеWindows XP илиWindows 7 выберите «Пуск» > «Все
программы» > SMART Technologies > SMART Tools > SMART Product Update.

ИЛИ

В операционной системеWindows 8 перейдите на экран «Приложения» , а затем найдите
и выберите SMART Product Update.

Появится окно SMART Product Update.

2. Установитефлажок «Автоматически проверять наличие обновлений» , а затем
введите интервал в днях (не более 60) между последовательными проверками для SPU.

3. Закройте окно SMART Product Update («Обновление продукта SMART»).

Если при очередной проверке SPU обнаружит обновление для конкретного продукта,
автоматически откроется окно SMART Product Update, в котором будет активна кнопка
Update («Обновить») для данного продукта.

Для проверки наличия обновлений вручную

1. В операционной системеWindows XP илиWindows 7 выберите «Пуск» > «Все
программы» > SMART Technologies > SMART Tools > SMART Product Update.

ИЛИ

В операционной системеWindows 8 перейдите на экран «Приложения» , а затем найдите
и выберите SMART Product Update.

Появится окно SMART Product Update.

2. Нажмите «Проверить сейчас».

Если для продукта доступно обновление, кнопка «Обновить» станет активной.

3. Если для продукта доступно обновление, установите его, выполнив следующую
процедуру.
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Для установки обновления

1. Откройте окно SMART Product Update, как описано выше.

2. Перейдите на строку продукта.

Появится подробное описание продукта. Это описание содержит версию установленного
продукта, количество доступных обновлений, дату и размерфайла для загрузки (если
обновление доступно).

TIP

Нажмите «Просмотреть комментарии разработчика», чтобы просмотреть краткий
обзор изменений и системные требования для установки обновлений.

3. Нажмите «Обновить».

4. Загрузитефайл и установите обновление, следуя инструкциям на экране.

IMPORTANT

Для установки обновлений необходимо иметь права администратора.

Для отключения функции автоматической проверки обновлений

1. В операционной системеWindows XP илиWindows 7 выберите «Пуск» > «Все
программы» > SMART Technologies > SMART Tools > SMART Product Update.

ИЛИ

В операционной системеWindows 8 перейдите на экран «Приложения» , а затем найдите
и выберите SMART Product Update.

Появится окно SMART Product Update.

2. Снимитефлажок Check for updates automatically («Автоматически проверять
наличие обновлений»).

IMPORTANT

Компания SMART рекомендует не отключать эту функцию.
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Активация ПО SMART
Обычно ПОSMART активируется сразу после установки. Но в некоторых ситуациях
приходится активировать его позднее. Например, если нужно оценить ПО, прежде чем
решать приобрести его.

NOTES

l В версии 11.1 активация ПОSMART Notebook и SMART Product Drivers не требуется.
SMART предоставляет права на использование этого ПО непосредственно при покупке
интерактивного продукта SMART.

l Если вы хотите использовать ПОSMART Notebook на устройстве, которое не является
интерактивным продуктом SMART, вы должны приобрести ключ продукта.

Получение ключа продукта
SMART Software Portal — это веб-сервис, помогающий просматривать ключи продуктов,
активации и прочую информацию оПОSMART. В настоящиймомент портал SMART Software
Portal доступен для англоговорящих пользователей в Северной Америке и Великобритании.
Посетить портал можно по адресу licensing.smarttech.com.

Если вы живете за пределамиСеверной Америки и Великобритании, свяжитесь с
реселлером (smarttech.com/wheretobuy), чтобы получить ключ продукта.

TIP

Если вы потеряли ключ продукта, перейдите на страницу: smarttech.com/findproductkey.

Активация программного обеспечения SMART с помощью ключа продукта
После получения ключа продукта вы можете активировать ПОSMART.

Для активации ПО SMART

1. В операционной системеWindows XP илиWindows 7 выберите «Пуск» > «Все
программы» > SMART Technologies > SMART Tools > SMART Product Update.

ИЛИ

В операционной системеWindows 8 перейдите на экран «Приложения» , а затем найдите
и выберите SMART Product Update.

Появится окно SMART Product Update.

http://licensing.smarttech.com/
http://www.smarttech.com/wheretobuy
http://www.smarttech.com/findproductkey
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2. Нажмите «Активировать» или «Управление» рядом с названием ПО, которое хотите
активировать.

Появится окно «Активация ПОSMART».

NOTE

Значения в столбце «Состояние» обозначают состояние каждого продукта.

Значение Описание

Установлено ПО установлено.

Активировано ПО установлено и активировано с бессрочной лицензией или
лицензией на техобслуживание.

Подписка ПО установлено и активировано с лицензией по подписке. Число в
скобках обозначает количество оставшихся дней периода подписки.

Срок
истекает

ПО установлено, но не активировано. Число в скобках обозначает
количество оставшихся дней пробного периода.

Срок
действия
истек

ПО установлено, но не активировано. Пробный период истек. С этого
момента продукт можно будет использовать только после активации.

Неизвестно Состояние ПО неизвестно.

3. Нажмите «Добавить».

4. Выполните активацию ПО с помощью ключа продукта, следуя инструкциям на экране.

Для просмотра ключей продукта

1. В операционной системеWindows XP илиWindows 7 выберите «Пуск» > «Все
программы» > SMART Technologies > SMART Tools > SMART Product Update.

ИЛИ

В операционной системеWindows 8 перейдите на экран «Приложения» , а затем найдите
и выберите SMART Product Update.

Появится окно SMART Product Update.

2. Выберите Tools > View Licenses («Инструменты» > «Просмотр лицензий»).

Появится диалоговое окно «Ключи продукта».
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3. По завершении просмотра ключей продукта нажмите OK.

NOTE

Такжеможно просмотреть ключ отдельного продукта. Для этого нажмите его название
в окне SMART Product Update («Обновление продукта SMART») и выберите View
licenses («Просмотреть лицензии»).

Отправка отзыва в компанию SMART
При первом запуске ПОSMART может появиться диалоговое окно с вопросом о том, хотите
ли вы принять участие в программе сбора отзывов пользователей SMART. В случае вашего
согласия ПОSMART Notebook отправит компании SMART сведения, которые помогут
улучшить новые версии программного обеспечения.После первого запуска ПОможно
отключить или включить эту функцию из менюHelp («Справка»).

Кроме того, запросы нафункции можно отправлять в компанию SMART по электронной
почте.

Для включения функции отслеживания программы сбора отзывов пользователей
выполните следующее:

Выберите «Справка» > «Программа сборов отзывов покупателей» > «Включить
отслеживание отчетов».

Для отключения функции отслеживания программы сбора отзывов пользователей
выполните следующее:

Выберите «Справка» > «Программа сбора отзывов покупателей» > «Выключить
отслеживание отчетов».

Для отправки по электронной почте запроса на функции выполните следующее:

1. Выберите «Справка» > «Отправить запрос функций».

Откроется почтовый клиент, заданный по умолчанию, и появится окно нового сообщения.

2. Введите свой запрос в теле нового сообщения электронной почты и
нажмите «Отправить».
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Chapter 13: Поиск и устранение
неисправностей ПО
SMART Notebook

Поиск и устранение неисправностейфайлов 245
Поиск и устранение неисправностей цифровых чернил 245
Поиск и устранение неисправностей жестов 246
Устранение неисправностей параметров DPI на дисплеях 4K UHD 246

В данной главе представлена информация о поиске и исправлении неисправностей ПО
SMART Notebook.

Поиск и устранение неисправностей файлов
Проблема Рекомендации

Файл содержит большие картинки и
открывается в SMART Notebook очень
медленно.

Экспортируйте оптимизированную версию
файла (см. раздел Настройка параметров
оптимизации изображения на странице 229).

Поиск и устранение неисправностей
цифровых чернил
Проблема Рекомендации

SMART Notebook не распознает рукописный
текст на определенном языке.

Установите соответствующий языковой
пакет (см. раздел Установка языка на
странице 235).
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Проблема Рекомендации

Вы хотите, чтобы рукописный текст
отображался в SMART Notebook более
естественно и плавно.

Используйте инструмент
«Каллиграфическое перо» вместо
инструмента «Стандартное перо» (см.
раздел Написание или рисование
цифровыми чернилами на странице 32).

Возникли проблемы с плавным написанием
слов в SMART Notebook на компьютере с
операционной системойWindows 7.

Включенафункция панорамирования с
помощью одного пальца. Выключите ее (см.
документ smarttech.com/kb/147470).

При написании пером SMART Notebook на
компьютере с операционной системой
Windows 7 интерпретирует все действия как
щелчки мышью.

Включенафункция быстрого движения.
Выключите ее (см. документ
smarttech.com/kb/144274).

Поиск и устранение неисправностей жестов
Проблема Рекомендации

Жесты с несколькими касаниями,
описанные в этом руководстве, не работают
в ПОSMART Notebook.

Убедитесь, что интерактивный продукт
поддерживает жесты с несколькими
касаниями, ифункция жестов с несколькими
касаниями включена.

Устранение неисправностей параметров DPI
на дисплеях 4K UHD
Мы рекомендуем использование 125% масштабирование DPI для дисплеев с разрешением
4K UHD. Если ваши текущие настройки не оптимальны, то при запуске Notebook в левом
верхнем углу первой страницы может появиться уведомление с рекомендацией увеличить
DPI дисплея. Если вы пять раз закроете уведомление и не внесете никаких изменений, то
появится диалоговое окно. В нем вы сможете узнать о том, как изменить DPI, или отключить
появление уведомления.

Более подробную информацию об изменении параметров DPI можно прочитать здесь:
Увеличение размеров экрана SMART Notebook с помощью изменения параметров DPI.

http://www.smarttech.com/kb/147470
http://www.smarttech.com/kb/144274
http://knowledgebase.force.com/articles/HOW_TO/Increase-the-size-of-the-screen-display-for-SMART-Notebook-by-adjusting-the-DPI-settings?q=000016952&l=en_US&fs=Search&pn=1
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увеличение пространства, 27
удаление, 29

стрелки, 37
стрелки меню, 64

Т
таблицы

выделение, 52
добавление затенения ячеек, 182
добавление объектов в, 51
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написание или рисование, 32
описание, 32
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